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taking important photographs.

® Screen and camera illustrations shown in this manual were produced during the
developmental stages and may differ from those of the actual product.
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Names of parts

Camera
Shutter button =" P.50

AF illuminator I="P.78
AF sensor
Flash I=°P.59

—t

/Ei;mo D OLYMPUS
N Microphone I=5°P.100, 137

AEL button (AEL) 0="P.85

Lens

Remote control receiver 15" P.90

|_ Self-timer/Remote control lamp
I P.89, 90

— Self-timer/Remote control button ($)/d) 1S5 P.89, 90

___ Erase button (1) IS°P.51, 143

Viewfinder =" P.27

Control dial 1=°P.31, 33, 150
QUICK VIEW button I5"P.122

Arrow pad (®&Q8) 1=°P.37, 121
OK/Menu button (®) 1=°P.37

©) | —— card cover I P.22

0 | — Monitor button (@DJ) =" P.50
09 L— Card button (CF xD) I°P.23
0

/ Card access lamp = P.50
g2 | v | Connector cover IS5 134, 187

. L A/V OUT jack (MONO) 1 P.134
Monitor

IS P28, 50 L USB connector I5°P.187
DC-IN jack I=°P.19




Names of parts

Hot shoe I=5"P.65
Power switch I5°P.25

Mode dial I=5°P.25, 46

Diopter adjustment
ring I P.27

we

—00 ©

- L

Zoom lever (WE=R/TQ))
IS P.57, 124,125

Custom button () I°P.154

Strap eyelet * I=°P.16

* The metal clip of the strap eyelet is

not shown in detail in the
illustrations in this manual.

Speaker

Tripod socket
Battery compartment lock 1=5°P.18
Battery compartment cover I5°P.18

Flash pop-up button I="P.59
Strap eyelet * I=°P.16

AF /Macro/ MF button (AF/¥/MF)
I’ P.79, 87, 88
Protect button (Om) 1" P.142

Flash mode button (%) I°P.59
Rotation button (1) IS°P.123

Metering button (([{sl)) 1=5"P.81
Print button (0,) I=°P.178

Exposure compensation button ()
I P.64, 108

Information display button (INFO)
I P.135

White balance button (WB) 1=5"P.109
Record mode button (<€:-) I°P.105



Names of parts

Viewfinder and monitor indications

@ Shooting mode

=2 O

d f@]“;g:@;éﬂ_%‘é’m._ 30

I
14 15 16 1718

Still picture
14 15 17 18
Movie
Item Indication Ref. page

1 | Shooting mode P A S MM & 2 M & P.46
2 | Shutter speed 15" to 1/4000, BULB P.71
3 | Aperture value F2.4t0 F8.0 P.70
4 | Exposure compensation -2.0to +2.0 P.108

Exposure differential -3.0to +3.0 P72
5 | Battery check [ | P14
6 | Green lamp (o] P.50
7 | Flash stand-by ¥ Lights P.50, 59

Camera movement warning/ | % Blinks

Flash charge
8 | Macro mode ¥ P.87

Super macro mode oY P.88

Manual focus MF, M, P.79
9 | Noise reduction [NR] P118
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Names of parts

Item Indication Ref. page
10 | Flash mode ©, 3, ®, $SLOW1, @ 4SLOWT, P.59
gsLowz
11| Flash intensity control -2.0to +2.0 P.64
12 | Sequential shooting mode O, HIG), &y, AFEy, BKT P92
13| Self-timer ) P.89
Remote control 8 P.90
14 | Sound record Ul P.100,
101, 137
15 | Record mode RAW, TIFF, SHQ, HQ, SQ1, SQ2 P.102
16 | Resolution 3264 x 2448,2048 x 1536, 640 x 480 etc.| P.104
17 | AF target mark [ 1 P.50
Metering target mark O P.81, 82
18 | Number of storable still 30 P.104
pictures
Remaining recording time 04:00 P.55
19 | AE lock AEL P.85
AE memory
20 | Metering mode ) @@ P.81
21180 ISO50, 1ISO100, 1SO200, ISO400 etc. P.107
22| White balance O, D, 2%, Sto &4, £, P.109
CWB1 to CWB4,
=) P11
23 | White balance compensation |B1to B7, R1to R7 P112
24| Scene modes N A P.117
Hue RGB _5t0 +5 P.116
Saturation RGB _5 to +5 P117
25
Sharpness S -5t0+5 P.114
Contrast © -5t +5 P.115
26 | Memory gauge LLEE P14
27 | Card [xD], [CF] P.23
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Names of parts

@Playback mode
INFO setting allows you to select how much information to display on the
screen. Screens with the information display set to ON are shown below.
I “INFO - Displaying shooting information” (P.135)

3 45

10
1
12
13
14
Still picture
Item Indication Ref. page
1 | Battery check a) a] P14
2 |Card [xD], [CF] P.23
3 | Print reservation/ 4,x10 P178
number of prints P.128
Movie x
4 | Sound record [ P.100,
101, 128
5 | Protect [ P.142
6 |Record mode RAW, TIFF, SHQ, HQ, SQ1, SQ2 P.102
7 | Resolution 3264 x 2448, 2048 x 1536, 640 x 480, P.104
320 x 240 etc.
8 |Aperture value F2.4to F8.0 P70
9 | Shutter speed 8'to 1/4000 P.71
10 | Exposure compensation |-2.0 to +2.0 P.108
11| White balance WB AUTO, (), <, 3%, 2%, &5 to &34, -, P.109
=, P.111
12|1SO ISO50, 1ISO100, 1SO200, 1SO400 etc. P.107
13 | Date and time '04.4.17 15:30 P.168
14 | File number FILE : 100 - 0030 P176
Playing time/Total 00:00/00:36 P.128
recording time

o

Note

* The indications that appear on a movie picture that has been selected and
displayed from the index display are different from those that appear when
the movie picture is displayed using the movie playback function.
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Names of parts

@ Memory gauge

The memory gauge lights up when you take a still
picture. While the gauge is lit, the camera is storing the
picture on the card. The memory gauge indication
changes as shown below depending on the shooting
status. The indication is not displayed during movie
recording.

Battery check indication

R N,

Memory gauge —

Shoot Shoot Shoot
a a a
d . d . d .
q q q
Wait

Before shooting One picture taken Two or more taken No more pictures
(Gauge is off) (Lit) (Lit) can be taken
(Fully lit)
Wait until the gauge
returns to the status
on the left to take
the next shot.

@Battery check
If the remaining battery power is low, the battery check indication changes as
follows when the camera is turned on or while the camera is in use.

@ ) ‘E ) BATTERY EMPTY
is displayed.

Lights (green)

(Goes off after a while) Blinks (red)

Remaining power level: high Remaining power level: low  Remaining power level:
If you intend to use the exhausted
camera for a long period of  Charge the battery.
time, charge the battery as
soon as possible.

|14



How to use this manual

Set the mode dial to any of the marks
shown here.

1 Adumithe brightsma bpauming the
el whily baling fras § el i of the

| Mos ds™) # a &0l ng.h"&ﬂ,

L—— The buttons for the function
and their location are
clearly illustrated.

This shows control dial
operations.

Follow the arrows to perform menu operations. For details on

operating procedures, see “Menu basics” (P.38).

SHARPHNESS |

T, b

L P

This represents the arrow pad. Only arrows
applicable to the operation are shown.

This sample page is only for your reference. It may differ from the actual page
in this manual.

@ Indications used in this manual

Important information on factors which may lead to a malfunction or

/!/ operational problems. Also warns of operations that should be
Note  absolutely avoided.
% Useful information and hints that will help you get the most out of your
s camera.
1> Reference pages describing details or associated information.

15|
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1 Getting started

Attaching the strap

1

Pass the lens cap string through the hole in
the lens cap, then pass the other end through
the loop and pull tight.

Pull the ends of the strap out of the stopper ~
and ring. Ring

Stopper \

Thread the strap through the string loop
(attached to the lens cap in Step 1).

Thread the strap through the strap eyelet,
then back through the ring and stopper as
indicated by the arrows.

Strap eyelet

When you have decided how long you want the
strap to be, pull on the strap in the stopper ® to
make sure it is securely fastened.

Attach the strap to the other eyelet following
Steps 3 to 5.

Note

» Be careful with the strap when you carry the camera, as it can easily catch
on stray objects, causing injury or damage.

+ Attach the strap correctly as shown above so that the camera does not fall
off. If the strap is attached incorrectly and the camera falls off, Olympus is
not responsible for any damages.

|16



Charging the battery

This camera uses one BLM-1 lithium ion battery. Other batteries cannot be

used.

The battery is not fully charged at the time of purchase. Before using the
camera, charge the battery using the BCM-2 charger. For more details, read the

instructions provided with the charger.

1 Plug the power cord into the charger.

2 Plug the other end of the power cord into a
household electrical outlet.

3 Remove the protection cap from the battery.
Place the battery on the charger, making
sure that itis correctly oriented as shown in
the illustration.

+ Align the battery with the guideline on the charger
(=Z=]), and insert the battery into the charger as far
as it goes.

Meaning of the charge lamp
indications:

Lights red : Charging

Lights green: Charging is completed
Blinks red : Charging failure

The battery charges in
approximately 5 hours. The charging
time may differ according to the
amount of power left in the battery.

Protection

cap

/' Use only the specified charger.

>« The battery becomes warm during charging, but this is not a malfunction.

Not ) ) )
ST you intend to use the camera for a long period of time, you are

recommended to carry a spare battery (sold separately) with you.

used to prevent short-circuiting of the battery terminals.

Always secure the protection cap to the battery when carrying it or not being

17|
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Loading the battery

This camera uses one BLM-1 lithium ion battery.

1 Make sure the camera is turned off.
* The monitor is off.
* The viewfinder is off.
» The lens is retracted.

Battery compartment cover
2 Sslide the battery compartment lock from
& to < and open the battery
compartment cover.

Battery compartment lock:

[l 'nserting a battery
3 Insert the battery, making sure that it is
correctly oriented as shown in the
illustration.
» The battery lock secures the battery when
correctly loaded.

[l Removing the battery

Press the battery lock in the direction of the

arrow (®).

» The battery is ejected.

+ Keeping your hand over the battery to stop it falling
out, turn the camera right way up and remove the
battery.

4 Close the battery compartment cover.

5 Slide the battery compartment lock from
Rto&.

Battery level warning
The amount of power consumed varies considerably depending on the
operations performed on the camera. If you use an exhausted battery, the
camera may turn off without displaying the battery level warning (P.14).

|18




Loading the battery

Other ways to power the camera

@AC adapter

The optional Olympus CAMEDIA-brand AC adapter allows you to power your
digital camera from a common AC wall outlet. Be sure to use the specified AC
adapter. An AC adapter is useful for time-consuming tasks such as downloading
images to a PC or outputting images on a printer.

Use an AC adapter designed to operate on the AC voltage in the area the
camera is being used.

Consult your nearest Olympus dealer or Service center for details.

AC wall outlet

@ Power battery holder

The optional power battery holder allows you to shoot
for longer than when using the lithium ion battery. Be
sure to remove the battery compartment cover
pushing to the direction of the arrow when attaching
the power battery holder to the camera.

For more details, read the instructions provided with

the power battery holder. \

% "§
@~

—

|

19|
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Loading the battery

@

TIPS == mmeemscmee s aaseeaaaaannann

How to use the charger in another country

— To use the charger in another country, equip the charger with an adapter

plug suited to the AC outlet in the intended region of use. Please ask your
travel agency about which adapter plug to use.

Note

|20

If the battery power runs out while the camera is connected to a PC or
printer, the image data may be lost or damaged. You are recommended to
use the AC adapter when transferring images to a PC or printer. Do not
connect or disconnect the AC adapter while the camera is communicating
with the PC or printer.
Do not remove or load the battery or connect or disconnect the AC adapter
while the camera is turned on. Doing so could affect the camera’s internal
settings or functions.
The battery consumption may vary according to the shooting conditions, etc.
Power is consumed continuously during the conditions described below.
This discourages the power to last longer.

* When the monitor is turned on.

* Repeated zoom adjustments.

» Repeated auto-focus by depressing the shutter button halfway.

* When the FULLTIME AF mode is turned on.

* When the camera is connected to a PC or printer.
When using an AC adapter, power is supplied to the camera by the AC
adapter even if a battery is loaded in the camera. The AC adapter does not
charge the battery in the camera.
Carefully read the instructions for the AC adapter before use.



Inserting a card

“Card” in this manual refers to the xD-Picture Card, CompactFlash and
Microdrive. The camera uses the card to record pictures.

The xD-Picture Card can be used simultaneously with CompactFlash or
Microdrive.

Card basics

The card corresponds to normal camera film for recording the pictures you have I

taken. Pictures recorded and stored on the card can easily be erased,
overwritten, and/or edited on a PC.

The following cards can be used. Read the instructions for the card carefully
before use.

xD-Picture Card
* 16 MB to 512 MB

A
OLYMPUS

XD-Picture Card

@ Index area
You can write down the card’s contents.
@ Contact area
Comes into contact with the camera’s signal read contacts.

CompactFlash (CF) (optional)

CompactFlash is a large-capacity solid state flash memory

card. You can use commercially available cards. \ S

» The camera may not function normally with some types of /
CompactFlash cards.

Microdrive (optional)

You can use Microdrive that supports CF+Type |l (CompactFlash expansion
standard). Microdrive is a compact hard disk drive. Be sure to read the
“Precautions for using Microdrive” (P.24).

D 340 MB Microdrive cannot be used.
%« This camera may not recognize a non-Olympus card or a card that was
Note formatted on another device (such as a PC). Before use, be sure to format
the card on this camera. I5~ “Formatting cards” (P.166)

21|
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Inserting a card

1 Make sure the camera is turned off.
* The monitor is off.
* The viewfinder is off.
» The lens is retracted.

2 Open the card cover.

3 Inserta card.

xD-Picture Card

* Insert the card into the front slot, ensuring that it
is not inserted diagonally.

* Insert the card as far as it will go until it clicks.

« If the card is inserted incorrectly oriented or it is
inserted at an angle, the contact area may be
damaged or the card may become jammed.

+ Ifthe card is notinserted fully, it may not be able
to record data.

CompactFlash/Microdrive

» Hold the card straight and insert it correctly into
the rear slot, as shown.

+ Set the eject button in the down position.

4 Close the card cover securely until it
clicks.

Removing the card

xD-Picture Card
* Push the card all the way in to unlock it, then let [~
it return slowly.
The card will be ejected. Take hold of the card
and pull it out.

Note
Releasing your finger quickly after pushing the
card all the way in may cause it to eject forcefully
out of the slot.

|22




Inserting a card

CompactFlash/Microdrive

+ Set the eject button in the upright position.

» Press the eject button gently all the way in. The

card will be ejected a short way.

Take hold of the card and pull it out.

* Return the eject button to the down position
before closing the card cover.

—

9]

Eject button

@ * Do not push the card in with a pen or similar hard or pointed object.
* Never open the card cover, or remove the card or the battery while the
camera is turned on. Doing so could destroy the data stored on the card.
Once destroyed, data cannot be restored.

Note

Switching cards

The card currently in use is indicated in the viewfinder or on the monitor. Choose
the card you want to record the picture on before taking the picture.

The factory default setting is the xD-Picture Card. If only one card is inserted,
that card is automatically selected. Card selection can also be made in Playback
mode.

1 Press the card button repeatedly to select
the card you want to use.
» The indication alternates between the two slots.

Selected card Card button

[CF] : CompactFlash or Microdrive

23|
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Inserting a card

@ Precautions for using Microdrive

The following restrictions apply when using Microdrive. Read the instructions
provided with your Microdrive.

You are recommended to use an xD-Picture Card or CompactFlash card when
taking important pictures.

Operating environment

Microdrive is a compact hard disk drive. As it is a rotating recording medium, it
is not as resistant to vibration or impact as the solid recording medium of other
cards.

When using Microdrive, be careful not to subject the camera to vibration or
impact. (Special care is needed during recording and playback.)

Do not bang the camera down on the table during recording.

Be careful not to hit the camera against anything when carrying it on your
shoulder.

Do not use the camera where the ground is likely to vibrate, such as a
construction site.

Do not use the camera in the car while driving along a bumpy road etc.,
where the camera will be badly shaken.

Precautions regarding Microdrive

Do not write on the label.

Do not remove the label.

Do not over-wrap labels.

It is advisable to keep Microdrive in its case for storage or transportation.
Microdrive may become hot if used for an extended period of time. Care
should be taken when handling Microdrive.

Do not take close to where there is strong magnetism.

Do not apply strong pressure to the cover.

Camera operations
Using Microdrive may increase the battery consumption. To reduce
consumption of the battery, observe the following.

» Whenever possible, refrain from using the monitor during shooting.
Unless there is a particular need, remove the xD-Picture Card when using
Microdrive.

If nothing happens when the buttons are pressed, remove the battery, then
put it back again.

If you use Microdrive when the battery power is low, the camera may not
turn on.

If CARD ERROR is displayed
+ If no pictures can be recorded or downloaded, run SCANDISK on a PC.
I “Error codes” (P.200)
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Turning the power on/off

1 Press the catch on the lens cap in the
direction of the arrow and remove the
lens cap.

the red line.
SET UP mode =" P.45

Turn the mode dial until the mode you want to use is aligned with

Use this mode to perform basic camera settings, such as date/time and beep sound.
When the camera is turned on, the SET UP mode menu is displayed on the monitor.

Shooting mode 5" P.46
Use one of these positions
when you want to take pictures.

3 Press the power switch. Mode dial

Playback mode I=5°P.121
Use this mode to view pictures
you have taken on the monitor.

- The mode in which the camera turns on depends on | — Power switch

the position of the mode dial.

Shooting mode:

The camera turns on in the shooting mode. The
monitor turns on and the lens extends.

Playback mode:

The camera turns on in the playback mode and the
monitor turns on.

SET UP mode:

The menu is displayed on the monitor.
You can change the mode with the camera turned
on, or off.

4 Press the power switch again to turn the camera off.

o TIPS == nxes s e

Setting the date and time

Pictures are saved with the date and time when they were taken.

[ “Setting the date and time” (P.168)

Selecting a language for on-screen display

You can select the language in which illustrations and explanations are
displayed on the monitor.

I¥° “Selecting a language for on-screen display” (P.167)

25|
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Turning the power on/off

The viewfinder or monitor turned off

To reduce battery consumption, the lens retracts to the widest position and the
camera automatically enters the sleep mode after about 3 minutes of non-
operation. The camera activates again as soon as you touch the shutter button
or zoom lever. You can select the length of time until the camera enters the
sleep mode.

[ “SLEEP — Setting the time until the camera enters sleep mode” (P.169)
To reduce battery consumption, the camera turns off automatically and the
lens retracts after about 4 hours of non-operation. To resume operation, turn
the camera on again.

Note

If the camera is subjected to strong vibration or impact while it is turned on,
it may turn off momentarily and the date and other settings return to the
factory default settings.

If the card is not recognized (card check)

When the power is turned on, the camera checks the card automatically. If there
is no card in the camera or a card that is not supported by this camera is
inserted, the following screen is displayed.

Monitor indication Corrective action

There is no card in the camera or the card is not inserted
properly.

NO CARD — Insert a card. If a card is already inserted, remove it and

insert it again.

The card cannot record, play back or erase pictures.

Replace the card with a new one or format the card.

— Press @& to select POWER OFF, then press ®). Replace
POWER OFF the card with a new one.

— Format the card.

| [T) FORMAT ) Press & to select [T] FORMAT, then press @) to display

the confirmation screen. Select YES and press &).

Formatting starts. If the card was successfully formatted, the

camera is ready to take pictures.

<'> » All data stored on the card is erased when the card is formatted.

Note

|26




Adjusting the viewfinder

You can adjust the viewfinder to match your eyesight (visual acuity).

1 With the viewfinder off, press to turn it Viewfinder
on. )

2 Look through the viewfinder and slowly
turn the diopter adjustment ring.

papess Buijen i

3 Turn the diopter adjustment ring until the
AF target mark can be seen clearly.

g% 30 W

ool

AF target mark

Attaching the lens hood

When light shines directly on the lens, flare or ghosting may occur. To prevent
this happening, attach a lens hood.

1 Fit the lens hood matching the lens hood
indicator () with the indicator on the
lens.

2 Turn the lens hood in the direction of the
arrow as far as it goes.

/1, * Thelens hood cannot be attached or detached when the lens cap is on.
* The lens cannot be retracted with the lens hood attached backwards.

27|
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Holding the camera

Hold the camera firmly with both hands while keeping your elbows at your sides
to prevent the camera from moving. When taking pictures in the vertical position,
hold the camera in a position as shown in the illustration.

Keep your fingers, the strap and the lens cap away from the lens, flash and AF
sensor.

Horizontal grip Vertical grip Top view

Do not hold this part of the
lens.

2\
e

) + Clear pictures cannot be obtained if the camera moves as the shutter button

. is pressed. Hold the camera correctly, and press the shutter button gently.

Note . For the best results, hold camera at right position so that flash is positioned
higher than the lens.

You can change the angle of the monitor. This is useful for taking low-angle
shots where the viewfinder or monitor is hard to see.

1 Take hold of the monitor as shown in the
illustration and pull it out.

2 To take low-angle shots, position the monitor in the up position as shown.
» The monitor can be positioned in the down position at an angle of 45 degrees
and in the up position at an angle of 22, 45 or 90 degrees.
» To take high-angle shots, position the monitor in the down position.




2 Using the buttons and menus

Direct buttons and menus

This camera is equipped with direct buttons for quick operation and setting of
various shooting and playback-related functions. The setting screens are
displayed on the monitor when the direct buttons are pressed. Menus are also
provided for selecting the various shooting and playback settings.

Functions that can be set using the direct buttons can also be set using the
menus.

Ex 1: To select a metering mode Control dial

=~ Al d
oo T Arrow pa
Uy

OK button
‘ Using the direct button ‘ ‘ Using the menus ‘
Press ([e)). Press ® to display the menu, then select
MODE MENU — CAMERA tab — ESP/(e].
2 [ {(FLASH MoDE
— \(EsP) S |(AF /& [WF)
e @) CEsPIEDI )
(LniCs)) = D
(LD L on 1 @& )
+ The setting screen is displayed on the * Press @& to select a metering mode.

monitor.
+ Turn the control dial while holding down
(Y to select a metering mode.

29|

snuaw pue suoyng ay3 buisn E



Direct buttons and menus

Ex 2: To select a flash mode Control dial

OK button

‘ Using the direct button ‘ ‘ Using the menus

Press 5 Press () to display the menu, then select
MODE MENU — CAMERA tab — FLASH
MODE.

* The setting screen is displayed on the  Use the arrow pad to select flash-related
monitor. settings.

« Turn the control dial while holding down #
to select a flash mode.

snuaw pue suoyng ay} Buisn !

Select FLASH MODE Select Select ™ FLASH Select & SLOW
(FLASH MODE )P AUTO ) AUTO
(@EZD))oN g@,@
[INEEY
CZ D4 sLom

SELECT# (] SET#[»] GO# [OK] SELECT#(] SET#[] GO#[OK]

C Flash intensity control can be adjusted directly by turning the control dial while
holding down [E%.



Direct buttons

The direct buttons have different functions in the shooting mode and in the
playback mode. Turning the control dial while holding down the direct button
allows you to select menu options or change the values for the different

functions.

Certain function settings require the direct button to be pressed repeatedly.

Direct button basics

The procedure for making settings using the direct buttons and control dial is
shown below. The setting screens are displayed on the monitor when pressing

the direct button.

Ex: Using the ¥ (flash mode) button

1 Turnthe control dial while holding  Control dial

down i to select the flash mode.

» The setting screen is displayed on the
monitor.

« Atthe moment you release your finger from the i
button, the flash mode setting is made.

« If the operation guide is displayed at the bottom of
the screen, you can select further options.

2 Press ® while holding down ¥ to display
the menu.
Release the direct button after the menu is
displayed.
» The menu for changing the current settings for the
various flash options is displayed.

3 Follow the operation guide to select the
item and option you want to change.

I3 For further details, see “Menu basics” (P.38).

I
Operation guide

(FLASH MODE DD ALTO
D0.0

(ERIENASH){ 1N
C DD sLaw

=g
v

The icons displayed in the
operation guide
correspond to the arrow

pad and & button.
31 I
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Direct buttons

C TIPS == ====sscscececscs e s s nnnnns
Further options may be available depending on the option you selected. If the
operation guide is displayed at the bottom of the screen, you can select further

options.
Ex)
When the ®)/i (self-timer/remote control) button is used
Turn the control dial while holding down &)/é to If you select &, the
change the setting. 1 = operation guide is
displayed.
O/i
O#
oh | = L
Q == T ) |\
—> —> i)

Operation guide
Pressing & while
holding down &)/§
displays the screen
for selecting the
time that remote
control is activated.

|32



Direct buttons

Functions that can be set using the direct buttons

@ Shooting mode

AF/ & /MF O/k

Control dial

This means to turn the control dial while holding down the
W direct button to make function settings.

(0) (exposure compensation) button

Changes the exposure compensation value.

P 1/200 F5.6 E¥l

Control dial

~—

=" P.108

The histogram display can be set.
= P.119

® % (flash mode) button

I P.59

Selects a flash mode from auto, <@ (red-eye reduction), % (fill-in flash),
#SLOW (slow synchronization) and (®) (flash off).

Control dial

You can select the various
options available in FLASH
MODE, [ (flash intensity
control), ¥\ FLASH (external
flash) and & SLOW (slow
synchronization) mode.
= P63

33 I

snuasw pue suoynqg ay3 buisn H



snuaw pue suoyng ay} Buisn !

Direct buttons
Prgg:a?the (flash intensity control) buttons I P.64
same time

Adjusts the amount of light emitted by the flash.

N

Control dial

® AF/&/MF (AF/Macro/MF) button IS°P.79, 87, 88

Selects a focus mode from AF (auto-focus), 8 (macro), MF (manual focus),
¥ (super macro) and $%MF (super macro MF).

_AF ]
C¥O

Control dial = :) You can select the various options
AF /% /MF available in FOCUS MODE, AF
:) MODE, FULLTIME AF and P-AF
CommC )| | mode. IEP.74,75,76
When the AF MODE is set to
SPOT, the AF target mark can be
moved. 5 P.77
@ (@) (metering) button I P.81, 83

Selects a metering mode from ESP, spot metering ((¢]),
multi-metering ((8JMULTI) and center-weighted metering (({s1).

Control dial
When the metering mode is set
to (], the metering target can
be moved. 5" P.82
® O/ (self-timer/remote control) button I P.89, 90

Activates the self-timer or remote control function.

Control dial

the time that remote control is
activated. 05" P.91

’— When § is selected, you can set

|34



Direct buttons

® WB (white balance) button I P.109
Selects a white balance setting from AUTO, PRESET 1, PRESET 2, CUSTOM
and 53, (one-touch).

Control dial
:) The screen for setting the
e selected white balance is
( SET ¥0K] ) 2 ’7displayed. 1°P.109-113
——
(@) <€:- (record mode) button IS P.105
Sets the image quality and resolution.
Still pictures : RAW, TIFF, SHQ, HQ, SQ1, SQ2
Movies : SHQ, HQ, sQ
Control dial
The screen for setting the
selected record mode is
displayed. I5°P.105

4] (custom) button IS P.154
Activates the function registered on the custom button.

See “Custom button” (P.154) for details of how to register a function and use
the button.

© QUICK VIEW button I’ P.122
Displays the last picture taken on the monitor.

@ AEL (AE Lock) button I P.85

Fixes the exposure. The lock function is alternately activated and canceled
each time you press the button.

35|
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Direct buttons

@Playback mode

AF/ & /MF

0]
)

@ O (protect) button IS P.142
Protects important pictures from accidental erasure.

® INFO (information display) button I P.135
Displays the shooting information and histogram.

® 9 (rotation) button IS°P.123
Rotates pictures 90 degrees clockwise or counterclockwise.

@ &k (print) button IS PA178
Stores print reservation data on the card.

® & (erase) button IS5°P.143, 144

|36
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Using the menus

There are two types of menu: the top menu which is the first screen that appears
on the monitor when you turn on the camera and press &), and the MODE
MENU which categorizes settings into tabs. The functions of this camera are set
from the menus. When the mode dial is set to SET UP, the MODE MENU is
displayed instead of the top menu.

MENU.

+ Setting the mode dialto P A S M &P & &) Aa 8 €Y
and pressing displays the top menu in the shooting
mode.

+ Setting the mode dial to [>] and pressing @) displays the
top menu in the playback mode.

|
Press

v

[ Top menu ]

* Setting the mode dial to SET UP displays the MODE }_

=1
(TS0 (Hooe WewD)

DIGITAL Z00M)
\v4

Use the arrow pad to
e % select a menu.

4
( Shortcut menus ] [ MODE MENU ]
« Take you directly to the setting screens. « Categorizes the settings into tabs.
« Display operational buttons at the « Displays the associated menu items
bottom of the screen. when a tab is selected by pressing
« The functions registered in the shortcut .
menus can also be accessed from the « Display operational buttons at the
MODE MENU. bottom of the screen.

* You can change the shortcut menus in
any mode other than @[>] modes.
IS “SHORT CUT” (P.157)

!

.10 ]
DIGITAL Z00M) 4

lose fecion) | ON
 FUNCTION
FRATE ASSIST)
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This section explains how the menus work, using the P mode screens. Setting
the mode dial to SET UP displays the screen in Step 2.

I Press () to display the top 2 Press & & to select
menu, then press 9. a tab, then press ).
Top menu CAMERA tab
yay
9 9
AC1S0 ) (wook WEW)D| ———> «—
8
v
Press @ to
(<) return to
selection
(= Hbauto | screen.
C= bne
(L DbwomasL
(SHARPNESS |)E+0
[(CONTRAST))::-0

>
@ )T Arrow pad
OK/Menu button

- J

@l @
CARD tab
| CARD SETUP

12 tab

|38



Menu basics

3 Press & to select the 4 Press & to select a
item you want to set, then setting. Press & to
press b). complete setting.

Press & again
to exit the menu.

Slider bar
Displayed when there are more
items on the next page.

To return to select
anitem, press @ or

&/,

The green frame moves
to the selected item.

— 5 P
— 18V
Gz jams)
Bor® &= oD
Con ) @

D

&
—

ESP/

el
i

While SET UP is selected on the
mode dial, turn the dial other than
SET UP to exit the MODE MENU.

* Notallitems can be selected depending on the status of the camera and the
@ settings performed.
* You can take pictures by pressing the shutter button in the shooting mode
with the menu open.
* If you want to save the settings even if the camera turns off, set ALL RESET
to OFF. I=¥"“ALL RESET - Saving the camera’s settings” (P.145)
39 I

Note
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@ Shooting mode

PA SM®?
A °8 Y mode & mode
(for still pictures) (for movies)
pay yay
AC 150 ) (woE MeN)D (150 ) (wopE MENU))
< <

(Factory default setting)

=

Selects a shooting mode from [ (single-frame shooting), HI1Ey (high
speed sequential shooting), (=) (sequential shooting), P.92
AF &y (AF sequential shooting) and BKT (auto bracketing).

¥ (movies)
‘ Selects whether to record sound when shooting a movie. ‘ P.101
1ISO
‘ Selects the ISO value from AUTO or in the range of ISO 50 to ISO 400. ‘ P.107
DIGITAL ZOOM
‘ Digitally enhances the maximum optical zoom. ‘ P.58
TIPS = == === ========cscsseeeesseeeeneesm=n

The functions registered in the shortcut menus can also be accessed from the

MODE MENU. You can change the shortcut menus in any mode except &
and [>] modes. I~ “SHORT CUT” (P.157)
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Shortcut menus

@Playback mode ([>])

For still pictures For movies
&
= MOVIE PLAY
N 7~ N
I8 ) (ooE mEND)D dCcopy ) (wopE MENY))
D s ~—
<

=
Runs through all saved pictures one after another. P.127 ‘
MOVIE PLAY
MOVIE PLAYBACK | Plays back movies. P.128
INDEX Creates an indexed view of a movie in 9 frames. P.131
EDIT Edits a movie. P.132
&

‘ Displays guidelines on the image. P.136 ‘
COPY
Copies pictures to and from cards. Lets you select whether to copy all P 141
frames or only a selected frame. :

U

Adds sound to a still picture already taken. P.137 ‘

41|

snuasw pue suoynqg ay3 buisn E



snusw pue suoyng ay3 buisn !

Mode menus

The MODE MENU functions are divided into tabs. Press &>& to select a tab
and display the associated menu items.

TABS

CAMERA tab: regards picture taking.
PICTURE tab: regards picture appearance.

EDIT tab
CARD tab

12 tab
SETUP tab

: regards editing picture already taken.
: regards memory card formatting, etc.
: regards customizing functions.

: regards basic settings of the camera.

@Shooting mode (P A S M & & ®] A %8 ) mode)

CAMERA tab
PICTURE tab
CARD tab

12 tab

CAMERA tab

FLASH MODE

AF/W/MF

ESP/(®)

D

Ok
ISO

DIGITAL ZOOM
NOISE REDUCTION

FUNCTION
FRAME ASSIST

¢
MY MODE

|42

Selects flash-related settings.

Sets the options available in flash mode, flash intensity
control, external flash and slow synchronization.

Sets the options available in focus mode, AF mode,
fulltime AF and P-AF.

Selects a metering mode from ESP, spot metering, multi-

metering and center-weighted metering.

Selects a shooting mode from (3 (single-frame
shooting), HIE (high speed sequential shooting), =
(sequential shooting), AF = (AF sequential shooting)
and BKT (auto bracketing).

Selects the self-timer or remote control function.

Selects the ISO value from AUTO or in the range of ISO
50 to ISO 400.

Digitally enhances the maximum optical zoom.
Reduces the noise that affects pictures during long
exposures.

Enables panorama and guideline shooting, and lets you
take pictures in black & white or sepia tone.

Displays lines as a guide for composing the picture.
This function lets you record sound when taking a still
picture.

Selects a mode to be activated when taking pictures in
®? mode.

Displays a histogram showing the luminance distribution
of still pictures.

P.59

P.74,
75,76

P.81

P.92

P.89,
90

P.107
P.58
P.118

P.95,
97,98
P.99

P.100
P.73

P.119




Mode menus

WwB

<«

SCENE MODES

SHARPNESS
CONTRAST
HUE
SATURATION

CARD tab
CARD SETUP

& tab
ALL RESET

REC VIEW
BEEP
SHUTTER SOUND

DIAL

EV STEP

CUSTOM BUTTON
SHORT CUT
MY MODE SETUP

CONTROL PANEL

PICTURE tab

Sets the appropriate white balance according to the light
source. Also adjusts and saves the white balance.

Sets the image quality and resolution.

Still pictures : RAW, TIFF, SHQ, HQ, SQ1, SQ2

Movies : SHQ, HQ, sQ

Lets you take pictures suited to the situation and the
desired effect (N, [, ®)).

Adjusts the sharpness of the image.

Adjusts the contrast of the image.

Adjusts the overall tint of the picture.

Adjusts the level of color depth without changing the tint.

Formats a card.

Selects whether to keep the current camera settings
when you turn off the power.

Displays the picture on the monitor while recording it to
acard.

Sets the beep sound used for button operations and
adjusts the volume.

Sets the sound made when the shutter button is pressed
and adjusts the volume.

Changes the control dial, arrow pad and direct button
functions.

Selects whether to set the shutter speed, aperture value
and exposure compensation, etc. in 1/3EV steps or in
1/2EV steps.

Lets you assign a frequently used function to the
camera’s custom button.

Lets you assign frequently used functions as shortcut
menus.

Customizes settings which are activated in the &
mode.

Displays the settings in the shooting mode on the
monitor.

P.109

P.102

P.117

P.114
P.115
P.116
P.117

| P.166

snuasw pue suoynqg ay3 buisn H

P.145

P.147

P.148

P.149

P.150

P.153

P.154

P.157

P.160

P.163
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Mode menus

@Playback mode ([>])

EDIT tab
CARD tab

12 tab

EDIT tab”
RAW DATA EDIT

Cul
=

COPY

CARD tab
CARD SETUP

12 tab
ALL RESET

BEEP

VOLUME
=

|44

B~ (oo,
CD
e
—| &5

(for still pictures)

Sets the image quality, white balance, etc. of pictures

taken in RAW data format and saves them as new files.

Makes the file size smaller and saves it as a new file.
Crops part of a picture and saves it as a new file.

Copies pictures to and from cards. Lets you select
whether to copy all frames or only a selected frame.

* The EDIT tab is not displayed during movie playback.

Erases all image data stored on the card or formats a
card.

Selects whether to keep the current camera settings
when you turn off the power.

Sets the beep sound used for button operations and
adjusts the volume.

Adjusts the sound volume during playback.

Selects the number of frames in the index display.

P.140

P.138
P.139

P.141

P.144,
166

P.145

P.148

P.165
P.126



Mode menus

@ SET UP mode

1 tab
SETUP tab

& tab

ALL RESET
REC VIEW
BEEP

SHUTTER SOUND
DIAL

EV STEP
CUSTOM BUTTON
SHORT CUT

MY MODE SETUP

CONTROL PANEL

VOLUME
=

SETUP tab
s
D

»)

SLEEP

FILE NAME
BATTERY SAVE

PIXEL MAPPING
[mm]}

mift

VIDEO OUT

AF ILLUMINATOR
usB

@ vou
(@ECViEw pio
BEer |
EED
C o bmoaL

tab in SET UP mode.

Selects whether to keep the current camera settings
when you turn off the power.

Displays the picture on the monitor while recording it to a card.

Sets the beep sound used for button operations and
adjusts the volume.

Sets the sound made when the shutter button is pressed
and adjusts the volume.

Changes the control dial, arrow pad and direct button
functions.

Selects whether to set the shutter speed, aperture value and
exposure compensation in 1/3EV steps or in 1/2EV steps.
Lets you assign a frequently used function to the
camera’s custom button.

Lets you assign frequently used functions as shortcut
menus.

Customizes settings which are activated in the &
mode.

Displays the settings in the shooting mode on the
monitor.

Adjusts the sound volume during playback.

Selects the number of frames in the index display.

Selects a language for on-screen display.
Sets the date and time.

Sets the beep sound used for warnings and adjusts the
volume.

Sets the time from the moment the camera was last
operated until it enters sleep mode.

Changes how file names are assigned.
Turns the powersaving mode on and off.

Checks the CCD and image processing functions for
errors.

Adjusts the brightness of the viewfinder or monitor.
Sets the measurement unit (m/ft) used during manual focus.

Selects NTSC or PAL according to your TV's video signal
type. TV video signal types differ depending on the region.

Turns on the AF illuminator to illuminate a dark subject.

Sets whether the camera is connected to a PC or a
printer with the USB cable.

The functions assigned to the &
tab in both shooting and playback
modes can also be setfromthe 1@

P.145
P.147
P.148

P.149
P.150
P.153
P.154
P.157
P.160

P.163

P.165
P.126

P.167
P.168

P.169

P.169

P.170
P.171

P.172

P.173
P.173

P.174
P.78
P.175

45|
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3 Shooting basics

Shooting mode

The shooting mode includes modes where the optimal settings for the situation
are automatically selected, and modes where you can select the settings best
suited to the shooting conditions and the effect you wish to achieve.

You can change the mode with the camera turned on, or off.

Situation-related
modes
SET UP mode

Mode dial

Setting-related modes

J

Setting-related modes

P Program shooting

The camera automatically sets the optimum aperture value and shutter speed
for the brightness of the subject. Other functions, such as flash mode and record
mode, can be adjusted manually.

Program shift = = = = = = == = ===« c e mcmneneee e

Program shift allows you to change the combination of aperture value and
shutter speed set by the camera without altering the exposure.

* Press & to change the aperture value and the shutter speed that
determines an appropriate exposure.
» Ps is displayed on the monitor in the program shift mode.

+ To cancel the program shift mode, do one of the following:
« If the combination of shutter speed and aperture value was changed by pressing &,
press & until Ps goes out.
« If the combination of shutter speed and aperture value was changed by pressing &,
press & until Ps goes out.
« Change the mode to A, S, M, @2 or &.



Shooting mode

A Aperture priority shooting

Allows you to set the aperture manually. The camera sets the shutter speed
automatically. By decreasing the aperture value (F number), the camera will
focus within a smaller range, producing a picture with a blurred background.
Increasing the value forces the camera to focus over a wider range in the
forward and backward directions, resulting in a picture in which both the subject
and the background are in focus.

5" “Aperture priority shooting” (P.70)

=)
¥

et el
Aperture (F number) is decreased. Aperture (F number) is increased.

S Shutter priority shooting

Allows you to set the shutter speed manually. The camera sets the aperture
automatically. Set the shutter speed according to the subject and the type of
effect you want.

5 “Shutter priority shooting” (P.71)

g

v e e 8 :
Setting the shutter speed Setting the shutter speed
higher lets you capture fast- lower blurs a moving
moving action without blur. subject, giving the
The subject will be clear and impression of movement.
sharp, as if it were not
moving.

47|
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Shooting mode

M Manual shooting

Allows you to set the aperture and shutter speed manually. To check the
exposure, refer to the exposure differential displayed on the monitor. This mode
gives you more creative control, allowing you to make the settings you need to
get the type of picture you want, regardless of optimum exposure. Using bulb
allows you to take pictures at the max of 8 min of long exposure.

I “Manual shooting” (P.72)

&P My Mode

Allows you to save your favorite settings as your own personal mode and use
these customized settings when taking pictures. Current settings can also be
saved for retrieving by this mode. =" “MY MODE SETUP — Setting a function
in My Mode” (P.160) =5~ “Using My Mode” (P.73)

& Movie record

This function allows you to record movies. The camera automatically
determines the aperture and shutter speed. Sound is recorded at the same time.
The focus and zoom are locked. If the distance to the subject changes, focus
may be compromised.

I “Recording movies” (P.55)
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Shooting mode

Situation-related modes

Night Scene shooting

Suitable for shooting pictures in the evening or at night. The camera sets a
slower shutter speed than is used in normal shooting. For example, if you take
a picture of a street at night in P mode, the lack of brightness will result in a dark
picture with only dots of light. In the Night Scene shooting mode, the true
appearance of the street is captured. The camera automatically selects the
optimal settings for this type of shooting condition. Since the shutter speed is
slow, make sure you stabilize the camera by using a tripod.

A\ Landscape shooting

Suitable for taking pictures of landscapes and other outdoor scenes. Both the
foreground and the background are in focus. Since blues and greens are vividly
reproduced in this mode, it is excellent for shooting natural scenery. The camera
automatically sets the optimal shooting conditions.

°A Sports shooting

Suitable for capturing fast-moving action (such as sports) without blur. Even a
fast-moving subject will be clear and sharp as if it were not moving. It enables
you to capture facial expressions and detailed activity. The camera
automatically sets the optimal shooting conditions.

ﬁ Portrait shooting

Suitable for taking a portrait-style shot of a person. This mode features an in-
focus subject against a blurred background. The camera automatically sets the
optimal shooting conditions.

@ » The available settings vary depending on the mode. ¥ “List of items by

shooting mode” (P.217)
Note

49|
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Taking still pictures

You can take still pictures using either the viewfinder or the monitor.

p Als M ®lAsN

1 SetthemodedialtoP A S Mm? &) Aa ° Mode dial
or Y and turn the camera on. Viewfinder
=" “Turning the power on/off” (P.25)

[To take pictures with the viewfinder, press ]

to turn the viewfinder on.

button
Card access lamp

2 Compose the picture. AF target mark

Green lamp
5mark

H.ﬂ'-l._w I

HONg264:848

3 Press the shutter button gently (halfway) to adjust =
the focus. %/.//_:

+ The AF target mark moves to the focus position. |—|’

* The shutter speed and aperture value automatically
selected by the camera are displayed on the monitor
(except in M mode).

* Monitor indications when the shutter button is pressed halfway are shown in
the following table.

Indication Meaning
Flash stand-by. The flash fires when the shutter-release button
is pressed all the way.
imark If the flash has popped up: flash is charging. Remove your

. finger from the shutter button and wait until the lamp goes off.
Blinks ; . i
If the flash is closed: camera movement warning. Press the
flash pop-up button to open the flash.
Lights | The picture is in focus or the exposure is locked.
The picture is out of focus or the exposure is not locked. Also
see TIPS on P.51.

4 Press the shutter button all the way (fully). =
* The camera takes the picture.
» The card access lamp blinks while the picture is stored on

the card.
* You can check the picture you have taken by pressing the QUICK VIEW
button. I="“QUICK VIEW” (P.122)

Shutter button

Lights

Green
lamp | Blinks
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Taking still pictures

@ Canceling recording to the card

You can cancel recording to the card while the picture you have taken is being
stored. Once recording to the card has been terminated, the picture will not be
stored. You can cancel recording to the card when the picture was taken in RAW
or TIFF record mode. B “Record mode” (P.102)

1 Press f§ while the picture you have taken Card access lamp
is being recorded to the card (while the
card access lamp is blinking).
* The picture just taken is displayed on the
monitor.

% Erase

button

Arrow pad

Ll OK button

2 Press ®& to select REC. START or REC.
CANCEL (CANCEL ONE or CANCEL ALL),
then press ®.

REC. START Recording to the card is resumed. & &
The picture displayed on the P _. B
monitor is stored on the card. &  GO*OK] |
REC. CANCEL The picture displayed on the i
monitor is not stored on the card.

* REC. CANCEL is not displayed in sequential shooting mode or when several
pictures are taken in succession. In this case, select CANCEL ONE or
CANCEL ALL.

CANCEL ONE The picture displayed on the
monitor is erased without being
stored on the card. All other
pictures are stored on the card.

CANCEL ALL  None of the pictures taken is
stored on the card.

C TIPS === === c e emsssssse s
The subject cannot be focused on.
I “If correct focus cannot be obtained” (P.53)
The green lamp blinks.
— You are too close to the subject. Take the picture atleast 20 cm (7.9") away
from the subject. If you use the super macro mode, you can take pictures
as close as 5cm/(1.2") from the subject. I=5 “Super macro shooting” (P.88)
— Depending on the subject, the focus and exposure may not be locked.
I “Subjects that are difficult to auto focus on” (P.54)
51 I

soiseq Bunjooys H



soiseq Bunjooys !

Taking still pictures

To check the picture you have just taken immediately.
— Set REC VIEW to ON. 15" “REC VIEW — Checking the picture immediately
after shooting” (P.147)

To record sound when taking pictures.

— You can record sound when taking still pictures. Set & to ON.
I=5” “Recording sound with still pictures” (P.100) You can also add sound to
a picture that has already been taken. 15" “Recording sound” (P.137)

The viewfinder or monitor turned off.

— The camera automatically enters the sleep mode and the viewfinder and
monitor turn off after about 3 minutes of non-operation. Touch the shutter
button or zoom lever to turn the viewfinder or monitor on again. You can
select the length of time until the camera enters the sleep mode.

[ “SLEEP - Setting the time until the camera enters sleep mode” (P.169)

To adjust the brightness of the viewfinder or monitor.
— Select 183} in the mode menu and adjust the brightness. B “Adjusting the
brightness of the monitor and viewfinder” (P.173)

The viewfinder or monitor is hard to see.

— When you point the camera lens toward a bright subject, smears (lines like
beams of light) may appear on the image in the viewfinder or on the monitor.
This does not affect recorded pictures.

To check the area the camera is focusing on.
— If you press while pressing the shutter
button halfway, the area you are focusing on is
enlarged. Pressing once more returns the
size to normal. This function is not available in
the digital zoom range.
=¥ “Using the digital zoom” (P.58)

Note

|52

Press the shutter button gently using the ball of your finger. If it is pressed
hard, the camera may move and pictures may come out blurred.

» Recorded pictures will be saved on the card regardless of whether the
camera is turned off or the battery is replaced or removed.

Do not open the card cover, remove the battery or connect/disconnect the
AC adapter while the card access lamp is blinking. Doing so could destroy
stored pictures and prevent storage of pictures you have just taken.

When taking pictures against strong backlight, the area of the picture in
shadow may appear colored.



If correct focus cannot be obtained

When the subject you want to focus on is not in the center of the frame and you
cannot position the AF target mark on it, you can focus the camera on another
point at roughly the same distance (focus lock) and take the picture as explained
below.

Determine the position of the subject after focusing (Focus Lock)

[Mode dia )P [A]'s | Mm?/E) da 80

1 Position the AF target mark on the subject you
want to focus on.
* When shooting a hard-to-focus subject or a fast-
moving subject, point the camera at an object about
the same distance away as the subject.

2 Press the shutter button halfway and check
that the green lamp lights steadily.

When the focus and exposure are locked, the

green lamp lights steadily.

The AF target mark moves to the focus position. Shutter button

When the green lamp blinks, the focus and

exposure are not locked. Release your finger from the shutter button, re-

position your subject and press the shutter button halfway again.

soiseq Bunjooys H

3 Keeping the shutter button pressed halfway, Green lamp

recompose your shot. BT ETYE RGN |

4 Press the shutter button all the way (fully).

Shutter button

GUTIPS == mssss e

%" The frame in which you focus on a subject is different from the frame in
which you lock the exposure.
I3 “AE Lock - Locking the exposure” (P.85)

You want to focus on the center of the frame.
[=¥"“AF MODE - Changing the focus range” (P.74)
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If correct focus cannot be obtained

Subjects that are difficult to auto focus on

Under certain types of conditions, the auto focus may not work properly. If this
happens, focus on an object with high contrast at the same distance as the
intended subject (focus lock), recompose your shot and then take the picture. If
the subject has no vertical lines, hold the camera vertically and focus the
camera using the focus lock function by pressing the shutter button halfway,
then return the camera to the horizontal position while keeping the button
pressed halfway and take the picture.

If the subject still cannot be focused on, use the manual focus.

I “Manual focus” (P.79)

Green lamp blinks: the subject cannot be brought into focus.

Subject with low contrast Subject with an extremely Subject without vertical
bright area in the center of lines
the frame

The green lamp lights, but the subject cannot be brought into focus.

The subject to be
focused on is not in the
center of the frame.

Subjects at different Fast-moving subject
distances
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Recording movies

You can also record movies with this camera. Sound is recorded at the same
time. The focus and zoom are locked. If the distance to the subject changes,
focus may be compromised.

Mode dial J) &

1

Set the mode dial to & and turn the camera  Mode dial
on. Power switch

=" “Turning the power on/off” (P.25)

» Theremaining recording time on the card that you
are using is displayed on the monitor.

Compose the picture.
* You can use the zoom lever to enlarge your
subject.

soiseq Bunjooys H

Press the shutter button fully to start
recording.

* The focus and zoom are locked.

* During movie recording, lights red.

Remaining recording

Press the shutter button again to stop time

recording.

* When the remaining recording time has been used up, recording stops
automatically.

* When there is space in the card memory, the remaining recording time is

displayed, and the camera is ready to shoot the next movie.
I=5” “Movie Record Modes” (P.104)
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Recording movies

C TIPS == ====sscscececscs e s s nnnnns
To keep your subject in focus all the time while shooting.
The auto focus does not operate during recording when & (movie) is set to
ON.
— Set ® (movie) to OFF and FULLTIME AF to ON. I “FULLTIME AF - A
reliable time-saving way to focus” (P.75)

To use the zoom while shooting.

The optical zoom is not available during recording when & (movie) is set to

ON.

— Set DIGITAL ZOOM to ON. =5 “Using the digital zoom” (P.58)

— Set & (movie) to OFF, and you can use the optical zoom while shooting.
I=5” “Recording sound with movies” (P.101)

Depending on the card, the remaining recording time may drop rapidly
during recording. Try using the card again after formatting it.

Note g3 “Formatting cards” (P.166)

When @ is set to ON, the movie is recorded with the focus that was set when
the shutter button was pressed in Step 3. If the distance to the subject
changes, focus may be compromised.

In & mode, the flash and manual focus (MF) cannot be used.

Notes for recording movies over a long time

* Recording will continue until the card is full unless stopped by pressing the
shutter button.

* A long recorded movie cannot be edited. (P.130)

« If a single movie recording uses up all of the card’s memory, create space
on the card by deleting the movie or downloading it to a PC.
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Telephoto and wide-angle shooting are possible at 5x magnification (the optical
zoom limit, equivalent to 28 mm to 140 mm on a 35 mm camera). By combining
the optical zoom with the digital zoom, zoom magpnification can be increased to
a maximum of approximately 15x.

Camera movement is likely to occur at higher magnifications. Stabilize the
camera with a tripod, etc. to avoid camera movement.

Using the optical zoom

PIA s M EDXRE Al

1 Turn the zoom lever. Zoom lever

Wide-angle: Telephoto:
Turn the zoom lever toward Turn the zoom lever toward
W to zoom out. T to zoom in.

e

R T i e
e VL
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Zoom

Using the digital zoom

[y v 4] [ DAY

1 In the top menu, select MODE MENU > Zoom lever
CAMERA - DIGITAL ZOOM - ON, and
press ®.

I “Menu basics” (P.38)

» IfDIGITAL ZOOM is displayed on the top menu as
a shortcut menu, press the arrow pad in the same
direction as the arrow shown next to DIGITAL
ZOOM. 15" “SHORT CUT” (P.157)

\—— Arrow pad

oK
@ OK button

* Press (® again to exit the menu.

Mode dial J &

1 In the top menu, select DIGITAL ZOOM - ON, and press &).

2 Turn the zoom lever toward T.

* The white area of the zoom indicator indicates the
optical zoom. If the digital zoom is set to ON, a red
area appears on the zoom indicator. When you [
reach the limit of the optical zoom, the digital zoom sz —m ey

is enabled. S 'D.]
o 100, G204

P &l/200 FB.6 0.0

7
[

|
The cursor moves up and
down on the zoom indicator
according to the zoom
magnification.
The cursor turns orange
when inside the digital zoom
field.

@ * In & mode, the maximum digital zoom magnification is 2.5x.

N Pictures taken with the digital zoom may appear grainy.
ote
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4 Flash
Flash shooting

Select the flash mode best suited to the light conditions and the effect you want
to achieve. You can also adjust the amount of light emitted using the flash
intensity control.

p Als M EP ElAS Y

1 Press the flash pop-up button (D).
+ The flash pops up (@).

Flash pop-up button
2 Set the flash mode by turning the control Control dial
dial while holding down ¥
» The flash mode changes in the sequence shown
below. (The selectable flash modes may differ
depending on the shooting mode.)

Auto (Auto-flash) <> <@ (Red-eye reduction flash) <> & (Fillin flash)

L @ (Flash off) <> ¥ SLOW (Slow synchronization) J

3 Press the shutter button halfway. $mark
. i lights when the flash is ready to fire.

4 Press the shutter button fully to take the
picture.

Flash working range
W (max.): Approx. 0.8 — 5.8 m (2.6 — 19 ft.)
T (max.): Approx.0.2—-4.0m (0.7 -13.1 ft.)
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Flash shooting

C TIPS == === s e e s mmmns
The ¥ (flash charging) indication blinks.

— The flash is charging. Wait until ¥ goes off.

Shutter speed when using the flash (Auto-flash, red-eye reduction, fill-in

flash).

—>When ¥ lights, the flash fires automatically but the shutter speed locks at a
level at which camera movement is not likely to occur. The level at which
the shutter speed locks changes depending on the zoom position.

Zoom position | Shutter speed
W (max.) 1/30 sec.
T (max.) 1/125 sec.

AUTO, <®, ¥ and @ % SLOW are not available in S and M modes.
The flash does not fire in the following situations:
In & mode, during sequential shooting (HI=y, &y, AF 2y, BKT),
during super macro shooting, during panorama shooting.
The flash may not give you the optimum result in macro mode, especially
with wide-angle shooting. Check the resulting picture on the monitor.
When a conversion lens is attached to the camera, vignetting may occur. To
take flash pictures, use an external flash.

°

Note

@ Auto-flash (No indication)
The flash fires automatically in low light or backlight conditions.

@Red-eye reduction flash (<©)

The light from the flash may make the subject’s eyes appear red in the picture.
The red-eye reduction flash mode significantly reduces this phenomenon by
emitting pre-flashes before firing the regular flash. This helps accustom the
subject’s eyes to the bright light and minimizes the red-eye phenomenon.

The subject’s eyes appear red.

@ « After the pre-flashes, it takes about 1 second before the shutter is released.

> Hold the camera firmly to avoid camera movement.

« Effectiveness may be limited if the subject is not looking directly at the pre-
flashes, or if the shooting range is too far. Individual physical characteristics
may also limit effectiveness.

Note
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Flash shooting

@Fill-in flash gQ)

The flash fires regardless of the available light. This mode is useful for
eliminating shadows on the subject’s face (such as shadows from tree leaves),
in a backlight situation, or for correcting the color shift produced by artificial
lighting (especially fluorescent light).

@ + The fill-in flash may not have the desired effect under excessively bright

light.
Note 9

@Flash off ((®)

The flash does not fire even in low light conditions. Use this mode in situations
where flash photography is not desired or is prohibited. You can also use this
mode when you want to shoot a natural-looking twilight or night scene.
Besides setting the mode to ), flash does not fire when it is closed.

@ + Since a slow shutter speed is automatically selected in low light situations
: when in the flash off mode, the use of a tripod is recommended to prevent

Note  your pictures from being blurred by camera movement.

@ Slow synchronization (§ SLOW1 ¢ SLOW2 <& 5SLOW1)

The slow synchronization flash is designed for slow shutter speeds. Normally,
when shooting with a flash, shutter speeds cannot go below a certain level to
prevent camera movement. But when shooting a night scene background, fast
shutter speeds can make the background too dark. Slow synchronization flash
allows both a slow shutter speed for the background and a flash for the subject.
Since the shutter speed is slow, make sure you stabilize the camera by using a
tripod. Otherwise, camera movement may cause the picture to be blurred.

In S and M modes, the flash fires at the selected shutter speed.

1st curtain (front curtain) § SLOW1

Usually, regardless of the shutter speed, the flash fires right after the shutter
fully opens. This is called 1st curtain. Unless you change it, this is how the flash
always fires. The factory default setting for slow synchronization is i SLOW1.
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Flash shooting

2nd curtain (rear curtain) § SLOW2

The 2nd curtain fires just before the shutter closes. Changing the flash timing
can create interesting effects in your picture, such as expressing the movement
of a car by showing the tail-lights streaming backwards. The slower the shutter
speed, the better the effects turn out.

The slowest possible shutter speed depends on the shooting mode:

A, S, M mode : 15 sec. (Bulb shot is available in M mode.)
P, @, &, %8, Y mode : 4 sec.

When the shutter speed is set to 4 sec.

* " -

-
rear curtain 4 selc.“?” ‘?’ E) front curtain

2nd curtain flash fires  1st curtain flash fires

Shutter closes Shutter fully opens

1st curtain with red-eye reduction <© % SLOW1

This mode is for when you want to use slow synchronization, yet also reduce the
red-eye phenomenon. For instance, when shooting a person against a brightly
lit night background. A normal flash might make the person’s eyes red, but 1st
curtain with red-eye reduction lets you capture the background correctly and
reduce the red-eye phenomenon at the same time. 2nd curtain with red-eye
reduction is not available.
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Using the slow synchronization flash

[Mode dia )P [A]'s | Mm?/E) Aa /0

1 Press ® while holding down §.

o
o
— 4
3 Press ®® to select § SLOW1, @ 5SLOW % [ & sLown |
or §SLOW2, then press ®. ’ ‘

* Press (@ again to exit the menu.

2 Press ®& to select iSLOW, then press

yser4

SELECT # €} GO # [OK]
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Flash intensity control

You can adjust the amount of light emitted by the flash.

In some situations, you may get better results by adjusting the light emission.
Examples include small subjects, distant backgrounds, or situations when
increased contrast is desired.

[Mode dia )P A |'s | M m?/ =) 8 (Y

1 Adjustthe brightness by turning the control Control dial
dial while holding down % and [ at the fXPOSUfe compensation
same time. uien

Turning to the left Turning to the right

decreases the light w increases the light
emission. N\ 4 emission.

Min. setting is —2.0. Max. setting is +2.0.

Q TIPS = ===ssssccsmennennennennasnennesnsnneens
Y » The flash intensity can be set in 1/3EV steps or 1/2EV steps.
I “EV STEP - Setting exposure adjustment increments” (P.153)

» The flash adjustment effect may not be sufficient if the shutter speed is

o faster than 1/300.
Note
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External flash (optional)

Using an Olympus external flash

Various types of flash shooting are possible with the Olympus FL series external
flashes.

If the external flash is used, flash mode and exposure compensation will be
detected automatically by the camera, allowing the built-in flash and external
flash to function together.

The external flash is mounted on the camera by attaching it to the hot shoe on
the top of the camera. To use the external flash together with the built-in flash,
the FL-BKO1 flash bracket (optional) and FL-CBO02 bracket cable (optional) are
required.

This section explains how to use the FL-20 when attached to the hot shoe.

[ (# [5 Wss A

1 Slide the shoe cover off in the direction of Hot shoe
the arrow and attach the external flash.
* Forinstructions on how to attach the flash, refer
to the manual for the external flash.
» Keep the shoe cover in a safe place to prevent it
getting lost, and replace it on the camera when
you have finished using the external flash.
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External flash (optional)

2
3

Press ® while holding down %.

- [ FLASH MODE
Press ® & to select ™ FLASH, then . &= )
press §. CAFASICINN)
I=° “Menu basics” (P.38) (::D
To use the external flash only

— Select *®, then press ®).

To use the external flash together with the built-in flash, use Olumpus flash
bracket and the bracket cable (both optional).
— Select IN+*®} | then press ®).

Turn on the external flash.
+ Set the mode dial to TTL-AUTO.
» Be sure to attach the flash to the camera before turning the flash on.

Select the flash mode by turning the control dial while holding
down %.
=¥ “Flash shooting” (P.59)

@ « If close-up pictures are overexposed, try using the built-in flash by itself.

Note

* When the built-in flash and the external flash are used together, the built-in
flash is used as the compensating light source. This means that if the
amount of light from the external flash is insufficient (beyond its working
range), the resulting pictures may be underexposed.
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External flash (optional)

Using a commercially available external flash

Provided that the flash can be connected to the hot shoe, a commercially
available external flash may be used. For details on compatible commercially
available external flashes, refer to the next page. The amount of light emitted
cannot be adjusted on commercially available external flashes except Olympus
FL series. If the external flash gets in the way of the built-in flash when the flash
pop-up button is pressed, use a flash bracket.

Mode dial ) M @2

1 Attach the external flash to the hot shoe
and connect it to the camera.
» For instructions on how to attach the flash, refer
to the manual for the external flash.

2 select M mode. Adjust the shutter speed
and aperture.
[=” “Manual shooting” (P.72)

* Remember that a slow shutter speed can
produce blurred images. For the best results, we
recommend that you set the shutter speed from
1/200 to 1/300 seconds.

3 Turn on the external flash.
» Be sure to attach the flash to the camera before turning the flash on.

4 Set the mode that automatically controls the amount of light
emitted by the external flash. Also set ISO and aperture on the
external flash to match the camera’s settings.

+ Refer to the user’s manual for the external flash to select the mode.

@ * The camera’s flash mode will have no effect on the external flash. The
external flash will fire even when the camera’s flash mode is set to ) (off).
» Confirm in advance that the external flash you are using is synchronized
with the camera.

Note
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External flash (optional)

Compatible external flashes

When selecting an external flash, use products which meet the following

basic conditions.

(1) Some flashes available on the market operate with a high voltage synchro
terminal. If one of these is used, it may damage the camera, and/or the
camera may not function normally. Contact the manufacturer of the flash
you are using concerning the specifications of the flash’s synchro terminal.

(2) Some flashes available on the market have the polarity of the synchro
terminal reversed. In this case, even if the flash is connected, it will not fire.
Contact the manufacturer of the flash for more information.

(3) Exposures when using an external flash require that adjustments be made
on the external flash unit. If an external flash is used in the auto mode,
match it with the F value and ISO settings on the camera.

(4) Even if the auto F value and ISO of the external flash are set to the same
conditions as those on the camera, depending on the photographic
conditions, it is possible that the correct exposure may not be obtained
anyway. In such a case, adjust the auto F value or ISO value on the external
flash unit or calculate the distance in the manual mode and use it that way.

(5) Use a flash whose illuminating angle covers the angle of view of the lens.
However, in close-up photography with the lens on the wide setting, the
bottom of the image may not expose correctly. The ideal is to have a wide
angle adapter to fit on the flash and spread the illumination angle so it is
wider.

(6) Use a flash unit with a flash time of 1/200 sec. or less when using the flash

at full strength.

For devices with a long flash time, a portion of the light emitted will not

contribute to the exposure.

If a flash unit or other accessory TTL flash that has additional

communications functions other than an Olympus FL series flash is

used, it may not only fail to function normally, but may also cause
damage to the camera’s circuitry. Do not use such a device.

7

~
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External flash (optional)

Using the slave flash mode

This setting is for when using a commercially available slave flash that is
synchronized with the camera flash.

The amount of light emitted by the flash can be adjusted in 10 levels. The flash
can fire in sequential shooting mode, but the interval between shots will be
longer if a high emission level is set.

AUTO, ®® : The setting is automatically changed to % (Fil--in flash).
@ 4SLOW : The setting is automatically changed to % SLOW1.

Mode dial A M

1 Press ® while holding down §.

&
N\
¥ Flash mode
button

A Arowen
&) Arrow pa
@ ﬁ OK button
2 Select>" FLASH - SLAVE, and press 9.

[ “Menu basics” (P.38) (FLASHINOGE)

. B
CarasidC )
% SLOW

(sLave))
SELECT#EE) GO #(OK]

3 Press ®& to select an emission level from

| SLAVE FLASH |
1 to 10, then press ®. LA

.

v

SELECTE] GO #(OK]

4 Press @) repeatedly until the menu disappears.
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5 Advanced shooting

Aperture priority shooting A
et

1 Turn the control dial to set the aperture Control dial
value.

Turn to the left to Turn to the right to
decrease the \W/ increase the
aperture value aperture value

(F number). (F number).

* You can change the adjustment range for the
aperture. I¥"“EV STEP — Setting exposure
adjustment increments” (P.153)

« If the aperture value is displayed in red, the setting is unsuitable for the
conditions. Take the following steps. (If the shutter speed is displayed in
green, the setting is suitable for the conditions.)

Aperture value

g0l I
HQ 32662048 " 30 HQ 3264x2448

a appears: The image is overexposed. ~ appears: The image is underexposed.
Turn the control dial to the right to Turn the control dial to the left to
increase the aperture value. reduce the aperture value.

Aperture range: Toward W: f2.4 to f8.0, Toward T: f3.5 to 8.0

* When the flash is set to the auto-flash mode or the fill-in flash mode, the
N shutter speed is fixed at 1/30 sec. in the maximum wide angle, or 1/125 sec.
Note in the maximum telephoto angle, and will not go slower.
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Shutter priority shooting

[ 5> s o7

1 Turn the control dial to set the shutter Control dial
speed.
Turn to the left to Turn to the right to
set a slower W set a faster

shutter speed. shutter speed.

* You can change the adjustment range for the
shutter speed. 15" “EV STEP — Setting exposure
adjustment increments” (P.153)

« If the shutter speed is displayed in red, the setting is unsuitable for the
conditions. Take the following steps. (If the shutter speed is displayed in
green, the setting is suitable for the conditions.)

— Shutter speed
—— /. .

HQ 3264x24

a appears: The image is overexposed. ~ appears: The image is underexposed.
Turn the control dial to the right to set  Turn the control dial to the left to set the
the shutter speed faster. shutter speed slower.

Shutter speed range : 15" to 1/4000

TIPS === === ssecsecceesses s mmmesnnsnnnnnn
2" Shutter speed indication
The actual shutter speed differs from the shutter speed displayed on the
monitor. The actual shutter speed range of the camera is 16 to 1/4000 sec.,
but the speed is displayed in the range of 15" to 1/4000 on the monitor.

/'\ » To avoid camera movement, you are recommended to use a tripod when

N-t taking pictures requiring a slow shutter speed.
ote
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Manual shooting

Mode dial M @Y? Control dial

1 Set the aperture by turning the control dial Exposure compensation
R . button
while holding down [i4. . 7
* You can change the adjustment range for the
aperture and the shutter speed. I=5°“EV STEP —
Setting exposure adjustment increments” (P.153)

Turn to the left to Turn to the right to

decrease the aperture + W increase the aperture
O N~ value (F number).

value (F number).

INFO
Turn the control dial to set the shutter speed.
Turn to the left to set a W Turn to the right to set
slower shutter speed. AN J a faster shutter speed.
* When the shutter button is halfway pressed, the Exposure differential

difference (ranging from —3.0 to +3.0 EV) between
the two exposures is displayed. One is the
exposure determined by the currently selected
aperture and shutter speed, and the other is the
exposure level considered optimal by the camera.
If the exposure differential appears in red in the
viewfinder or on the monitor, it indicates that the
exposure differential is less than —3.0 EV or more
than +3.0 EV.

When you press the AEL (AE Lock) button, the
screen on the right appears with the bar indicating
the current exposure differential.

Aperture value : f2.4 to f8.0
Shutter speed : 15" to 1/4000

@ TIPS == ====sscscceeccs e s s nnnnns
%" To take long exposure (bulb) shots
1 Turn the control dial to the left to set the shutter speed to BULB.
2 The shutter remains open as long as the shutter button is held down.
» The maximum bulb length is 8 minutes.
+ Using the remote control prevents camera from shaking due to
pressing the shutter by finger.
* You can connect a remote cable (sold separately) with the power
battery holder (also sold separately).

» To avoid camera movement, you are recommended to use a tripod when
0 taking pictures requiring a slow shutter speed.
Note
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Using My Mode

When you use @ mode, the settings you selected with the menus in My Mode
are activated.

Saving the shooting mode or function settings you want to use in advance lets
you shoot with your favorite settings straightaway. By setting the mode dial to

@7, you can select whether to use one of the 8 customized My Mode settings

that you have saved.

Mode dial ) m

1 In the top menu, select MODE MENU >
CAMERA > MY MODE > MY MODE 1 to
MY MODE 8, and press ®).

I “Menu basics” (P.38)

* Press (@ again to exit the menu.

* Only the settings in MY MODE 1 have already
been saved. You cannot select MY MODE 2 to MY
MODE 8 if no settings have been saved in them.
I “MY MODE SETUP — Setting a function in My
Mode” (P.160)

o Arrow pad

oK
” OK button

EH MY MODE1

CANCEL® (+] SELECT#&] GO# [OK]
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Focusing applications

AF MODE - Changing the focus range

This function allows you to select the focus range of your subject.

iESP Even when the subject is not in the center of the screen, focusing is
possible. The AF target mark moves to the focus position.
SPOT Focus selection is based on the subject within the AF target mark.

p Als M EP ®lAs Y

1 Press @ while holding down AF/¥/MF. AFIYIMF
AF/Macro/MF button

* In MF or $&%MF mode, the menu is not displayed
when ®) is pressed.

—_—
o T rrow pa
¢OK button
2 Press ®& to select AF MODE, then

9 [ Focus oo |

press ©- T ()

3 Press ®& to select iESP or SPOT, then ()
press &. | P-AF )

* Press ® again to exit the menu.
®ag SELECT # 6} GO #[OK]

* If you select SPOT for the AF MODE, P-AF is automatically set to OFF.
I “P-AF — Changing the auto focus mode” (P.76)
Note . | @ mode, the AF MODE is fixed to iESP. The setting cannot be changed.

4
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Focusing applications

FULLTIME AF - A reliable time-saving way to focus

Focusing is performed repeatedly without having to press the shutter button
halfway. When ON is selected, the focusing time is reduced, letting you take

successive snapshots.

PIA s M EDXRE AN

1 Press @ while holding down AF/&/MF. AF/YIMF
* In MF or $&%MF mode, the menu is not displayed
when ®) is pressed.

Arrow pad

OK button
2 Press &®& to select FULLTIME AF, then
press {. k. wooe]
3 Press ®& to select ON or OFF, then (FuLLTme ADMC_ )
press ®. [ P-AF
* Press (@ again to exit the menu.

SELECT# €] GO » [OK]

@ * In & mode, FULLTIME AF does not operate when & (movie) is set to ON.

+ Battery consumption increases when FULLTIME AF is used.
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Focusing applications

P-AF — Changing the auto focus mode

For auto focusing, this camera is equipped with a AF sensor
contrast detection system measured by CCD and a
phase difference detection system measured by AF
sensor. You can select whether to use only the
contrast detection system or to use the contrast
detection system in conjunction with the phase
difference detection system.

OFF The camera focuses on the subject using
only the contrast detection system.

ON The camera focuses on the subject using both the contrast detection
system and the phase difference detection system. Focusing is
performed faster than when OFF is selected.

EXDEAREC LI

1 Press @ while holding down AF/&/MF. AF/YIMF
- In MF or SMF mode, the menu is not displayed ~ AF/Macro/MF bution
when ®) is pressed.

Bunooys pasueApy !

Arrow pad

OK button
2 Press ®& to select P-AF, then press P).
9 [ FOCUS MODE |
3 Press ®& to select ON or OFF, then (AF MODE |
press ®. ( )
* Press (& again to exit the menu. ‘

SELECT # ( GO # (OK]

* When the subject is within 80 cm (2.6 ft.) of the camera, the camera focuses
using only the contrast detection system.

* Focusing may take some time if P-AF is set to ON when a conversion lens
or underwater housing is attached to the camera.

+ In & mode, P-AF is fixed to OFF. The setting cannot be changed.

Note
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Focusing applications

Changing the position of the AF target mark

This function lets you select the area you want to focus on by changing the
position of the AF target mark.

P Als M mPE AN

1 Set the AF mode to SPOT. AF/W/MF AF/Macro/MF
[I=¥”“AF MODE - Changing the focus range” (P.74)

Cad
M —Arrow pad

% OK button

2 Hold down AF/&/MF and use the arrow pad
to move the AF target mark to the area you
want to focus on.

* In MF or %MF mode, the AF target mark does not
move when the arrow pad is pressed.

3 Take the picture.

» Torestore the AF target mark to its original position (in AF target mark
the center), press &) while holding down AF/$/MF
on the right screen.

@ » Turning the camera off or changing the shooting mode will return the AF
target to the center position.

Note . The AF target mark cannot be moved when the digital zoom is on.
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Focusing applications

AF illuminator

The AF illuminator allows the auto focus to focus on dark subjects. When the
shutter button is pressed halfway, the AF illuminator fires automatically, lighting
up the subject. Factory default setting is ON. To turn the AF illuminator off, follow
the procedure below.

Mode dial SET UP

1 Select SETUP > AF ILLUMINATOR -> OFF,
and press ®.
[ “Menu basics” (P.38)

Arrow pad
OK button

AF illuminator

@ « Even when the AF illuminator is lit, the auto focus may still not be able to

N focus properly on subjects within 80 cm (2.6 ft.) of the camera.
ote
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Focusing applications

Manual focus

If auto focus is unable to focus on a subject, use manual focus.

[ s (o[ W e AR A

1 Turn the control dial while holding down AF[WIMF AF/Macro/MF
AF/&/MF and select MF.

» When you release your finger from the AF/$/MF
button, the distance indicator is displayed on the
monitor.

2 Press ®& to set the focus.

* During operation, the area in the middle is

enlarged. This lets you check whether the focus is
correct.
The distance indicator on the left of the monitor is .
for reference only. e
When the indicator is moved to less than 0.8 m (2.6
ft.), the display automatically switches to the 20 cm (8") to 80 cm (2.6 ft.)
display.

3 Take the picture.
» The focus is locked at the distance you have set.
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Focusing applications

C TIPS === === sssecsecceessess s ssemmmesnnsnnnnnn
How to shoot while keeping the same focus distance
— Decide the focus in Step 2, then press ). The focus is locked and MF
appears in red on the monitor.

To fix the focus at the same distance as the focus lock position

1 Position the AF target mark on a subject at the desired distance and
press the shutter button halfway.

2 Keeping the shutter button half-pressed, press AF/#/MF.
» The distance indicator is displayed.
* MF is selected and the focus is locked at the same distance as when

you performed focus lock.

» Set to AF to return to auto focus.

Even if you move the cursor to the top of the distance indicator, focusing
is not possible at co.
— Adjust the cursor position by pressing & &.

How to take pictures very close to the subject

— In super macro MF mode, pictures as close as 5cm from the subject can be
taken with manual focus. Turn the control dial while holding down AF/¥/MF
and select MF. I=5"“Super macro shooting” (P.88)

@ * When the digital zoom is set to x2.5 or more, the area you are focusing on
is not enlarged.
* Ifthe zoom lever is pressed after performing manual focus, the saved focus
distance may be changed. Perform setting again.

Note
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Metering ©

There are four ways of measuring the brightness of a subject. Select the way
best suited to your purpose.

Digital ESP metering Meters the center of the subject and the surrounding
area separately.

Spot metering ((¢]) Exposure is determined by metering within the
metering target area. In this mode, a subject can be
shot with optimal exposure regardless of the
background light. I=5° P.81

Multi-metering ((£JMULTI)

Meters the brightness of the subject at up to 8 different
points to set the optimal exposure based on the
average brightness. This method is useful with a high
contrast subject. =5~ P.83

Center-weighted metering (([[e3)

Meters the brightness over a wide area with emphasis
on the center of the screen. This method is used when
you do not want to let the brightness of the surrounding
area affect the picture. I=5° P.81

Spot metering / Center-weighted metering — Selecting the metering area

P Als M EP D E M0

1 Turnthe control dial while holding down @) Control dial
and select (o] or (). @) Metering button

81|

Bujooys pasueapy H



Bunooys pasueApy !

Metering

Changing the position of the metering target mark

When the metering mode is set to SPOT, you can select the metering area by
moving the position of the target mark.

p Als M ®lAs N

1 Turnthe control dial while holding down @) Control dial
to select E (@) Metering button

Arrow pad

€ OK button

N

Hold down ({®) and use the arrow pad to
move the metering target mark to the area
you want to meter.

Metering target mark

3 Take the picture.
* To restore the metering target mark to its original

position (in the center), press & while holding
down (@Y in Step 2.

@ » Turning the camera off or changing the shooting mode will return the

metering target to the center position.
Note
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Metering

Multi-metering
— Metering the exposure at more than one point = MULTI

o[4S DA

1 Turnthe control dial while holding down @) Control dial
and select (¢JMULTI. @) Metering button

2 Position the AF target mark on the area you
want to meter and press the AEL (AE Lock)
button. The brightness is metered at up to
8 different points.

* The multi-metering bar appears.

+ Additional metering is ignored after the 8th
reading.

» To perform metering again, press the AEL button
for more than 1 second to display (WEmo). Press the
AEL button again to cancel the metering values.
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|
Metering

Ex: When metering 2 points (pressing the AEL button twice)

The aperture and shutter speed as calculated from the average values obtained by
metering at 2 points. These values are recalculated every time another metering point
is added.

Indicates how much the
present exposure you are
metering differs from the
average exposure value.
The present exposure can
be fixed by pressing the
shutter button halfway.
(The present exposure is
not added to the average
value unless you press the
AEL button.)

The average for the 2
metering points.

The average is always
shown at the center of the
bar.

The reading when the AEL button was
pressed. < indicates the number of times
you have pressed the button. < indicates
the difference between the metered and
average readings.

When <> moves more than +3 from the center of the bar (the average reading), red

< D> appear.

TIPS == === s e e s mmmns
<?> To save the locked multi-metering exposure after shooting (AE memory)
— After metering in Step 2, hold down the AEL button for more than 1 second.
appears. While is displayed, the exposure is saved. Press the
AEL button again to cancel the AE memory.

The multi-metering exposure is canceled.

— If you operate any of the buttons or the mode dial after metering in Step 2,
the multi-metering exposure is canceled.
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AE Lock - Locking the exposure AEL

This function is suitable for situations when optimal exposure is difficult to
achieve, such as when there is excessive contrast between the subject and the
surroundings.

For example, when the sky takes up much of the frame, shooting with automatic
exposure sometimes results in a dark subject. Recompose your shot so that not
much sky is in the frame, and then press the AEL button to lock the metered
value (exposure) temporarily. Next, compose your shot again with the sky in the
frame and take the picture.

bt~ b

as AN

1 Compose the picture where you want to AEL button
lock the metered value (exposure), then
press the AEL button.

* The metered value is saved.

« If you want to lock a different exposure, press the
AEL button again to cancel AE lock. Each time
you press the AEL button, AE lock is engaged and
canceled repeatedly.

P 1/200 F5.6 0.0
EED

e < AR

o]
(1@ 8264%2448 30 I

2 Position the AF target mark on the subject During AE lock, AEL
you want to focus on and press the shutter d'slp'aye"'
button halfway. P[1/200 F5.6 0.0

© (ED

[]

[0 8264%2448 30

» The green lamp lights.

3 Press the shutter button fully.
» AE lock is automatically canceled after one shot.
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AE Lock - Locking the exposure

TIPS === === ceecmec s s s s s m e
<?> To save the locked multi-metering exposure after shooting (AE memory)
— After setting AE lock in Step 1, or after pressing the shutter button halfway
in Step 2, hold down the AEL button for more than 1 second. appears.
While is displayed, the exposure is saved. Press the AEL button again

to cancel the AE memory.

AE lock was canceled.

— Do not operate any of the buttons or the mode dial after performing AE lock.
Doing so will cancel AE lock.

— The camera had emerged from sleep mode or the power was turned off.

+ AE lock is not available when multi-metering is enabled. Set the metering
method to ESP, (&) or @)). 1= “Metering” (P.81)
Note . AE lock is not available when a menu is displayed on the screen.
I “Menu basics” (P.38)
» AE lock is not available when the control panel is displayed on the screen.
[5” “CONTROL PANEL - Using the monitor as a control panel” (P.163)
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Macro mode shooting ©

Focusing is usually slow when you get close to a subject (20 cm to 80 cm (0.7
ft. to 2.6 ft.)). However, in the $ mode focusing is performed quickly.

% W o

Normal shooting Macro shooting

N

Mode dial J/ P A S M mP X ) AR )
1 Turn the control dial while holding down Control dial
AF/&/MF and select . AF/\IMF

AF/Macro/MF button

@ * If you use the flash in macro shooting, shadows may be noticeable and the

correct exposure may not be achieved.
Note
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Super macro shooting

In super macro mode, pictures can be taken as close as 5cm (2.0") from the
subject. Subjects measuring up to approximately 4.8 cm x 3.6 cm (1.9" x 1.4")
can be captured on the monitor.

In the % mode, normal shooting is also possible, but the zoom cannot be used.

PIA s M EDXE Al

1 Turn the control dial while holding down Control dial

AF/%/MF and select 4. ﬁgﬁa’x;w button

@ Super macro MF

When taking pictures close to the subject, shadows may become noticeable,
and the auto focus may not be able to maintain correct focus. Set the camera to
super macro MF and use manual focus.

1 Turn the control dial while holding down AF/&/MF and select
SUMF.

2 When you release your finger from the AF/¥/MF button, the
distance indicator is displayed on the monitor.
» During operation, the area in the middle is enlarged. This lets you check
whether the focus is correct.

3 Press @& to adjust the focus.
* Pressing & locks the focus position and M, appears in red on the monitor.

A' + During super macro shooting, the built-in flash is not available. You can use
&~ anexternal flash, but vignetting may occur. Display the recorded image on
Note  the monitor to check it.
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Self-timer shooting

This function lets you take pictures using the self-timer. Fix the camera securely
on a tripod for self-timer shooting. This function is useful for taking pictures

where you want to be included in the photograph.

P A|s| M EDRE A )

1 Turn the control dial while holding down
®/¢ and select &).

2 Press the shutter button fully to start self-
timer shooting.

Pressing the shutter button halfway locks the

focus and exposure.

The self-timer/remote control lamp lights for

approximately 10 seconds, then starts blinking.

After blinking for approximately 2 seconds, the

picture is taken.

To stop shooting while in & mode, press the

shutter button fully again.

To cancel the self-timer, press &)/§.

O/4 Self-timer/ Control dial
Remote control button

Self-timer/
Remote control lamp

The self-timer mode is automatically canceled after one shot.

D If self-timer shooting is attempted in sequential shooting mode, the camera
S shoots 5 frames at most, regardless of the setting.

Note

89|

Bujooys pasueapy H



Bujooys pasueapy !

Remote control shooting

Shooting is possible using the remote control device provided with the camera.
This is useful when you want to take a picture of yourself in it, or a night scene,
without touching the camera.

P A|s| M EDRE A )

1 Mount the camera on a tripod or place it on a stable, flat surface.

2 Turn the control dial while holding down O/ Selftimer  Control dial
k\:)/ﬁ and select 6 Remote control button

ori -
&n
(&)

3 Point the remote control device at the
remote control receiver on the camera.

5m(16.4ft) /-~ (({Aa
NPT
15

4 Press the shutter button on the remote control device.
» The focus and exposure are locked and the self-timer/remote control lamp
blinks before taking the picture.
* You can set the time until the picture is taken. I=5” “Changing the time until
remote control is activated” (P.91)
» To shoot in bulb mode, press and hold down the shutter button on the remote
control device. I “Manual shooting” (P.72)

Sm
~(?-8f1) .

Self-timer/
Remote control lamp

Remote control
receiver
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Remote control shooting

TIPS == ====sscscececscs e s s nnnnns
@ The self-timer/remote control lamp does not blink after pressing the

shutter button on the remote control device.

— The remote control device may be too far from the camera. Move closer to
the camera and press the shutter button on the remote control device again.

— The battery in the remote control device is running low. Replace with a new
battery. B=¥3"“How to replace the battery (CR2025) of the remote control
device” (P.220)

How to cancel the remote control mode.
— The remote control mode is not canceled automatically after shooting.
Perform Step 2 and set the mode to OFF.

« If the remote control receiver is exposed to strong light, the effective signal

@ distance may be reduced or shooting may not take place.

» To shoot sequential shots using the remote control device, press and hold
the shutter button on the remote control device. If the camera does not
receive the remote control signal properly, sequential shooting may stop.

Note

Changing the time until remote control is activated

You can select the time from when the shutter button on the remote control
device is pressed until the picture is taken.

AUTO The picture is taken immediately the shutter button on the remote
control device is pressed.
3 SEC The picture is taken approximately 3 seconds after the shutter

button on the remote control device is pressed.

1 Press while holding down Q')/ﬁ O/ § Self-timer/Remote control
- In &) mode, the menu is not displayed when ® is P10 '

pressed.

Arrow pad

€ OK button

2 Press ®& to select AUTO or 3 SEC, then
press ®.

8|

| SELECTHE] GO#
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Sequential shooting

There are 4 sequential shooting modes: high speed sequential shooting,
sequential shooting, AF sequential shooting and auto bracketing. Except for
auto bracketing, the exposure and white balance are locked at the first frame.
Sequential shooting cannot be performed when the record mode is set to TIFF.

Sequential shooting mode

(] Shoots one frame at a time when the shutter button is
pressed. (Normal shooting mode, single-frame shooting)
HIE Pictures can be taken at a faster speed than normal

sequential shooting.

Approx. 5 frames at 1.6 frames/sec.

The focus is locked at the first frame. The sequential

shooting speed varies depending on the record mode

setting.

Approx. 17 frames (in HQ mode) can be taken in sequence.

AF Dy Adjusts the focus 1 frame at a time. The AF sequential
shooting speed is slower than normal sequential shooting.

BKT =" “Auto bracketing” (P.93)

iU

High speed, sequential and AF sequential shooting
HI&Z & AFL

EXDIROO0

1 In the top menu, select MODE MENU >
CAMERA - Ty > HI1 3y, 3y or AF y, and
press ®.

I “Menu basics” (P.38)

« If &gy is displayed on the top menu as a shortcut
menu, press the arrow pad in the same direction
as the arrow shown next to &y.

I “SHORT CUT” (P.157)

Arrow pad

OK button
* Press @ again to exit the menu.

2 Take the picture.
» The camera will take pictures in sequence until
you stop holding down the button.
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Sequential shooting

Auto bracketing BKT

Under some conditions, you may obtain better results shooting with exposure
compensation than by using the exposure setting considered optimal by the
camera.

When auto bracketing is set, the exposure is changed automatically for each
frame while the shutter button is pressed. The exposure differential and number
of frames can be selected in the menus. The focus and white balance are locked
at the first frame.

Ex : When BKT is set to +1.0 x3

-1.0 0.0 +1.0

o[als A

1 In the top menu, select MODE MENU >
CAMERA - Oy > BKT, and press ).
I=° “Menu basics” (P.38)

Bunooys pasueApy H

Arrow pad
OK button

2 Select the exposure. Press & to select
0.3, 20.7 or £1.0, then press .
* When the exposure adjustment is set to 1/2 EV
steps, select from 0.5, £1.0 and £1.5.
I “EV STEP - Setting exposure adjustment

increments” (P.153)
3 Select the number of pictures. Press &®&
to select x3 or x5, then press ®.
» In some combinations of picture size and record mode, only x3 is available.
* Press @ repeatedly until the menu disappears.

4 Take the picture.
» Press the shutter button fully and keep it pressed to shoot the preset number
of pictures. You can stop shooting at any time to stop holding down the shutter

button.
93 I
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Sequential shooting

Note

|94

Sequential shooting (HIZy, &y, AF 2y, BKT) is not possible in the
following situations:

* When the record mode is set to TIFF

* When NOISE REDUCTION is set to ON
3y and AF =) are not available when the record mode is set to RAW.
In sequential shooting mode (HI1 =, =y, AF &, BKT), the built-in flash
does not fire. The external flash does not fire in BKT mode.
Auto bracket shooting is not available in M mode.
Since the shutter speed is set to 1/30 sec. max. exceptin S and M mode,
exposure is decreased when shooting a dark subject to prevent camera
movement.
For auto bracketing in modes other than S mode, shooting is automatically
setto 1/30 sec. if the shutter speed was other than 1/30 sec. for an exposure
differential of 0.
If the battery power is low and the battery check blinks during sequential
shooting, shooting stops and the camera starts saving the pictures you have
taken. Whether or not all of the shots are saved depends on how much
battery power remains.
In Auto bracket shooting, if available space on the card does not exceed the
number of set pictures, the next picture may not be taken.



Panorama shooting

You can take advantage of PANORAMA shooting with the Olympus xD-Picture
Card. PANORAMA shooting lets you connect pictures with overlapping edges
into a single panoramic picture, using the CAMEDIA Master software.

p N ERXG )

1 In the top menu, select MODE MENU >
CAMERA - FUNCTION > PANORAMA, and

press ®.
[ “Menu basics” (P.38)

* The PANORAMA mode is set.

2 Use the arrow pad to choose the direction
in which you want the pictures connected.
® : Connects the pictures from left to right.

@ : Connects the pictures from right to left.
<&@ : Connects the pictures from bottom to top.
& : Connects the pictures from top to bottom.

_> —»_
Connecting pictures from left to Connecting pictures from
right bottom to top

3 Take pictures so that the edges overlap.
» Focus, exposure and white balance are set by the first picture. Do not select
an extremely bright subject (such as the sun) for the first picture.
You cannot adjust the zoom after the first picture.
Panorama shooting is possible for up to 10 pictures.

Keeping the area in the frame at the edge of the screen in mind, position
the camera so that the same area appears in the frame for the next
picture. Compose the picture so that the section that appeared at the
right edge of the previous picture (or the left edge if you are connecting
pictures from right to left) appears at the left edge of the next picture (or
the right edge if you are connecting pictures from right to left).
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Panorama shooting

* When you have taken 10 pictures, a warning mark
appears.

4 Press @ to exit PANORAMA shooting.
» The frame on the screen disappears and the camera returns to the normal
shooting mode.

The PANORAMA mode is only available with Olympus CAMEDIA-brand
cards.

Note During PANORAMA shooting, the flash, sequential shooting (HI1 =, =y,
AF 3y, BKT) and program shift modes are not available.

Images are saved in JPEG format when PANORAMA shooting is performed
in the TIFF mode. The size of the image does not change.

PANORAMA shooting is not available when the record mode is set to RAW.
If the mode dial is operated during PANORAMA shooting, the camera
cancels the PANORAMA mode and returns to normal shooting.

The camera itself cannot connect panorama pictures. The CAMEDIA
Master software is necessary to connect the pictures.
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Guideline shooting

This function displays a silhouette of guideline on the monitor to help you
compose your pictures. Select the type of guideline best suited to your purpose.

[y v 4] [ DAY

1 In the top menu, select MODE MENU >
CAMERA > FUNCTION - B3, and press ®.
I=° “Menu basics” (P.38)

Cad
oK Arrow pad
@ OK button

&

2 Press ®& to select the guidelines, then take the picture.

i

SELECT‘@_ CANCEL» SELECT# ] CANCEL»

Horizontal position Vertical position

3 Press ® to exit guideline shooting.
» The guidelines on the screen disappear and the camera returns to the normal
shooting mode.

TIPS === === c e
<‘> * You can display the guidelines in the playback mode too.
=¥ “Displaying guidelines” (P.136)

/| » The guidelines do not appear on the resulting picture.

Note
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Shooting in black & white or sepia-tone

This setting lets you add special effects to pictures.

o a5 W BEARD

1 In the top menu, select MODE MENU >
CAMERA - FUNCTION > BLACK & WHITE
or SEPIA, and press ®.

I “Menu basics” (P.38)

* Press & again to exit the menu.

Arrow pad

@ OK button

(FONCTION){ (ickane)

» White balance, white balance compensation, hue and saturation cannot be
used in black & white or sepia shooting.

A\

P4
o (s
=
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FRAME ASSIST - Displaying vertical and

horizontal lines to aid composition

This setting displays a vertical and horizontal lines on the monitor to help you
compose your pictures.

PIA s M EDXRE Al

1 In the top menu, select MODE MENU >
CAMERA -> FRAME ASSIST > ON or OFF,
and press ®.

I “Menu basics” (P.38)

* Press & again to exit the menu. The vertical and
horizontal lines are displayed on the monitor.

Arrow pad

OK button

/' » The frame is not displayed in the following cases.

Nt During panorama or guideline shooting
ote
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Recording sound with still pictures

This function lets you record sound when taking a still picture. Recording starts
about 0.5 seconds after the shutter is released and lasts about 4 seconds.
When this function is enabled, sound is recorded automatically every time you
take a picture.

[Mode dia )P A |'s | M m?/ =) 8 (Y

1 In the top menu, select MODE MENU >
CAMERA -  (for still pictures) > ON, and
press ®.

I “Menu basics” (P.38)

* Press (@ again to exit the menu.

@y Ao

oK oW pa

=

OK button

2 When recording starts, turn the camera Shutter button  Microphone
microphone towards the source of the -
sound you want to record.
» The BUSY bar is displayed during recording.

GUTIPS = mmmsssss e e

N . [J] appears on the monitor during playback of still pictures and movies with

sound. During playback, sound is output from the speaker. The volume can
be adjusted. 15" “VOLUME — Adjusting the playback volume” (P.165)
Sound can be added later to still pictures. Recorded sound can also be
changed. I=5” “Recording sound” (P.137)

Note

|100

If the camera is more than 1 m (3.3 ft.) away from the source of the sound,
sound may not be recorded clearly.

* Itis not possible to take another picture during sound recording.

Sound recording is not possible in the following cases:
When the record mode is set to TIFF, during sequential shooting
(HIZy, &y, AFy, BKT) or panorama shooting
Sound recording may also pick up camera noises, such as button
operations, shutter movement, etc.
Sound recording may not be possible if there is insufficient space in the card
memory.



Recording sound with movies

Sound can be recorded while shooting a movie.

[

1 Inthe top menu, press & to select
¥ (movie).

Arrow pad

@ OK button

2 Press ®& to select ON, then press ®).

3 Recording starts at the same time as | s GOWOK)|
shooting.

» When @ is set to ON, the focus and optical zoom are locked during movie
O recording. If § is set to OFF, you can use both the optical zoom and digital
Note  700m during movie recording.
* If the camera is more than 1 m (3.3 ft.) away from the source of the sound,
sound may not be recorded clearly.
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6 Adjusting the image quality and exposure
Record mode

You can select a record mode in which to take pictures or shoot movies. Choose
the best record mode for your purpose (printing, editing on a PC, website
editing, etc.). For resolutions and file sizes in the different record modes, refer
to the table on P.104.

Normal image mode

Image becomes clearer

<
Apolication Compression Un- Low High
pplica Resolution compressed|compression|compression
3264 x 2448 SHQ HQ
§A 2592 x 1944
o SQ1 SQ1
g Select for the print 2268 X 1712 HIGH NORMAL
= : 2048 x 1536
0 size
2 1600 x 1200 TIFF
oy 1280 x 960
° SQ2 SQ2
E 1024 x 768 HIGH NORMAL
£ For small sized prints
3 and website 640 x 480

@Resolution

The number of pixels (horizontal x vertical) used when saving an image. If the
image will be printed, higher resolutions (larger numbers) are recommended so
that the image will be clearer. However, higher resolutions make the file size
(amount of data) larger, so the number of pictures that can be saved will be
fewer.

@ Compression

In record modes other than TIFF, image data are compressed. The higher the
compression, the less clear the image will be.

@ Resolution and picture size on a computer screen

When a picture is transferred to a computer, the size of the picture on the
computer screen varies depending on the computer’s monitor setting. For
instance, a picture taken in 1024 x 768 resolution is the same size as the screen
if you set the picture to 1x when the monitor setting is 1024 x 768. However, if
the monitor setting is over 1024 x 768 (such as 1280 x 1024), the picture only
takes up part of the screen.
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Record mode
Special image mode
Record mode Features Resolution

As the name suggests, the data is

RAW “raw”, not having been subjected to 3264 x 2448
image processing.

3:2 This mode is useful when having

(TIFF, SHQ, HQ) |prints made at a photo lab. 3264 x 2176

RAW Data

As its name suggests, RAW data is unprocessed image data in its original state
to which white balance, sharpness, contrast, color conversion and other
processes have not been applied on your PC. CAMEDIA Master software is
required to display RAW data on your PC as images. Plug-in software for
playback by Photoshop can also be used. (Available for download from the
Olympus home page.) You cannot display RAW data using ordinary software or
make print reservations.

Pictures taken in the RAW data format can be edited on this camera.

I “RAW editing” (P.140)

3:2 Resolution

The image aspect ratio is normally 4:3. If the aspect
ratio is changed to , the image can be prlnted ata ﬂ"ﬂ
photo lab without Iosmg the image borders. isnot |
available in & mode.

Check the shooting range on the monitor before taking
the picture.

Monitor indications when
is set
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Record mode

@Record modes and the number of storable still pictures

The number of storable still pictures can be estimated
by dividing the capacity of the card by the file size.
When a card is inserted in the camera, it is displayed
in the viewfinder or on the monitor.

The file size and the remaining recording time in the
following table are the estimated numerical value.

e el

|
Number of storable still pictures

Still Picture Record Modes

File size (MB)
Record mode Resolution Compression File format With sound Without
sound
RAW 3264 x 2448 |Uncompressed ORF 11.5 1.4
3264 x 2448 22.9 22.9
3264 x 2176 20.3 20.3
2592 x 1944 14.4 14.4
2288 x 1712 11.2 11.2
TIFF 2048 x 1536 |Uncompressed TIFF 9.0 9.0
1600 x 1200 5.5 5.5
1280 x 960 3.5 3.5
1024 x 768 2.3 2.3
640 x 480 0.9 0.9
sHa 3264 x 2448 Low 3.9 3.8
3264 x 2176 |compression 3.4 34
HQ 3264 x 2448 High 2.0 1.7
3264 x 2176 |compression 1.7 1.2
HIGH 3.6 3.6
2502 x 1944 NORMAL 1.2 1.2
sQ1 2288 x 1712 HIGH 28 28
NORMAL 1.0 0.9
2048 x 1536 HIGH JPEG 23 22
NORMAL 0.8 0.8
1600 x 1200 HIGH * 1.4 1.4
NORMAL 0.5 0.5
HIGH 0.9 0.9
saz 1280 X960 I oRMAL 03 03
1024 x 768 HIGH 0.6 0.6
NORMAL 0.2 0.2
HIGH 0.3 0.2
640 x 480 NORMAL 0.1 0.1
*HIGH uses low compression/NORMAL uses high compression
Movie Record Modes
Remaining recording time (sec.)
Record mode Resolution 32MB
With sound Without sound
SHQ 640 x 480 (15 frames/sec.) 34 35
HQ 320 x 240 (15 frames/sec.) 93 96
sQ 160 x 120 (15 frames/sec.) 374 424
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Record mode

. * The number of storable still pictures that can be taken may change according to
: the subject or factors such as whether print reservations have been made or not.
Note In certain instances, the number of remaining pictures displayed on the monitor
does not change even when you take pictures or stored images are erased.
* In some cases, the larger the capacity of the card, the greater the difference
between the calculated number of pictures and the actual number of pictures.
* If movies are shot with VIDEO OUT set to PAL and the AV cable connected, the
movie recording time will differ from the time listed in the Movie Record Modes table.

Selecting a record mode

P AS Mm X MR N

1 Turn the control dial while holding down €-Recorg  Control dial
<€:- to select the record mode.

» The record mode changes in the sequence shown
below.

mode button

Still Picture Record Modes

RAW TIFF SHQ
SQ2 SQ1 HQ

oD
o Arrow pad
@ OK button

Movie Record Modes
SHQ HQ SQ

(i )

2 Ifyou selected a still picture record mode,
press & while holding down <€:- to display
the screen for selecting the resolution.

3 Ifyou selected TIFF, SHQ or HQ, press &® &
to select a resolution, then press ®.
If you selected SQ1 or SQ2, press & & to
select a resolution, then press @ Press

SELECT#(] GO »[OK]
When HQ is selected

& to select HIGH or NORMAL, then (2592x1944 |1 HIGH |
press ®.  NORMAL |

SELECT#E] SET#[] GO#(OK]

When SQ1 is selected
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Record mode

@ JPEG duplicate setting

Pictures taken in the RAW data format can be stored in JPEG format at the
same time as they are recorded in RAW data. To record pictures in JPEG format
you can select SHQ, HQ, SQ1 or SQ2 for the record mode, but you cannot
select a resolution. Pictures are recorded in the resolution currently set for each
record mode.

1 Turn the control dial while holding down R Control dial
:- Record
<€:- to select RAW.

mode button

or Arrow pad
@ OK button

&

3 Press @& to select OFF, SHQ, HQ, SQ1 or
SQ2, then press ®.

SELECT# 5] GO #(OK]
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ISO — Set-up appropriate sensitivity

The higher the ISO settings, the greater the camera’s light sensitivity and the
better its ability to shoot in low light conditions. However, higher values also
introduce noise into the resulting image, which may give them a grainy
appearance.

AUTO Sensitivity is automatically adjusted according to the light conditions
and the subject brightness.

50 to 400 With a lower ISO setting, you can shoot clear, sharp images in
daylight. With a higher ISO setting, you can use faster shutter
speeds with the same amount of light. The available ISO settings
vary depending on the EV step setting. 15" “EV STEP — Setting
exposure adjustment increments” (P.153)

[Mode dia )P [A]'s | Mm?/E) da /0

1 In the top menu, select MODE MENU >
CAMERA - 1SO and press ).
I=° “Menu basics” (P.38)

+ IfISO is displayed on the top menu as a shortcut
menu, press the arrow pad in the same direction
as the arrow shown next to ISO.

I “SHORT CUT” (P.157)

Mode dial ) &

1 Inthe top menu, press @ to select ISO.

2 Press ®& to choose the most suitable ISO value, then press &).
+ AUTO is not available in A, S or M mode.
* Press (@ again to exit the menu.

Arrow pad

OK button

/'> » Higher ISO settings produce more electrical noise.
}-t * When ISO sensitivity is set to AUTO and you are shooting in dark conditions
ote

without a flash, the sensitivity automatically increases, otherwise the shutter
speed will be reduced, possibly resulting in camera movement and blurred
images.

If the subject is too far away for the flash illumination to reach when ISO
sensitivity is set to AUTO, the sensitivity is automatically increased.

When using slow synchronization in the P, A or S mode, the slowest
available shutter speed varies depending on the ISO setting.
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Exposure compensation

In some situations, you may get better results when the exposure that the
camera sets is compensated (adjusted) manually. You can adjust the exposure
by selecting the exposure compensation value. After adjusting the exposure,
you can check the picture in the viewfinder or on the monitor.

PIA[S BT/ E AR Y

1 Turn the control dial while holding down [4. Exposure Control dial
+ Adjust toward + Turn to the right to adjust up compensation button
to +2.0.
+ Adjust toward — Turn to the left to adjust up to
-2.0.

» The exposure compensation can be set in 1/3EV
steps or 1/2EV steps. I “EV STEP — Setting
exposure adjustment increments” (P.153)

2.0 0.0

TIPS == ====sscsccceccssses s nnnnns
@ Often bright subjects (such as snow) will turn out darker than their natural
colors. Adjusting toward + makes these subjects closer to their real shades.
For the same reason, adjust toward — when shooting dark subjects.
Pressing 4 when histogram is set to [Z4 ON
displays the histogram in the viewfinder or on the
monitor.

If you press while pressing 4, the menu for
changing the histogram setting is displayed.

[ “Histogram — Displaying the luminance
distribution of still pictures” (P.119)

You can change the position of the histogram target mark.

I “Changing the position of the histogram target mark” (P.120)

You can set the aperture by turning the control dial while holding down [E4 in
5 M mode. I=5° “Manual shooting” (P.72)

Note If the flash is used, the image brightness (exposure) may differ from the

intended brightness.

Exposure compensation cannot correct the image if the surroundings of the

subject are extremely bright or dark.

AN
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White balance W]

Color reproduction differs depending on the light conditions. For instance, when
daylight, the setting sun or tungsten lighting are reflected on white paper, the
shade of white produced will be slightly different for each. By setting the WB
(white balance), you can achieve more natural-looking colors.

PIA s M EDXE Al

1 Turn the control dial while holding down Control dial
WB, then select the best white balance
(AUTO, PRESET1, PRESET2,CUSTOM, &2)
for the shooting conditions.

WB White balance button

Ca>
5\ \-— Arrow pad
@ OK button

&

PRESET1

SET #0K

2 If you selected PRESET1, PRESET2, CUSTOM or O3, press
while holding down WB to display the next selection screen.
PRESET1 [¥ “Preset1 white balance” (P.110)

PRESET2 ¥ “Preset2 white balance” (P.110)
CUSTOM 5" “Custom white balance” (P.111)
=3 [ “One-touch white balance” (P.111)

Auto white balance

Automatically adjusts the white balance for any light source.

* Press &) while holding down WB to display the menu
for adjusting and storing the auto white balance. g R o= B

I “White balance compensation” (P.112)
I “Saving a custom white balance” (P.113)

SELECT®E SET#[»] GO#[OK]
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White balance

Preset1 white balance

Select a white balance setting according to the type of light when shooting
outdoors.

DD | PRESET1, th

1 Press to select S then ) )
press 9 | o ]

2 Press ®& to select 1),, <, 3 or 2, ( SET

then press ®.

* Press &) again to exit the menu.
@ & SELECT# 6 GO #[OK]

). For shooting in the shade
> For shooting on a cloudy day
:Q:  For shooting on a sunny day

X For shooting in evening sunlight

Preset2 white balance

Select a white balance setting according to the type of light when shooting
indoors.

1 Press @& to select PRESET2, then

2 Press ® to select &, &5, &3, &4, -5, | SET
depending on the type of light, then press ). -

-

+ Press & again to exit the menu.
9 SELECT # (] GO #(0K]

&4 For shooting under a daylight fluorescent
lamp (6,700K)*. This type of lamp is used mainly in homes.

&% For shooting under a neutral white fluorescent lamp (5,000K)*. This
type of lamp is generally used in desk lamps, etc.

&3 Forshooting under a cool white fluorescent lamp (4,200K)*. This type
of lamp is generally used in offices, etc.

&4 For shooting under a white fluorescent lamp (3,500K)*.

:8:  For shooting under a tungsten light (3,000K)*.

* The color temperature values (K) are approximate. They are not an accurate
indication of color.
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White balance

Custom white balance

Storing the white balance and white balance compensation settings lets you
reactivate the settings for use later on. I3~ “Saving a custom white
balance” (P.113)

1 Press ®& toselect CUSTOM 1, CUSTOM 2,

CUSTOM 3 or CUSTOM 4, then press ®.
(custom 1)
* Press (@ again to exit the menu. _
» Custom1 is set to sunny day light condition. [ cusToM 3]
« If no custom white balance has been saved, this (cusToMm 4]
item cannot be selected. ||
One-touch white balance g,

This function is useful when you need more precise white balance than
PRESET WB can provide. To set the optimum white balance for the shooting
conditions, point the camera at a white object under the light source you want to
use and adjust the white balance.

1 Press @& to select GO, then press @ )
D

RED 00000 BLIE

18

2 Display the O3, screen and point the camera O
at a sheet of white paper.

* Position the paper so that it fills the screen, making
sure there are no shadows.

CANCEL® [«] GO#(OK]

3 Press ®.

* The new white balance is set.

button
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White balance

When setting the white balance by pointing the camera at a sheet of white
paper, the correct setting may not be obtained if the light reflected by the

Note  paper is too bright or too dark.

» White balance may not be effective under some special light sources.

* After setting a white balance other than AUTO, play back the picture and
check the colors on the monitor.

* When the flash is fired with a white balance setting other than AUTO, colors
may appear different in the resulting picture from the colors you see on the
monitor.

White balance compensation WBY.

This function lets you make fine changes to the AUTO, PRESET 1, PRESET 2
and one-touch white balance settings.

P As | MEP X = AR/ Y

1 Follow the procedure on P.109 - P.111 to WB White balance button
select the white balance you want to adjust.

oD

5 \—— Arrow pad
QOK button
2 Press @ while holding down WB.
g q D%

3 Press ®® to select WBY, then press f). (@20 Y e

SELECT#F] SET#[») GO#[OK]

4 The color becomes bluer each time you
press &, and redder each time you press
&, depending on the original white balance
conditions. Press (&) to save your
adjustment.

» The white balance can be adjusted 7 increments in
both the red and blue directions.
+ After saving the adjustment, press () again to exit the menu.
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White balance

Saving a custom white balance

You can save the current white balance setting and white balance
compensation value in CUSTOM 1 to CUSTOM 4 and select them as custom

white balance menus.

[Mode dia )P [A]'s | M m?/E) da 0

1 Follow the procedure on P.109 - P.111 to
select the white balance you want to save.

2 Press @ while holding down WB.
3 Press ®& to select SET, then press @

4 Press ®& to select CUSTOM 1, CUSTOM 2, CUSTOM 3 or

CUSTOM 4, then press ®.

WB White balance button

Arrow pad

| OK button

D&
CsET

| PRESET1 |
(L D e ase()ocoBUE

SELECT®&] SET»[») GO#[OK]

» The current white balance setting and white balance adjustment value are

saved as a custom white balance.

« If a custom white balance is already saved in the selected number, a

confirmation screen appears. To register the new settings, select RESET and

press ®.

* Press (@ again to exit the menu.
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SHARPNESS

This function adjusts the sharpness of the image.

o[als W BTARD

1 In the top menu, select MODE MENU -
PICTURE > SHARPNESS, and press @
I=° “Menu basics” (P.38)

Arrow pad

oK
\) | OK button

2 Press & to adjust the sharpness
between +5 and -5. C )

* To increase the sharpness (+) : mC )
Press & . The image contours are = I\["sCENE MoDES |
emphasized, making the image appear sharper 4 0
and more vivid. Use this setting when you want [ CONTRAST )

to print pictures.

* To reduce the sharpness (-) :
Press & . The image contours are softened. Use this setting when you
want to edit images on a PC.

+ When you have finished setting the sharpness, press &). Press @) again to
exit the menu.

Q + If you adjust the sharpness too far toward +, noise may become noticeable

in the picture.
Note
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CONTRAST

This function adjusts the contrast of the image. For example, you can make
images with marked differences in light and shadow softer, and those with less
differences more vivid.

P A|s| M EDRE A )

1 In the top menu, select MODE MENU ->
PICTURE > CONTRAST, and press 0.
I=° “Menu basics” (P.38)

\—— Arrow pad
\/l OK button

2 Press ™ to adjust the contrast between

+5 and -5. ( )
* Toincrease the contrast (+) : mC )
Press & . The light and dark areas are defined | & (77 1)
more clearly, making the image look crisper. [ SHARPNESS |
+ To reduce the contrast (-) : (contRAST)4(_£0 )
Press & . The light and dark areas become
less defined, giving the image a softer
impression. Use this setting when you want to editimages on a PC.

+ When you have finished setting the contrast, press &). Press &) again to exit
the menu.
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HUE e

This function adjusts the tint of the whole picture. The hue can be adjusted
between +5 and -5.

PIA s M ED X E Al

1 In the top menu, select MODE MENU >
PICTURE - HUE, and press §).
[ “Menu basics” (P.38)

Cad
@ Arrow pad
X | OK button
2 Press & to adjust the hue between +5
and -5. HUE )4 £0 )%
+ Toincrease the hue (+) : :+ | SATURATION |

Press . Based on the blue of the sky, the
picture takes on a greener hue.

* Toreduce the hue (-) :
Press &. Based on the blue of the sky, the
pictures takes on a purpler hue.

* When you have finished setting the hue, press ®. Press again to exit the
menu.
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S ATION

This function adjusts the color depth.

o[a[s W BTARD

1 In the top menu, select MODE MENU >
PICTURE > SATURATION, and press §).
I=° “Menu basics” (P.38)

Arrow pad
| OK button

2 Press ®& to adjust the saturation
between +5 and -5.
* Toincrease the saturation (+) :
Press &. Colors become darker and more
intense.
» To reduce the saturation (-) :

| HUE |

(AR 4(£0 )

Press &. Colors become lighter.

+ When you have finished setting the saturation, press &). Press ®) again to

exit the menu.

SCENE MODES

InP, A, S, M, ®? and & modes, the image is processed according to your
purpose and the effect you want to achieve. The color reproduction, sharpness,

contrast and saturation are adjusted automatically.

[ A8 W

1 In the top menu, select MODE MENU >
PICTURE -> SCENE MODES, then choose
from >NORMAL, @, [ or [®)], and press ®.
I “Menu basics” (P.38)

» For N, [ and ®) modes, see “Situation-related
modes” (P.49).
* Press (& again to exit the menu.
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NOISE REDUCTION

This function reduces the noise that is generated during long exposures. When
shooting night scenes, shutter speeds become slower and noise tends to
appear on images. When noise reduction is set to ON, the camera automatically
reduces noise to produce clearer images. However, shooting time is
approximately twice as long as usual.

Noise reduction can only be used when the shutter speed is set slower than
1/2 sec.

Noise reduction: OFF Noise reduction: ON

The purpose of these pictures is to illustrate the effects of noise reduction.
They are not actual pictures.

[ o 4 [wlas

1 In the top menu, select MODE MENU >
CAMERA - NOISE REDUCTION - ON or
OFF, and press ®).

I “Menu basics” (P.38)

* Press & again to exit the menu.

Arrow pad

OK button

When ¥] mode is set, noise reduction is fixed to ON.

When noise reduction is set to ON, the camera implements noise-reducing
processes after each shot. For this reason, shooting time is approximately
twice as long as usual. During this time, you cannot continue shooting.
When noise reduction is set to ON, sequential shooting (HI1 =y, =, AF =,
BKT) is not possible.

This function may not work effectively with some shooting conditions or
subjects.

As the shutter speed is relatively slow, the use of a tripod is recommended.

»

Note
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Histogram — Displaying the luminance

distribution of still pictures

During still picture shooting, you can display a histogram showing the brightness
and contrast of your subject in the viewfinder or on the monitor. You can also
display the black and white areas directly on the image.

Checking the histogram during shooting enables precise exposure control.

OFF The histogram is not displayed.
ON The histogram is displayed when [4 is pressed.
5" “Exposure compensation” (P.108)
ON The histogram is always displayed.
DIRECT The black and white areas are displayed directly on the image.

Ex. When ON is selected in P mode
When the image is bright When the image is dark

P 1/200F5.6 +2.0 P 12007 F 5621210
s ————— Histogram -
i target mark .

ooy L
- dd

'..r»-“ e
:i" e O L
If the peak fills too If the peak fills too
much of the right much of the left frame, i\ l
/_frame, the image will the image will appear
\ appear mostly white. mostly black.

The part indicated in green in the histogram shows the luminance distribution within
the histogram target mark.

Ex. When DIRECT is selected in P mode

Red frame: Mostly white area
Blue frame: Mostly black area

If the area contains both black and white parts, it
is also displayed in the blue frame.

119|
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Histogram — Displaying the luminance distribution of still pictures

[Mode dia (P [A]'s | Mm?/E) Aa 0

1 Press @ while holding down [4. B Exposure  Control dial

compensation button

1 Arrow pad
%o;( button

2 Press &®& to choose the histogram
display mode, then press ®).
+ In M mode, when histogram is not set to OFF, the
subject is displayed in the viewfinder or on the
monitor at the appropriate brightness for the

selected exposure. EET*E GO*[0K]

The histogram or the direct is not displayed in the following situations even
if is set to ON or DIRECT.

During panorama shooting or during multi-metering
You can turn the histogram display on and off during exposure
compensation. I5”“Exposure compensation” (P.108)
The histogram displayed during shooting may differ from that displayed
during playback.
The histogram is not displayed in movie mode.

Note

@ Changing the position of the histogram target mark

While the histogram is displayed in shooting mode, hold down [¥4 and use the
arrow pad to move the histogram target mark. The area inside the target is
displayed in green on the histogram.

To restore the histogram target mark to its original position, press &) while
holding down 4.




7 Playback

Viewing still pictures =
D E

1 Set the mode dial to (=] (playback mode) Mode dial
and turn the camera on.

=" “Turning the power on/off” (P.25)

* The last picture taken is displayed. (Single-frame
playback)

+ Shooting information is displayed for about 3
seconds. You can change how much information is
displayed on the screen.
=" “INFO — Displaying shooting Arrow pad
information” (P.135)

 For details of the information displayed, see
“Viewfinder and monitor indications” (P.11).

Control dial

(D]
HQ

e

il i

‘04.04.17 15:30 " 30

2 Use the arrow pad or control dial to play back other pictures.
* Arrow pad

Jumps to the picture 10 frames back.

CAD
Displays the previous picture. g Displays the next picture.
\QD’}

Jumps to the picture 10 frames ahead.

» Control dial

Displays the previous picture. wﬂ Displays the next picture.
v

* If no operation is performed for about 3 minutes, the camera automatically
enters the sleep mode and the monitor or viewfinder turns off. Press or
any button to turn the monitor or viewfinder on.

Note

121 I
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Viewing still pictures

QUICK VIEW

This function lets you play back pictures while the camera is in the shooting
mode. This is useful when you want to check shooting results and resume

shooting quickly.
Functions available in normal playback mode are also available in Quick View.

PASM®B X MXN

1 Press the QUICK VIEW button in the
shooting mode.
* The camera immediately enters the playback
mode and displays the last picture taken. (Single-
frame playback)

2 Press the QUICK VIEW button again to return to the shooting

mode.
+ Alight press of the shutter button will also return the camera to shooting
mode.
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Viewing still pictures

Picture rotation &

Pictures taken with the camera held vertically are displayed horizontally. This
function lets you turn such pictures 90 degrees clockwise or counterclockwise
so that they are displayed vertically.

Mode dial ) [»>]

1 In the single-frame playback mode, press 7. €1 Rotation button
« Each pressing of £ rotates the image in the
following sequence: 90 degrees counterclockwise,
90 degrees clockwise, and back to the original.

coa A
04. 081715830

» The following pictures cannot be rotated.
Movies, protected pictures, pictures that have been edited on a PC and
pictures taken with another camera

* New picture orientations are saved even when the power is turned off.

Note

123|
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Close-up playback

Pictures displayed on the monitor can be enlarged 2, 3, 4 or 5 times.

[ &

1 Select the still picture you want to enlarge.
* You cannot enlarge pictures with &.

2 Turn the zoom lever toward T (Q).
» The picture is enlarged in steps each time the lever
is turned.
» By using the arrow pad while the enlarged picture
is displayed, you can shift the picture in the desired
direction, enabling you to view a different portion.

Zoom lever

* Turning the control dial allows you to view the next or previous frame in the
same magnification.
» To return the picture to the original size (1x), turn the zoom lever toward W.

[xD]

D
g

i}

06,0417 15:90° 80

¢ L}ﬁb
N e et )

= i ¢ i

: vl W

The left side of the picture is
displayed.

/7, ° Pictures cannot be stored in an enlarged state.

Note
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Index display

This function lets you show several pictures at the same time on the monitor.
The number of pictures shown can be 4, 9 or 16. I5” “Selecting the number of

p

ictures” (P.126)

Mode dial ) [>]

In the single-frame playback mode, turn the Zoom lever

1

zoom lever toward W (E=3).

» Use the arrow pad to select the picture.
Moves to the previous frame.

@ : Moves to the next frame.
& : Moves to the upper frame.
& : Moves to the lower frame.

» Turning the control dial during an index display allows you to change the

pages displayed.

* To return to the single-frame playback, turn the zoom lever toward T.

125|
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Index display

Selecting the number of pictures

This function lets you select the number of pictures in an index display from 4,
9 and 16.

[ &

1 In the top menu, select MODE MENU >
12 > B2 > 4,9 or 16, and press ®.
I=° “Menu basics” (P.38)

* Press (@ again to exit the menu.

ok Arrow pad
Ll OK button

C TIPS ==sssesesssascesesancnsasnncnsnsnnnnnsns
* Pictures can also be displayed in index format using the }& tab in SET UP
mode.
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Slideshow

This function displays still pictures stored in the card one after another. Only the

first frame of a movie is played back.

[ @

1 Select a still picture, then press @) to
display the top menu.

2 Press ® to start the slideshow.

3 Press ® to stop the slideshow.
* The slideshow will not stop until you cancel it by
pressing ®.

Ay
=
. I
(woE meNy) D
-
]
: i Ha
.
ey
el
04,086,997 15580 8O

Q * You are recommended to use the optional AC adapter when running a

Note

slideshow for a long period of time. If a battery is used, the camera will stop
the slideshow after about 30 minutes and enter sleep mode.

127|
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Viewing movies

This function lets you play back movies. You can fast forward the movie, play it back
one frame at a time or save selected frames as still pictures (capture, SHQ only).

[ s> @

1 Use the arrow pad or control dial to display Control dial

the picture with & you want to play back.
I “Viewing still pictures” (P.121)

2 Press ®.

* The top menu is displayed.

3 Press ® to select MOVIE PLAY.

4 Press &®& to select MOVIE PLAYBACK,
then press ®.
+ The movie is played back. When playback ends, the
display automatically returns to the beginning of the movie.

@ The following operations can be

——Arrow pad

OK button

performed during movie playback.

[J] appears on movies that have sound recorded. Pressing
I lets you adjust the sound volume during playback.
D

()

9
8

|128

: Reduces the volume.
: Plays the movie at double the normal speed.

Increases the volume.

Holding the button down increases the speed :-'/»vEﬂ Q)
to 20 times the normal speed. e

: Plays the movie in reverse at double the Playing time/Total recording ime

normal speed. Holding the button down
increases the speed to 20 times the normal speed.

: Pauses playback and displays the MOVIE PLAYBACK menu.



Viewing movies

5 Press ®.

- The MOVIE PLAYBACK menu is displayed. _
PLAYBACK Plays back the entire movie | MOVIE PLAYBACK ‘|

again. i
FRAME BY FRAME Plays back the movie manually |
one frame at a time. |“__ X

CAPTURE Cuts one frame from the movie

and saves it as a still picture. | SHECTOE]  GO#[OK]
If the movie is recorded in the

record mode other than SHQ, this cannot be selected.

EXIT Leaves the movie playback mode.

6 Press @& to select PLAYBACK, FRAME BY FRAME, CAPTURE
or EXIT, then press ®.

@If you selected FRAME BY FRAME

: Displays the first frame of the movie.

: Displays the last frame of the movie.

: Displays the next frame. The movie can be
played continuously by holding the button down. F

. Displays the previous frame. The movie canbe | D000 Y10l 36
played continuously in reverse by holding the I ﬂﬂ”fﬂﬂ pZALIS!
button down.

: Displays the MOVIE PLAYBACK menu.

@If you selected CAPTURE

@

@
®

Play back the movie one frame at a time o
: . | MOVIE PLAYBACK
until the frame you want to save as a still — ‘I
picture is displayed. .: il
Press ®). (
Press & to select CAPTURE, then “ :
press ®. | SELECT
Press & & to select the card, then ]
press ®.
« If only one card is inserted, skip this step.
» When there is insufficient card memory, the display returns to the MOVIE
PLAYBACK menu.
Press & & to select OK, then press ®.
« A still picture is created from the extracted movie frame and the display
returns to the MOVIE PLAYBACK menu.

CAPTURE

C TIPS === ==="scccmemeaeaeec s
» Movies can also be played back in the shooting mode using QUICK VIEW.

I “QUICK VIEW” (P.122)
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Editing movies

@ + The still picture created in CAPTURE is SQ2 (640 x 480 pixels). This picture

may be grainier than still pictures of the same size.

* While the card access lamp is blinking, the camera is reading the movie from
the card. Reading of movies may take considerable time. Do not open the
card cover while the card access lamp is blinking as this may cause not only
the data on the card to be damaged, but may also render the card unusable.

Note

Editing movies

This function lets you create indexes from as well as edit movies. However, you
cannot edit movies longer than approximately 56 seconds in SHQ mode, 150
seconds in HQ mode and 600 seconds in SQ mode.

INDEX 9 frames extracted from a movie are displayed as an index to show
the movie at a glance. Indexes can be stored on the card as still
pictures.

EDIT This function lets you cut the parts of the movie that you want and
edit.

[ &

1 Use the arrow pad to select a picture with &.

Arrow pad

| OK button

2 Inthe top menu, select MOVIE PLAY, then
choose each item.
I=° “Menu basics” (P.38)

Select “INDEX” = P.131
Select “EDIT” I P.132
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Editing movies

Creating an index

3 Press @& to select INDEX, then press ®.

4 select the first frame of the index with the
arrow pad and press ®.

: Jumps to the first frame of the movie.

: Jumps to the last frame of the movie.

: Displays the next frame. The movie can be
played continuously by holding the button down.

: Displays the previous frame. The movie can be
played continuously in reverse by holding the
button down.

5 Asin Step 4, select the last frame of the
index with the arrow pad and press ®).

{O0TBE00:361p% E

6 Press ©& to select the card, then press ®.
« If only one card is inserted, skip this step.
* When there is insufficient card memory, the display returns to the setting
screen.

7 Press @& to select OK, then press @).

» The camera returns to the playback mode, then the
9 frames extracted from the movie appear as an
index display. The index is stored as a new picture.

« If you want to select different frames, select RESET
and press @) and repeat the procedure from Step 4.

» To quit the index function, select CANCEL and
press ®.

C TIPS === === ssececcccesses s mesnnnnnnnnn
» The index is stored as a still picture in a different record mode from the
original movie.

Record mode when the movie was shot | Record mode when stored as an index
SHQ SQ1 (2048 x 1536 pixels: HIGH)
HQ SQ2 (1024 x 768 pixels: HIGH)
SQ SQ2 (640 x 480 pixels: HIGH)

131|
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Editing movies

* The interval between the frames that are automatically picked out varies
@ depending on the length of the movie.

* An index consists of 9 frames.

* You cannot create an index if there is insufficient memory space on the card.

Note

Editing a movie

3 Press ®& to select EDIT, then press &).

MOVIE PLAY
-~

Sz

4 select the first frame of the part you want to
keep with the arrow pad and press ®).

: Jumps to the first frame of the movie.

: Jumps to the last frame of the movie.

: Displays the next frame. The movie can be
played continuously by holding the button down.

: Displays the previous frame. The movie can be
played continuously in reverse by holding the
button down.

5 Asin Step 4, select the last frame of the part

WA 3 () OKe[OK]
you want to keep and press ®. =

(00°36/100:36

6 Press ®& to select the card, then press ®.
« If only one card is inserted, skip this step.
* When there is insufficient card memory, the display returns to the setting
screen.

7 Press ©& to select NEW FILE or
OVERWRITE, then press ®.
NEW FILE Stores the edited movie as a new

movie.
OVERWRITE Stores the edited movie with the
same name as the original. The CAVCELS ] SELECTHE GO [OK]

original movie is erased.
« If the card selected in Step 6 is different from the
card on which the original movie is stored, skip this step.
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Editing movies

8 Press @& to select OK, then press ®.
+ If you want to select different frames, select
RESET and press &) and repeat the procedure

from Step 4. LSS
+ To quit the editing function, select CANCEL and | (ICANCELD
press ®. SELECT# ) GO»[0K]

The edited movie is stored and the screen returns
to the playback mode.

@ * You cannot edit movies with sound which were taken with another digital

camera.

Note . you cannot select NEW FILE if there is insufficient memory space on the
card.

133|
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Playback on TV

Use the AV cable provided with the camera to play back recorded images on
your TV. Both still pictures and movies can be played back.

[ s> @

1 Make sure that the TV and camera are turned off. Connect the A/V
OUT jack on the camera to the video input terminal on the TV
using the AV cable.

Connector cover

Connect to the TV’s video input
(yellow) and audio input (white)
terminals.

2 Turn the TV on and set it to the video input mode.
+ For details of switching to video input, refer to your TV’s instruction manual.

3 Set the mode dial to [=] and turn the camera on.
» The last picture taken is displayed on the TV. Use the arrow pad to select the
picture you want to display.
» The close-up playback, index display, slideshow and other playback functions
can also be used on a TV screen.

TIPS == meemsemeeeeeaascaaaseeaaaaannnnn

* You are recommended to use the optional AC adapter when using the
camera witha TV.

- Make sure that the camera’s video output signal type is the same as the TV'’s
2/ video signal type.
Note  p3“VIDEO OUT — Setting the video signal type” (P.174)
The camera’s monitor and viewfinder turn off automatically when the AV
cable is connected to the camera.
Be sure to use the AV cable provided to connect the camera to the TV.
The picture may appear off-center on the TV screen.
When pictures are compressed in order to fit the entire picture on the TV
screen, a black frame may appear around the picture. If the picture is output
to a video printer via the TV, the black frame may be printed.
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INFO - Displaying shooting information ([}F3

This function lets you display shooting information or a histogram in the single-
frame playback mode.

OFF

ON

Displays the only basic informations, such as the record mode,
date and time, and number of frames.

Displays detailed shooting information on the monitor for 3
seconds. For details of the information displayed, see “Viewfinder
and monitor indications” (P.11).

Histogram Displays a histogram showing the brightness and contrast of still

pictures. For more details, see “Histogram — Displaying the
luminance distribution of still pictures” (P.119).

[ &

1 Press INFO repeatedly.
» Each time you press INFO, the information
displayed changes as follows.

INFO Information display button

Arrow pad

OK button

‘04.04.17 15:30 30

When INFO is ON Histogram display

g |
bz

O

INFO

| S
Note

If the picture has been taken with a different camera, not all the information
may be displayed when INFO is set to ON.

The file number used to specify an image when making non-DPOF print at
a print shop is displayed when INFO is set to ON.

=5 “How to print pictures” (P.176)

The histogram displayed during shooting may differ from that displayed
during playback.

The histogram is not displayed in movie.

It may not be possible to display a histogram for pictures taken with another camera.

135|
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Displaying guidelines

This function lets you display guidelines on the monitor during single-frame
playback.

[ @

1 In the top menu, press @.

Control dial
* The guidelines are displayed.

\—— Arrow pad

@ OK button

2 Press & to select the type of guidelines.

* When the guidelines are displayed, use @@ or the control dial to display the
picture you want to see.

i

Roeqheld !

SELECT# £ CANCEL# [OK] SELECT® F CANCEL®» [OK]

Horizontal position

Vertical position

3 Press @ to remove the guidelines.

» The guidelines on the screen disappear and the camera returns to normal
single-frame playback.

* The guidelines are not displayed during close-up playback or during an
index display.

S (=
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Recording sound

Sound can be added to a still picture that you have already taken. (This is known
as “after-recording”.) You can also re-record over the sound that has already
been recorded. Total recording time per picture is approximately 4 seconds.

[ &

1 Select the still picture to which you want to
add sound, then press &) to display the top
menu.

\—— Arrow pad
@l

¥OK button
Ay
=]
- " L]

(hooe W)

-

2 Press & to display START.

3 Turn the camera microphone toward the Microphone

sound you want to record and press to
start recording.
* The BUSY bar is displayed during recording.

D If the microphone is placed farther than 1m (3.3ft) away from the subject, the
N-t recorded sound quality may not be satisfying.
ote

* If you re-record the sound, the original sound is erased.

You may not be able to record sound when there is insufficient card memory
(the CARD FULL message is displayed).

Sound recording may pick up camera noises, such as button operation or
shutter movement.

Once sound is added to a picture, it is not possible to erase only the sound.
In this case, make a re-recording with silence.

137|
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Editing still pictures

This function lets you edit still pictures and store them as new pictures. The
following editing operations are possible.

Resizing By Changes the picture size to 640 x 480 or 320 x 240 and
stores the picture as a new file.
Trimming = Crops part of a picture and saves it as a new file.

RAW DATA EDIT Adjusts the white balance, sharpness, etc. of the pictures
recorded in the RAW data format and stores them as new
TIFF or JPEG files. You can edit recorded pictures to your

liking while checking the result.

Mode dial ) [>]

1 In the top menu, select MODE MENU > Control dial
EDIT, then choose each item.
I=° “Menu basics” (P.38)

Zoom lever

Select [5gd I P.138

Select £ I P.139

Select RAW DATA EDIT 15" P.140

When selecting RAW DATA EDIT, display the image
recorded in RAW mode first.

oD

N\ \—— Arrow pad
@ OK button
Resizing Gl

2 Select [5a, then press .

3 Turnthe control dial to select the still picture
you want to edit, then press ®.

4 Press ®& to select a resolution, then

press ®. | EXITs[{ SELECT# ) GO#(OK] |
» To quit the resizing function, select CANCEL, then

press ®.

5 Press ®& to select the card, then press ®.
« If only one card is inserted, skip this step.
* When there is insufficient card memory, the display returns to the setting
screen.
6 Press ®& to select OK, then press ®.

» The BUSY bar is displayed during resizing. After the image is saved, the
camera returns to Step 3.
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Editing still pictures

* Resizing is not possible in the following cases.
Movies, pictures that have been edited on a PC, or when there is
insufficient memory space on the card.

« Ifthe size of the selected picture is 640 x 480, you cannot select 640 x 480.

Note

Trimming =

2 Sselect f, then press .

3 Turnthe control dial to select the still picture
you want to edit, then press ®.

4 Press ®& to select [T, then press ®.

5 Use the arrow pad, zoom lever and control
dial to decide the trimming position and
size.

* Press @@@@ to select the trimming frame, and
turn the zoom lever toward W or T to decide the
trimming size.

+ Use the control dial to select the height and width
of the trimming frame.

+ 3:2 trimming size can be selected when the size of
the selected picture is 3264 x 2448 or
3264 x 2176.

6 Press ®.

» The trimmed picture is displayed for one second.

7 Press & & to select the card, then press ®.
« If only one card is inserted, skip this step.
* When there is insufficient card memory, the display returns to the setting
screen.

8 Press @& to select OK, then press ®.
The BUSY bar is displayed during trimming. After
the image is saved, the camera returns to Step 3.
The trimmed picture is stored as a separate picture
from the original.

If you want to trim the picture again, select RESET
and press &). Then repeat the procedure from Step
5.

To quit the trimming function, select CANCEL and press ®.
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I —
Editing still pictures

/7, * Trimming is not possible in the following cases.
& Movies, or when there is insufficient memory space on the card.

Note , may not be possible to trim pictures taken with another camera.
« If a timmed picture is printed out, it may appear grainy.
RAW editing
2 Select RAW DATA EDIT, then press @
3 Turnthe control dial to select the still picture "i%
you want to edit, then press ®. %E;&DT@
* You can only select an image recorded in RAW C L) Eeeeeeetll
mode. :}DN@L
4 Press ®& to select the item you want to
set, then press
press § &% G
5 Press @ ® to select the desired setting, (B4 ) (PRESET1 )
then press ®. -‘C)D
. | We7 ] (cusTom )
6 When aOIKI the necessary items have been set, e e || O, b
press ®.

7 Press ®& to select the card, then press @).
« If only one card is inserted, skip this step.
* When there is insufficient card memory, the display returns to the setting screen.
8 Press @& to select OK, then press ®.
* The BUSY bar is displayed during RAW editing. After the image is saved, the
camera returns to Step 3.

@Items that can be set by RAW editing

Item Settings Ref. page
<€ TIFF, SHQ, HQ, SQ1, SQ2 P.102
+5 P.108
wB AUTO, PRESET1, PRESET2, CUSTOM*, B3* P.109
WBY] RED 7 to BLUE 7 P.112
SCENE MODES NORMAL, [N, [, P.117
SHARPNESS 15 P.114
CONTRAST 15 P.115
HUE 15 P.116
SATURATION 5 P.117
FUNCTION OFF, BLACK & WHITE, SEPIA P.98
= — P.139

* Can only be selected if WB was set to CUSTOM or &3, during shooting.

|140



Copying pictures

This function lets you copy pictures to and from the xD-Picture Card and
CompactFlash or Microdrive. This menu can be selected if both cards are
inserted.

The selected card is the copying source. You can change the copying source by
pressing the card button. I~ “Switching cards” (P.23)

ALL Copies all the pictures on the card.
SELECT Copies only the selected picture.

[ &

1 Ifyou selected a still picture, in the top Control dial
menu, select MODE MENU - EDIT - COPY,
and press .

If you selected a movie, in the top menu,
press @ to select COPY.
I “Menu basics” (P.38)

» The screen is displayed for you to select ALL or

SELECT. —
@ 1 Arrow pad
OK button
2 Press ©& to select ALL or SELECT, then
press §.
@If you choose ALL
A confirmation screen appears asking if you want to
copy the pictures. Select YES and press ®). YES
» The pictures are copied and the menu is exited. [ NO |
EXIT#[{] SELECT#E GO#[OK]

@If you choose SELECT

The playback screen is displayed. Turn the control dial

to select the frame you want to copy and press ®.

» The picture is copied.

+ If you want to copy more pictures, repeat the
procedure.

+ To finish copying, press @ Press &) repeatedly until
the menu disappears.

o s, | gl
PO 7)1 SRS 80
EXITS (4] SELECT3 = COPY » (OK] |

141 I
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Protecting pictures

@ * Pictures cannot be copied to the same card.

* Files with a volume of 57 MB or over (movies of over approximately 64
seconds in SHQ mode, 70 seconds in HQ mode or 685 seconds in SQ
mode) cannot be copied. If you try to copy such files, the message “FILE
SIZE SELECTED TOO LARGE” will be displayed.

Note

Protecting pictures

You are recommended to protect important pictures to avoid accidentally
erasing them. Protected pictures cannot be erased by the single-frame/all-frame
erase function.

TG

1 Use the arrow pad or control dial to display Control dial
the picture you want to protect.
I “Viewing still pictures” (P.121)

O Protection button

2 Press Om.
+ To cancel protection, press O again.

Arrow pad

OK button

Displayed when a
picture is protected.

@ * Protected pictures cannot be erased by the single-frame/all-frame erase

N function, but they are all erased by formatting.
ote
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Erasing pictures

This function lets you erase recorded pictures. Single-frame erase erases only
the picture displayed on the monitor and all-frame erase erases all the pictures
on the card.

@ * You cannot erase pictures that are protected. Cancel protection before
$ erasing such pictures.

Note . Once erased, pictures cannot be restored. Check each picture before
erasing to avoid accidentally erasing pictures you want to keep.
I “Protecting pictures” (P.142)
Single-frame erase "
Mode dial ) [>]
1 Use the arrow pad or control dial to display Control dial

the picture you want to erase.
I “Viewing still pictures” (P.121)

Arrow pad

€ OK button

2 Press ‘g.
« The §f ERASE screen is displayed.

3 Press @& to select YES, then press ®.
» The picture is erased and the menu is closed.

| SOl GO8[OK] |

143|
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Erasing pictures

All-frame erase g

This function erases all the pictures on the card.

Mode dial ) [>]

1 In the top menu, select MODE MENU >
CARD - CARD SETUP, and press ).
I=° “Menu basics” (P.38)

\—— Arrow pad
%OK button

2 Press ®& to select £ ALL ERASE, then
press ®.

CANCEL® (<] SELECT#[:] GO#[OK]

Press & to select YES, then press ®.
* All the pictures are erased.

w

> ALL ERASE [xD]
/\ CAUTION ERASING ALL

YES
SELECT# (5] GO»
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8 Customizing the camera

ALL RESET - Saving the camera’s settings

This function lets you keep the current camera settings when you turn off the
power. The same settings are then reactivated next time you turn the camera
on. The settings affected by All Reset are listed on the next page.

The All Reset setting (ON/OFF) applies to all the modes. If All Reset is set in
one mode, this setting applies to all the other modes, both shooting and
playback.

ON All settings are returned to the factory default settings after the power is
turned off.

Ex. If the record mode is changed to SQ1 and All Reset is set to ON,
the record mode will return to HQ (factory default setting) next time
the camera is turned on.

OFF The settings made before the power is turned off are saved and are
activated again next time the camera is turned on.

P Als M AaS () SETUP

1 In the top menu, select MODE MENU - {8
> ALL RESET - ON or OFF, and press ®.
Or in SET UP mode, select 1@ > ALL
RESET - ON or OFF, and press ®.
I=° “Menu basics” (P.38)

+ Press & again to exit the menu.
+ In SET UP mode, set the mode dial to a different
mode to exit the menu.

—— Arrow pad

OK button

+ My Mode settings and functions on the SETUP tab (ALL RESET, @£3), m),
. etc.) are not returned to the factory default settings even when All Reset is
Note st to ON.

* When ALL RESET is set to OFF, it may take time to start up when the power
is turned on.
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|
ALL RESET — Saving the camera’s settings

@Functions that All Reset affects

|146

Factory Factory
Function default Zefé Function default Zefé
setting pag setting pag
FNo F2.4 P.70 AF MODE iESP P.74
SHUTTER 1/1000 P.71 P-AF ON P.76
Program Shift Reset P.46 @ (still pictures) OFF P.100
0.0 P.108 |[|® (movies) ON P.101
FLASH AUTO P.59 FUNCTION OFF P.95,
97,
98
5 0.0 P.64 8 OFF P.99
AF/&Y/MF AF P.79, OFF P.119
87,
88
(O] ESP P.81 <€:- HQ P.102
O/ OFF P.89, |(|WB AUTO P.109
90
LCD/EVF LCD (ON) P.50 WBY] No P.112
compensation
CARD xD P.23 SCENE MODES |NORMAL P.117
Optical zoom wide P.57 SHARPNESS +0 P.114
Oy O P.92 CONTRAST +0 P.115
BKT +1.0, P.93 HUE +0 P.116
3 pictures
ISO AUTO P.107 ||SATURATION 0 P.117
MY MODE MY MODE 1 |P.73 JPEG DUPLICATE |OFF P.106
SETTING
=M FLASH IN+="y P.66 TIFF, SHQ, HQ 3264 x 2448 |P.105
SLAVE 1 P.69 SQ1 2048 x 1536 |P.105
NORMAL
$sLow $sLow1 P.63 SQ2 640 x 480 P.105
NORMAL
NOISE OFF P.118 |[[INFO OFF P.135
REDUCTION
DIGITAL ZOOM OFF P.58 ™ 640 x 480 P.138
FULLTIME AF OFF P.75




REC VIEW - Checking the picture

immediately after shooting

You can display the picture you have just taken on the monitor while it is being
recorded to the card. This is useful for making a brief check of the picture you
have just taken.

OFF The picture being recorded to the card is not displayed.
This is useful when you want to prepare for your next
shot while the previous picture is being recorded.

AUTO The picture you have just taken is displayed while it is
recorded to the card.

3 SEC, 5 SEC, 10 SEC You can select the length of time the picture is
displayed. If recording is not completed in the set time,
the picture is displayed until recording is finished.

PA S M®B E SN SETUP

1 In the top menu, select MODE MENU - {8
- REC VIEW - OFF, AUTO, 3 SEC, 5 SEC
or 10 SEC, and press ®.

Orin SET UP mode, select }& > REC VIEW
- OFF, AUTO, 3 SEC, 5 SEC or 10 SEC, and
press ®.

I “Menu basics” (P.38)

>
LA

+ Press & again to exit the menu. @\ | frow pad

= OK button

+ In SET UP mode, set the mode dial to a different
mode to exit the menu.
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Setting the button operation sound 333

You can choose from 2 different sounds for button operations. You can also set
the volume of each sound to LOW or HIGH. The factory default settings are 1
(short beep) for the sound and LOW for the volume. You can turn the sound off
completely by setting OFF.

P A S MmEBE R Ma Y] SETUP

1 In the top menu, select MODE MENU - {8
> BEEP, and press ).
Orin SET UP mode, select }@ > BEEP, and
press §.
I “Menu basics” (P.38)

&)

A
o\ \—— Arrow pad
@ OK button

2 Select1or2and press @ Then select LOW
or HIGH and press ®.

* To turn the sound off completely, select OFF and | OEED)
press ©. o)

Press &) again to exit the menu.

In SET UP mode, set the mode dial to a different
mode to exit the menu.
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SHUTTER SOUND - Setting the shutter sound

You can select from 2 kinds of sounds for the shutter button. You can also set
the volume of each sound to LOW or HIGH. The factory default settings are 1
for the sound and LOW for the volume. You can turn the sound off completely
by setting OFF.

P A S M®mPE Aa () SETUP

1 In the top menu, select MODE MENU - {8
> SHUTTER SOUND, and press §).
Orin SET UP mode, select 1§ > SHUTTER
SOUND, and press @
I “Menu basics” (P.38)

&)

A
o\ \—— Arrow pad
@ OK button

2 Select1or2and press @ Then select LOW
or HIGH and press ®.
* To turn the sound off completely, select OFF and

| OFF
press ©. @D
* Press (@ again to exit the menu.

* In SET UP mode, set the mode dial to a different u

mode to exit the menu.

eiowed ayj Buiziwoysny
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DIAL - Changing the function of the control dial

You can change the function of the control dial and arrow pad in the shooting
mode. Normally, to adjust the exposure compensation, you turn the control dial
while holding down [Z4, but this feature lets you set the exposure compensation
using only the control dial.

In addition, it is also possible to set the functions by using both direct buttons
and the control dial with only the direct buttons.

The function of the control dial and arrow pad varies depending on the shooting
mode. You can also assign functions chosen from CUSTOM 1, CUSTOM 2 and
CUSTOM 3. For more details, see the table on the next page.

P AS MEPXRE M SETUP

1 In the top menu, select MODE MENU - {8
- DIAL > NORMAL, CUSTOM 1, CUSTOM 2
or CUSTOM 3, and press ®.

Or in SET UP mode, select }@ - DIAL >
NORMAL, CUSTOM 1, CUSTOM 2 or
CUSTOM 3, and press ®.

I “Menu basics” (P.38)

* Press (& again to exit the menu.
+ In SET UP mode, set the mode dial to a different
mode to exit the menu.

A
a3\ \—— Arrow pad
@ OK button

)
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DIAL — Changing the function of the control dial

@ Control dial and arrow pad functions by shooting mode

Shooting Function
mode NORMAL CUSTOM 1 CUSTOM 2 CUSTOM 3
. Exposure Exposure o
P compensation compensation
A Program Shift Program Shift Program Shift Program Shift
-«
0 o o o Exposure
compensation
Exposure Exposure
Aperture value compensation compensation -
A — Aperture value — Aperture value
— Exposur(_e Aperture value Exposurg
compensation compensation
Exposure Exposure
Shutter speed compensation compensation -
s — Shutter speed Shutter speed Shutter speed
. Exposure . Exposure
compensation compensation
Shutter speed — — —
M — Shutter speed Shutter speed Shutter speed
— Aperture value Aperture value Aperture value
. Exposure Exposure o
compensation compensation
© — — — —

Exposure
compensation

Exposure
compensation

x  Ywmd, : Turn the control dial to set.

: Press @& on the arrow pad to set.

: Press @@ on the arrow pad to set.
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DIAL — Changing the function of the control dial

Another CUSTOM 3 function

When CUSTOM 3 is selected, functions that were set by turning the control dial
while holding down the direct button can be set using only the direct button. The
setting can be changed by repeatedly pressing the direct button.

I3 “Functions that can be set using the direct buttons” (P.33)

Ex. Changing the flash mode
Press i repeatedly.
» The flash mode changes each time i is pressed.

Press Press Press

¥ ¥ ¥

= ruast wooe (RN = B © ) = ruast nooe (D)

— Precautions when using CUSTOM 3

» The exposure compensation cannot be adjusted by pressing 4. Flash
intensity control cannot be adjusted by pressing [¥4 and i at the same
time.

+ When sharpness, contrast, hue or saturation are assigned to the (]
button, the setting cannot be changed by repeatedly pressing .
PANORAMA and cannot be selected when FUNCTION is assigned
to the B button.
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EV STEP - Setting exposure adjustment

increments

You can set adjustment of the exposure compensation and flash intensity in
1/3EV or 1/2EV steps. The exposure compensation, flash intensity, shutter
speed, aperture and ISO sensitivity will differ depending on the adjustment
range you choose.

PASMEPX® Aa ) SETUP

1 In the top menu, select MODE MENU - {8
- EV STEP - 1/3EV or 1/2EV, and press ®.
Orin SET UP mode, select 1§ > EV STEP
> 1/3EV or 1/2EV, and press ®.

I “Menu basics” (P.38)

* Press (@ again to exit the menu.
+ In SET UP mode, set the mode dial to a different
mode to exit the menu.

A
a3\ \—— Arrow pad
@ OK button

&
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Custom button

You can set frequently used functions on the custom
button. This makes it easy to jump to the SETUP
screen without selecting MODE MENU or a shortcut
menu in the top menu.

Selecting a setting with the control dial and pressing
displays a dedicated screen for that setting. You
can make fine settings using the arrow pad and ®.

Functions that can be : : Ref.
set on the custom Settings made by the control dial

button page
ISO (default setting) AUTO, 50 to 400 P.107
=y O, HIG, &y, AFGDy, BKT* P.92
DIGITAL ZOOM OFF, ON P.58
NOISE REDUCTION OFF, ON P.118
FUNCTION OFF, PANORAMA, B8, BLACK & WHITE, SEPIA P.Qg,897,
FRAME ASSIST OFF, ON P.99
@ (still pictures) OFF, ON P.100
& (movies) OFF, ON P.101
MY MODE* @M to @78 P73
OFF, 40N, ON, DIRECT P.119
SCENE MODES NORMAL, (N, &, P.117
SHARPNESS -5to +0 to +5 P.114
CONTRAST -5to +0 to +5 P.115
HUE -5to+0to +5 P.116
SATURATION -5to +0 to +5 P.117
4+ —2.0 to +0 to +2.0 P.108
FLASH MODE* AUTO, @, ¥. §SLow, @ P.59
5 —2.0 to +0 to +2.0 P.64
AF/\&Y/MF AF*, &*, MF, ¥*, UMF P.7g,887,
(O] ESP, (¢], (CJMULTI, @) P.81
Ok OFF, &), &* P.89, 90
WB* AUTO, PRESET1, PRESET2, CUSTOM, &2, P.109
€ RAW, TIFF, SHQ, HQ, SQ1, SQ2 P.102

* The sub-menu lets you select further options.
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Custom button

Setting the custom button

PIAs|MEP R A () SETUP

1 In the top menu, select MODE MENU - 3
-> CUSTOM BUTTON, and press @
Orin SET UP mode, select }§ > CUSTOM
BUTTON, and press @
I “Menu basics” (P.38)

Arrow pad

OK button

2 Press @& to select the function you want
to set, then press ®.
* Press (& again to exit the menu.
+ In SET UP mode, set the mode dial to a different
mode to exit the menu.

. s
2]
| DIGTAL Z00M

i ReDUeTIN

R

@ « Ifthe mode dial is set to a mode other than @ and (4] is pressed when MY
MODE is set on the custom button, the customized settings are not
Note  activated. Set the mode dial to &P and press E4 to display the MY MODE
screen.
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Custom button

Using the custom button

PIA s M EDXRE Al

1 Press . [ Custom button
+ The function currently set to the custom button is
displayed.

Control dial

2 Turn the control dial while holding down [ to set.
+ B is used in the same way as the direct button. IS5 “Direct button
basics” (P.31)
* When an operation guide is displayed at the bottom of the screen, more
specific settings can be made.

Ex.1: When O3y is set to £

Ex.2: When SHARPNESS is set to (]
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SHORT CUT

You can set three shortcut menus (A, B, C) in the top menu in a still picture
shooting mode (P/A/S/M/m?/®) a2 /V).

This is useful when you want to go quickly to frequently-used functions.

Direct button function is al

so possible to be set to shortcut.

B
o
2 5—71~
((_Iso (MoDE_MENU) > Default setting
A Oy
DIGITAL ZOOM —C B: |s_6
< C: DIGITAL ZOOM
Top menu

Fu_nctions that can be set Ref. page Fu_nctions that can be set Ref. page
in the shortcut menu in the shortcut menu
FLASH MODE P.59 @ (still pictures) P.100
AF/&/MF P.79, 87, 88 ||MY MODE P.73
ESP/(¢] P.81 P.119
0y P.92 wWB P.109
O/ P.89, 90 € P.102
ISO P.107 SCENE MODES P.117
DIGITAL ZOOM P.58 SHARPNESS P.114
NOISE REDUCTION P.118 CONTRAST P.115
FUNCTION P.95, 97, 98 | |HUE P.116
FRAME ASSIST P.99 SATURATION P.117

157|

eiowed ayj Buiziwoysny H



elawed ay} Bujziwolsny u

. _________________
SHORT CUT

Setting the shortcut menu

You can set the three shortcut menus designated by A,
B and C on the diagram shown right. o
A
~ ~N
IC B ) (woDE MEND)D
e

P Als M AaS (Y SETUP

1

In the top menu, select MODE MENU > {3
- SHORT CUT, and press @

Orin SET UP mode, select }§ > SHORT
CUT, and press .

I “Menu basics” (P.38)

Arrow pad

€ OK button

Press & to select A, B or C, then press @

SELECT» B GO»[OK]

Press @®& to select the function you want
to set, then press ®.

. [ A ][[FLASH MoDE

* The shortcut menu is set. ‘
* Press (®) again to exit the menu. ¢ ) eseim )
« In SET UP mode, set the mode dial to a different o=
mode to exit the menu.
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SHORT CUT

Using the shortcut menu

When you have set a shortcut menu, you can use it to jump to the setting screen

for that function.

[oce aia » s w7 ) Au/s )

1 Press ® to display the top menu.

* The shortcut menu you have set appears on the

top menu.

€ o % Arrow pad
OK button
2 Press ®, § or & to select the shortcut

menu. o

» The monitor jumps directly to the setting screen for Ve N

that function. (CONTRAST)  (MODE MENU)[>

- (D

v

Ex. When SHARPNESS is set in shortcut menu A

Top menu

Setting screen

o
Press.—} /\
((CONTRAST)  (WoDE WENU) D

- G
AV

Pressing & takes you directly
to the SHARPNESS screen.

159|

esowes ayy Buiziwoisna H



eiowed ayj Buiziwoysny !

MY MODE SETUP - Setting a function in

My Mode

You can set shooting-related functions in MY MODE. You can also save the
current settings in MY MODE.

When the mode dial is set to @}, your customized settings are activated. You
can save up to 8 different settings in MY MODE 1 to 8. Only MY MODE 1 has a
factory default setting.

@ Functions affected by MY MODE SETUP

Functions that can Default Ref. Functions that can Default Ref.
be setin MY MODE | setting page || be setin MY MODE | setting page
P/A/S/M/S-Prg P P46 ||WB AUTO P.109
FNo F2.4 P70 || € HQ P.102
SHUTTER 1/1000 P71 ||&y O P.92
0.0 P.108 |[ISO AUTO P.107
LCD/EVF*1 LCD P.50 |[DIGITAL ZOOM OFF P.58
ZOOM*2 28 mm - NOISE REDUCTION | OFF P.118
FLASH MODE AUTO P.59 ||FUNCTION OFF P.95,
97,98
5% 0.0 P64 ||FRAME ASSIST OFF P.99
=M FLASH IN+="y P.66 ||® (still pictures) OFF P.100
$sLow EsLowt1 | P63 OFF P.119
AF/&Y/MF AF P.79, ||SCENE MODES NORMAL | P.117
87,88
AF MODE iESP P.74 ||SHARPNESS +0 P.114
FULLTIME AF OFF P.75 ||CONTRAST +0 P.115
P-AF ON P76 ||HUE +0 P.116
ESP/[s] ESP P.81 ||SATURATION +0 P17
O/ OFF P.89,
90

*1 Sets whether the monitor (LCD) or viewfinder (EVF) turns on when the
camera is turned on.

*2 In P mode, available zoom positions are 28 mm, 50 mm, 85 mm, 105 mm
and 140 mm. (These numbers are based on the focal length of a 35 mm
camera.)
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MY MODE SETUP — Setting a function in My Mode

P Als M AaR () SETUP

1 In the top menu, select MODE MENU - 3
- MY MODE SETUP, and press ).
Orin SET UP mode, select }& > MY MODE
SETUP, and press @
I “Menu basics” (P.38)

€ o » Arrow pad
OK button
2 Press @& to select an item, then press @
. [ EV STEP |
CURRENT* Saves the current camera settings. [ CUsTan BUTTON )
RESET Restores the factory default settings. [ SHORT CUT ) (CURRENT )}
CUSTOM  Saves settings one by one. (D) (GESED))
*Cannot be selected in SET UP mode. ) (custom)

* The MY MODE SETUP screen appears.

3 Select a MY MODE number.
* Press & & to selecta MY MODE number from 1
to 8, then press ®).

MY MODE SETUP
G2 MY MODE2 |
. 3 MY MODE3 |
L 53 My MODE4 |

[oacei [ siicro Gos(ok |

@ When selecting CURRENT in Step 2

4 Press ®& to select SET, then press &).

* The current camera settings are saved in the
selected MY MODE. SET CURRENT SETTING

[1.1 MY MODE SETUP

o
m
-

esowes ayy Buiziwoisna H
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MY MODE SETUP — Setting a function in My Mode

@ When selecting RESET in Step 2

4 Press @& to select ALL RESET, then
press ®.
* The settings in the selected MY MODE are reset.
If no settings are saved, the relevant MY MODE
number cannot be selected.

@When selecting CUSTOM in Step 2

4 Press &®& to select the item you want to
save in MY MODE, then press @
» Forthe available items, see “Functions affected by
MY MODE SETUP” (P.160).

Press & & to change the setting, then
press ®.

» The setting is saved.

* You can also change the other custom settings.

a

» The screen displayed in Step 2 appears.
* Press (@ again to exit the menu.

1.1 MY MODE SETUP

RESET CURRENT SETTING
ALL RESET
SELECT »2 GO» [OK |

(esmis ) b
T DF2.4
C = DD1/1000

CEDbren

:

| PINSMIS rg
(Crno )4(F2.4)*

| SHUTTER |
-
| LCD/EVF

When you have made all the settings you want, press ®.

» In SET UP mode, set the mode dial to a different mode to exit the menu.

@ » The zoom position is set to one of the five zoom positions available in MY
MODE SETUP. The value closest to the current zoom position will be

Note  gglected.
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CONTROL PANEL - Using the monitor as

a control panel

This option lets you display the each setting on the monitor in the shooting
mode. The subject is displayed on the viewfinder.

P Als M EP X = Al /(Y SsETUP

1 In the top menu, select MODE MENU >1}3,
- CONTROL PANEL - ON, and press ®).
Orin SET UP mode, select {8 > CONTROL
PANEL - ON, and press ®).

I “Menu basics” (P.38)

* Press @ again to exit the menu.

In SET UP mode, set the mode dial to a different
mode to exit the menu.

The control panel is displayed on the monitor.
Even when the control panel is displayed on the

. . ) ; ‘D P
monitor, you can display the subject by pressing 0D 1/200 F5.6 +0.0
@=D. [ | PP R LTI 1]
+ Pressing the direct button displays the setting in L :::"6 nsmf:oo ) 'v'._‘f:
green on the control panel. Each setting can be F 2.0 g
made on the control panel by turning the control oavE (3 | Eg .
dial. & +3264x2448 |

For more details [=5"“Control panel
screen” (P.164)

» The subject is displayed on the monitor when using functions that use the

|3 . o )
o/ monitor, such as guideline shooting or panorama mode.

Note
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CONTROL PANEL — Using the monitor as a control panel

@ Control panel screen

l 18
0|0 F5|6 +0|0 19
2 e | 20

6 B Rz - 21

12

Sequential shooting 24

9 I rocus P-ARy, 150 100° W 0 \F.tbz
10—F-A10_on :z::%i:g-— 22
1 -F@RWE O BJEEE] —
12J = 3264x2448 '_c'ic-_‘:L’al—.||: 24
3 i |~ T—25
14 15 16 17
1| Battery check 14 | Sound record
2| Shooting mode 15 | Record mode/Resolution
3| Shutter speed 16 | Number of storable still pictures/
4| Aperture value Recording time
5 | Exposure compensation 17 |Memory gauge
6 | Noise reduction 18 | Exposure compensation
7| AE lock/AE memory 19|10
8 Spot metering/Mult-metering 20 | White balance compensation
Center-weighted metering 21| White balance
9 | Focus mode, P-AF 22 | Saturation/Sharpness/Hue/
10 | Flash mode Contrast
11 | Flash intensity control 23 | Scene modes

Folder number

13

25

Self-timer/Remote control

Selected card
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VOLUME - Adjusting the playback volume

You can adjust the volume of the sound when playing back a still picture or
movie. There are 5 levels to choose from.

Mode dial ) [>] SET UP

1

In the top menu, select MODE MENU >8>
VOLUME, and press @

Orin SET UP mode, select > {8 >
VOLUME, and press @

I “Menu basics” (P.38)

o Arrow pad
@ OK button

Press & & to select the volume level, then

press ®.

* Press (@ again to exit the menu.

 In SET UP mode, set the mode dial to a different
mode to exit the menu.

I
Selecting this level will mute
the sound completely.
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9 Camera Settings
Formatting cards

This function lets you format a card. Formatting prepares cards to receive data.
Before using non-Olympus cards or cards which have been formatted on a PC,
you must format them with this camera.

All data stored on the card, including protected pictures, is erased when
the card is formatted. When formatting a used card, confirm there are no
pictures that you still want to keep on the card.

Pl Als M EP X E AN

1 In the top menu, select MODE MENU >
CARD - CARD SETUP, and press §).
I=° “Menu basics” (P.38)

« PASM mP &) 4a % OY: The [T FORMAT
screen is displayed.
+ [=]: The CARD SETUP screen is displayed.

Arrow pad

OK button

2 Ifthe mode dialissettoP A S M @ &

A R ), press @ to select YES.

If the mode dial is set to =], press & to Al TR O

select FORMAT, then press &). The

FORMAT screen is displayed. Press & to [ no ]

select YES.
The card to be formatted is
displayed.

3 Press ®.
* The BUSY bar is displayed and the card is
formatted.

BUS Y Y

. * Do not perform any of the following actions during formatting as they may
&/ render the card unusable.
Note Open the card cover, remove the battery, connect or disconnect the AC
adapter (regardless of whether or not the battery is loaded in the
camera).
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Selecting a language for on-screen display

This function lets you select a language for on-screen display. This reference
manual shows the English on-screen display in illustrations and explanations.
Available languages vary depending on the area where you purchased this
camera.

Mode dial SET UP

1 Select SETUP > @£, then press .
[ “Menu basics” (P.38)

= Arrow pad
@ OK button

2 Press ®& to select a language, then

press ®.
| FRANCAIS |
| DEUTSCH |
| ESPANOL

SELECT# (5] GO»
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Setting the date and time

The date/time is saved with recorded pictures and file names are assigned
based on the date/time settings.

Mode dial SET UP

1 Select SETUP > @, then press .
I “Menu basics” (P.38)
* Press & repeatedly until @ is displayed on the
monitor.

Cad
a3\ \—— Arrow pad
@ OK button

&)

2 Press &®& to select one of the following

date formats: .

Y-M-D (Year/Month/Day), ¢ 2004.01.07
M-D-Y (Month/Day/Year), S ViauMiD
D-M-Y (Day/Month/Year). DREOL
Then press §. SELECTS () SET#[] GO#[OK]

* Move to the year setting.
» The following steps show the procedure used when the date and time settings
are set to Y-M-D.

3 Press ©& to set the year, then press @ to
move to the month setting. N
+ To move back to the previous setting, press @. € 2004.07.09
+ The first two digits of the year are fixed. 00200

SELECT® (/] SET#F] GO#[OK]

4 Repeat this procedure until the date and time are completely set.
* The time is displayed in the 24-hour format. For example, 2pm will be
displayed as 14:00.

5 Press ®.

» For a more accurate setting, press & when the time signal hits 00 seconds.

/' » The date and time settings will be returned to the factory default setting if the

\) camera is left without the battery for a few days. The settings will be

Note canceled more quickly if the battery was only loaded in the camera for a
short time before being removed. Check that the correct date and time have
been set before shooting.
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Setting the warning tone

You can select the volume of the beep sound used for warnings from OFF,
LOW, or HIGH. You can turn the sound off completely by setting OFF.

Mode dial SET UP

1 Select SETUP > m)) > OFF, LOW or HIGH,
and press ®.
[ “Menu basics” (P.38)

o Arrow pad
@ OK button

The camera automatically enters the sleep mode after being left unoperated for
a preset length of time. Press the shutter button or arrow pad to cancel the sleep
mode and reactivate the camera.

Mode dial SET UP

1 Select SETUP -> SLEEP TIMER - 30 SEC, 1
MIN, 3 MIN, 5 MIN or 10 MIN, and press ®.
I=° “Menu basics” (P.38)

The camera will not enter sleep mode when powered by the AC adapter.
In =] mode, the camera will enter sleep mode and the monitor will turn off
after 3 minutes of non-operation, regardless of the time set in the sleep
timer.

In slideshow mode, the camera will enter sleep mode and the monitor will
turn off after 30 minutes.

In shooting mode, when the powersaving mode is set to ON, the camera will
enter sleep mode and the viewfinder will turn off after 10 seconds,
regardless of the time set in the sleep timer.

S (=
.
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FILE NAME - Assigning a file name

The camera automatically creates file names and folder names for images to be
stored in. Files can be numbered from 0001 to 9999 and folders can be
numbered from 100 to 999. Examples are shown below.

Folder name File name
l l

\DCIM\I***OLYMPI\IPmdd****.jpg

T T
Folder No. Month (1-C) File No.
(100 - 999) (0001 - 9999)

Day (01 - 31)
* Month: Jan. - Sep.=1-9, Oct. = A, Nov. =B, Dec. =C

There are two settings from which you can choose: RESET or AUTO. Choose
the one that is best for you when transferring images to a PC.

File name settings

RESET The file number and folder number are reset every time a new card
is inserted in the camera. The folder number returns to No. 100
and the file number returns to No. 0001. This method is useful
when grouping files on separate cards.

AUTO Even if a new card is inserted, the folder number and file number
are retained from the previous card, so the same file number is not
used on different cards. This helps you to manage multiple cards.
This method is useful when you want to manage all your files with
sequential numbers.

Mode dial SET UP

1 Inthe top menu, select SETUP - FILE
NAME > RESET or AUTO, and press ®.
[ “Menu basics” (P.38)

Arrow pad

@ OK button

'\ * When the File No. reaches 9999, the file number returns to 0001 and the
R folder number changes.
Note When both the Folder and File No. reach their respective maximum number
(999/9999), the number of storable pictures becomes 0 even if the card is
not full. No more pictures can be taken. Replace the card with a new one.
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BATTERY SAVE

— Reducing battery consumption

This function reduces battery consumption by restricting the following camera
operations in the shooting mode.
* The monitor does not turn on when is pressed.
» The camera automatically enters sleep mode and the viewfinder turns off
after 10 seconds of non-operation.
‘nP® A N ) mode, the fastest shutter speed automatically selected
by the camera is 1/2000 sec.

Mode dial SET UP

1 Select SETUP > BATTERY SAVE - ON or
OFF, and press ®).

[ “Menu basics” (P.38)
* To enable the powersaving mode, select ON.

Cad
o\ \—— Arrow pad
@ OK button

&

171|

sBuipag eiswen E



sBuipyag eiswen !

PIXEL MAPPING - Checking the image

processing functions

The Pixel Mapping feature allows the camera to check and adjust the CCD and
image processing functions. It is not necessary to operate this function
frequently. Approximately once a year is recommended. Wait over a minute
after the monitor is used or continuous shots are taken to allow for proper
performance of the Pixel Mapping function.

Mode dial SET UP

1 Select SETUP - PIXEL MAPPING, and
press .
[ “Menu basics” (P.38)

» START appears.

O
o) o) ATTOW pa
OK button
2 Press ®.

* The BUSY bar is displayed during Pixel Mapping.

When Pixel Mapping is finished, the screen returns
to the SET UP mode menu.

BUSY )

@ * If you accidentally turn the camera off during Pixel Mapping, start again from

Step 1.
Note
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Adjusting the brightness of the monitor

and viewfinder

This function lets you adjust the brightness of the monitor and viewfinder.
The brightness of the monitor and viewfinder can be adjusted separately.

Mode dial SET UP

1 Select SETUP - 15!, and press ).

[ “Menu basics” (P.38)

Arrow pad

@ OK button

2 Press ®& to adjust the brightness of the
monitor or viewfinder, and when you have
set the desired level, press ®.

* Pressing & brightens the monitor or viewfinder,
and pressing & darkens it.

Measurement units

The measurement unit can be selected from either meters or feet in the manual
focus mode.

m At long ranges, the camera measures in meters, and at short ranges in
centimeters.
ft Atlong ranges, the camera measures in feet, and at short ranges in inches.

Mode dial SET UP

1 Select SETUP > m/ft > m or ft, and press ®.
I=° “Menu basics” (P.38)

sBuipag eiswen E
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VIDEO OUT - Setting the video signal type

You can select NTSC or PAL according to your TV’s video signal type. Select
the video signal type before connecting the AV cable. If you use the wrong video
signal type, you will not be able to play back the recorded pictures properly on
your TV.

Mode dial SET UP

1 Select SETUP - VIDEO OUT - NTSC or
PAL, and press ®.
[ “Menu basics” (P.38)

A
oK Arrow pad
@ OK button

&

A TIPS === === c e emsasasse s
¥ TV video signal types & main regions
Check the video signal type before connecting the camera to your TV.
NTSC North America, Japan, Taiwan, Korea
PAL European countries, China
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USB setup — Setting the connection destination

Before connecting the USB cable, set the camera to either PC or printer,
whichever you intend to connect the camera to.

PC Select when connecting the camera to a PC with the USB cable and
transferring pictures to the PC. For instructions on how to connect
the camera to your PC, refer to the “OPERATION MANUAL”
(DIGITAL CAMERA - PC CONNECTION).

PRINT Select when connecting the camera to a PictBridge-compatible
printer with the USB cable. Pictures can be printed directly without
using a PC. 5" “Connecting the camera to a printer” (P.187)

Mode dial SET UP

1 Select SETUP > USB - PC or PRINT, and
press ®.
[ “Menu basics” (P.38)

\—— Arrow pad

0K
” OK button
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10 Print setting (DPOF)

Print reservation allows you to save printing data (the number of prints and date/
time information) with the pictures stored on the card.

With print reservation, you can print out pictures easily either at home using a
personal DPOF-compatible printer or at a photo lab or a print shop that supports
DPOF.

DPOF is a standard format used to record automatic print information from
digital cameras. You can print out pictures automatically, at home or in a print
shop, by storing such data as which pictures you wish to print and the number
of prints on the card.

Pictures with print reservation data can be printed using the following
procedures.

Printing using a DPOF-compatible photo lab or print shop.
You can print the pictures using the print reservation data.
Printing using a DPOF-compatible printer.

Printing is possible directly from a card containing print reservation data without
using a PC. For more details, refer to the printer’s instruction manual. A PC card
adapter may also be necessary.
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How to print pictures

C TIPS === === c e emsaeasee s
Picture size and printing

The resolution of a computer/printer is generally based on the number of dots
(pixels) per square inch. This is called dpi (dots per inch). The higher the dpi
value, the better the printed results. Keep in mind, however, that the dpi of the
picture does not change. This means that when you print an image with a
higher resolution, the size of the printed picture will be smaller. Although you
can print magnified images, picture quality will decrease.

If you want to print large, high-quality pictures, set the record mode as high as
possible when taking the pictures. 15" “Record mode” (P.102)

DPOF reservations set by another device cannot be changed by this
camera. Make changes using the original device.

« If a card contains DPOF reservations set by another device, entering
reservations using this camera may overwrite the previous reservations.

If there is not enough space in the card memory, you may not be able to
enter the reservation data. CARD FULL will be displayed.

You can make DPOF print reservations for up to 999 images per card.
Even if an image appears with the message “PICTURE ERROR”, it may be
possible to make print reservations. In this case, the print reservation icon
(&) does not appear when the image is displayed for full view. [, appears
when multiple images are displayed (index display), allowing you to confirm
the print reservation.

Not all functions may be available on all printers, at all print shops, or at all
photo labs.

Some TIFF images cannot be printed.

Print reservation may take considerable time when saving printing data to a
card.

Print reservations cannot be made for images recorded in RAW data.

°

Note
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All-frame reservation

Use this feature to print all the pictures stored on the card. Select the desired
number of prints and whether you want the date and time included.

[ s> @

1 Play back a still picture. ., Print button
* You cannot make print reservations for pictures

with &.

Arrow pad

OK button

2 Press [[h. The [,PRINT ORDER screen

appears.
« If print reservation data is already stored on the L
card, the PRINT ORDER SETTING screen
appears, giving you the choice of resetting the data &
or keeping it

3 Press @& to select %, then press ®.

4 Press & to select [hx (number of prints) or @ (date/time),
then press @

5 Perform each setting as illustrated.
Select {hx.
94 COx (xo)~
@ca L D
0
@ ¢ o

SELECT® ] SET #[) GO »[OK]

B

Select @. SELECT» (5] GO »

0
g
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All-frame reservation

@ Set the number of prints

Press @& to set the desired number of prints, then press @®.
& : Increases the number.
& : Decreases the number.

@ Set the date/time printing data

Press & to select NO, DATE or TIME, then press &).

NO The pictures are printed without the date and time.

DATE All the pictures are printed with the shooting date.

TIME All the pictures are printed with the shooting time.

+ After completing the number of prints or the date/time printing data setting,
press @) to return to the playback screen.
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Single-frame reservation

Use this feature to print only selected pictures. Display the picture to be printed
and select the desired number of prints.

[ s> @

1 Play back a still picture. Control dial
* You cannot make print reservations for pictures Lk Print button

with &.

Arrow pad

a OK button

2 Press . The L;PRINT ORDER screen
appears.

« If there is a print reserved data on the card, the (="
PRINT ORDER SETTING screen appears, giving
you the choice of resetting the data or keeping it. D
3 Press @& to select [, then press ®. EXIT#[«] SELECT#E] GO#(OK]

4 select the frame you want to print using the
arrow pad or the control dial and press ®).

5 Select the appropriate item using the arrow
pad.

MORE Sets the number of prints, date/time
and trim size. The print reservation [ s .
data is set and the screen proceeds ?i -
to Step 6. Sile—frame rsvtin i

SINGLE PRINT Sets single-frame print. The date/ menu
time and trimming settings are not
available. — Step 9

CANCEL Cancels the print reservation for the displayed picture.

I “To reset the print reservation data for a selected
picture” (P.185)
END Completes the print reservation. — Step 11
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Single-frame reservation

6 Press @& to select [0,x (number of prints),

& (date/time) or = (trimming), then press §).

7 Perform each setting.

@ Set the number of prints

Press & & to set the desired number of prints, then
press ®.

& : Increases the number.

& : Decreases the number.

@ Set the date/time printing data
Press @& to select NO, DATE or TIME, then

press ®.
NO  The pictures are printed without the date and
time.

DATE All the selected pictures are printed with the
shooting date.

TIME All the selected pictures are printed with the
shooting time.

@ Trim the picture
= “Trimming” (P.182)

8 After completing all the print reservations,
press &) to complete the print reservations
and return to the screen in Step 4.

+ The 0, icon appears on the displayed picture.
* Repeat steps 4 to 8 to make print reservations for
other images.

9 Press @ to display the single-frame
reservation menu.

10 Press @ to select END.
+ The & PRINT ORDER screen appears.

11 Press @ again to display the [0, PRINT
ORDER SETTING screen, then press @ once
more to complete the print reservations.

".;’“@_.4-.-0 AR5, 30 )

40
SELECT# 650 =
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Trimming

This function enables you to crop part of a recorded picture and print out the
enlarged section only.

[ s> @

1

w

n

Press & & on the single-frame reservation screen to select =
(trimming) and press o).
[ “Single-frame reservation” (P.180)

« If timming has already been set, the J& screen
appears. Press & to select RESET, then
press ®.

Use the arrow pad, zoom lever, and control
dial to decide the trimming position and
size.

* Press @@@@ to select the trimming frame, and
press the zoom lever toward W or T to decide the
trimming size.

+ Use the control dial to select the height and width
of the trimming frame.

+ 3:2 trimming size can be selected when the size of
the selected picture is 3264 x 2448 or

3264 x 2176. o Arrow pad
=
a» OK button
Press ®).

Press © & to select OK, then press ®.

OK Saves the current trimming size and returns
to the single-frame reservation screen.

RESET Sets a new trimming size. — Step 2

CANCEL Cancels the current trimming setting and
returns to the single-frame reservation
screen.

Press (@ to complete the print reservations and return to the
picture selection screen. Press &) again.
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Trimming

6 Press (d to select END.

Py

e A
SINGLE PRINT,

+ The & PRINT ORDER screen appears.

* Press @ again to display the {h PRINT ORDER
SETTING screen, then press @ once more to
complete the print reservations.

Note

The size of the printed picture varies depending on the printer settings. If the
trimmed picture size is small, printing magnification increases accordingly,
resulting in a printed picture with lower resolution.

For best results with close-up prints, you are recommended to use the TIFF,
SHQ or HQ mode.

The original picture is not trimmed. If your printer does not have a trimming
feature, the picture will be printed untrimmed.

Do not rotate pictures that have been trimmed, otherwise the cropped area
will change.

183|

(40da) Bumes jurd E



(40da) Bumes juug E

Resetting print reservation data @

This function allows you to reset the print reservation data for pictures stored on
the card.
You can reset all the print reservation data or just for selected pictures.

@ Resetting all print reservation data

Mode dial ) [»>]

1 Press [. Control dial
- The & PRINT ORDER SETTING screen appears. h Print button

A
3 Arrow pad

@ OK button

2 Press ®& to select RESET, then press ®).

PRINT ORDERED
3 Press @ to exit the menu. EXIT*(4) SELECT® (] GO#[OK]
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Resetting print reservation data

@To reset the print reservation data for a selected picture

[ &

1 Press 0.

2 Press ®& to select KEEP and press ®.
« If there is no print reservation data stored on the

oL PRINT ORDER SETTING

card, the & PRINT ORDER SETTING screen does B NACEDERED
not appear. [ RESET |
[ EXTy (4 Lo GO» (0K |

3 Press & to select L, then press ®.

4 Select the frame for which you want to reset
the print reservation data using the arrow
pad or the control dial and press ®.

* The single-frame reservation menu is displayed.

5 Press & to select CANCEL.
» The print reservation data is canceled and the
screen returns to Step 4.
6 If you have finished canceling print
reservation data, press ®.
» The single-frame reservation menu is displayed.

7 Press (@ to select END.
* Press @ repeatedly to return to the playback screen.
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11 Direct printing (PictBridge)
Using the direct printing function

By connecting the camera to a PictBridge-compatible printer with the USB
cable, you can print out recorded pictures directly. With the camera connected
to the printer, select the pictures you want to print and the number of prints on
the camera’s monitor. It is also possible to print out pictures using the print
reservation data. B “Print setting (DPOF)” (P.176)

To find out if your printer is compatible with PictBridge, refer to the printer’s
instruction manual.

What is PictBridge? ... It is the standard for connecting digital cameras and
printers of different makers and printing out pictures directly.

L, STANDARD ... All printers that support PictBridge have standard print
settings. Selecting [0; STANDARD on the setting screens (I P.189 to 195),
images are printed according to these settings. See the instruction manual for
your printer for its standard settings or inquire of the printer manufacturers.

N You are recommended to use the optional AC adapter when printing
O pictures. If you use the battery, make sure that it is fully charged. If the
Note camera stops operating while communicating with the printer, the printer
may malfunction or image data may be lost.
» Images recorded in RAW data and movies cannot be printed.
* The camera will not enter sleep mode when connected to the USB cable.
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Connecting the camera to a printer

Use the USB cable provided to connect the camera to a PictBridge-compatible
printer.

1 Set the camera’s USB mode to PRINT.
[=¥” “USB setup — Setting the connection

destination” (P.175) [ PC ]
* Make sure the card containing the pictures you
want to print is selected.
CANCEL®(«] SELECT#[5} GO#(OK]

2 Turn the printer on and plug the printer end of
the USB cable into the printer’s USB port.
* For details of how to turn the printer on and the
position of the USB port, refer to the printer’s
instruction manual.

3 Set the camera’s mode dial to =] and
plug the USB cable into the camera’s
USB connector.

Connector cover
USB connector

4 Press the power switch to turn the camera
on.

* ONE MOMENT is displayed and the camera and
printer are connected. The PRINT MODE
SELECT screen is displayed on the monitor.
Make the print settings on the camera’s monitor.
Go to =¥ “Printing pictures” (P.188).

Q + If the screen is not displayed after a few minutes, turn off the camera and

start again from Step 1.
Note

(eBpugyold) Bunuud 30811 E
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Printing pictures

When the camera is connected correctly to a
PictBridge-compatible printer, the PRINT MODE

SELECT screen is displayed on the monitor. Use this
screen to select the print mode. You can choose from  MULTI PRINT
the following print modes. (ALL INDEX |

PRINT MODE SELECT
screen

PRINT Prints the selected picture.
=" “PRINT/MULTI PRINT” (P.190)
ALL PRINT Prints all the pictures stored on the card.

=" “ALL PRINT” (P.193)
MULTI PRINT Prints one picture in multiple layout format.
=" “PRINT/MULTI PRINT” (P.190)
ALL INDEX Prints an index of all the pictures stored on the card.
=" “ALL INDEX mode/PRINT ORDER mode” (P.195)
PRINT ORDER Prints the pictures according to the print reservation data on
the card. If no print reservations (P.176) have been made,
this option is not available.
=" “ALL INDEX mode/PRINT ORDER mode” (P.195)

PRINT modes and each setting
Available printing modes, paper sizes etc., vary depending on the printer
you use. Please consult with the services of your printer's manufacture or to
the printer manual.
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Printing pictures

Easy printing

The method described below is the easiest way to print out pictures. The
selected picture is printed without the date, time or file name.

1 Inthe PRINT MODE SELECT screen Control dial
(P.188), press & to select PRINT, Zoom lever
then press ®.

» The PRINT PAPER screen is displayed.

oK Arrow pad
€ OK button

L — J

2 Press ®& to select the paper size,
then press .

* When the PRINT PAPER screen is not displayed,
SIZE, BORDERLESS and PICS/SHEET are setto | ST )M~ )
L, STANDARD. — Go to Step 4.

PRINT PAPER [xD]

CANCEL® [JSELECT#(E}) GO # [OK]

3 Use @& to select framed or unframed,
then press ®.

-~
OFF ()  Theimageis printed inside a blank |1 4@RsThoim)

PRINT PAPER [xD]

frame.
ON ([]) The image is printed filling the entire
page.
4 Press @@ or turn the control dial to select o]

the picture you want to print and press ®. |
» The PRINT screen is displayed.

5 Press @& to select OK, then press ®.
* Printing starts.

+ To cancel printing, select CANCEL and press ®).
The PRINT MODE SELECT screen is displayed.
* When printing is finished, the screen returns to GEENGEN
Step 4. Repeat Steps 4 and 5 and print all the ||

pictures you want to print.
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Printing pictures

PRINT/MULTI PRINT

1 Inthe PRINT MODE SELECT screen, Control dial
press & to select PRINT or MULTI Zoom lever
PRINT, then press ®.

» The PRINT PAPER screen is displayed.

Arrow pad

OK button

2 Press ®%& to select the paper size,
then press .
* PRINT mode:

PRINT PAPER [xD]

— Goto Step 3. @D 1S
* MULTI PRINT mode:

> GotoStep 4. [caceLo stz GO K |
* When the PRINT PAPER screen is not displayed, Print mode screen

SIZE, BORDERLESS and PICS/SHEET are set to
4, STANDARD. — Go to Step 5.

3 Use @& to select framed or unframed,

PRINT PAPER [xD]

then press ®. > Go to step 5.
~
OFF ()  Theimageis printed inside a blank =0T 4@RSThoim)
frame.
ON ([]) The image is printed filling the entire
page.
4 Press ©& to select PICS/SHEET, then —
press ®.
» PICS/SHEET depends on the paper size set in
Step 2 and the capabilities of your printer. (:)4
5 Press @@ or turn the control dial to select o]
the picture you want to print. F
* Turn the zoom lever toward W to display the picture
in index format. You can then select the pictures
you want to print from the index.

SINGLE PRINT#() _ MORE #[] |
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Printing pictures

6 Select the print reservation method.
SINGLE PRINT Makes a single-frame print reservation for the selected picture
according to standard settings.
MORE Sets the number of prints of the selected picture in the print
reservation data. You can also add the date or file name, and
trim the picture.

@Set a SINGLE PRINT reservation

Press &. Print reservation mark is
displayed.

*+ Press & when the picture with [, is displayed to
cancel the reservation.

N .;F :
SELECT # () =
_CACEL # (]

@ Set MORE print reservations

® Press &.
» The Print information settings screen is displayed.

@ Press @& toselect the item you want to
set, then press 9.
+ Press & to select the item, then press &).

PRINT INFO [xDI

SEETY]_SET9b] GO0 |

O % Sets the number of prints. You can select up to 10
prints.

DATE (®) If you select WITH, pictures are printed with the date
and time.

FILE NAME (¢&]) If you select WITH, pictures are printed with the file
name.

= Crops part of a recorded picture so that only the

enlarged section is printed.
I “Trim the picture” (P.197)

» DATE and FILE NAME are not available in MULTI PRINT mode.
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Printing pictures

® When you have finished all the settings for MORE, press ®.
» The screen displayed in Step 5 appears.

+ To print more than one picture in PRINT and/or The settings you have
MULTI PRINT mode, repeat Steps 5 and 6 and r made are displayed.
make single and/or multiple print reservations for L
all the pictures you want to print.

- EH is displayed in MULTI PRINT mode.

BBl @] Jom:i0
e

L%

Sl FLE:100-0030
SELECT # () = PRINT # [OK
RUANGERS ]

7 Press ®.
* The PRINT screen is displayed.

8 Print the pictures.

PRINT [xD]
* Press & & to select OK or CANCEL, then
press ®.
oK Printing starts. | CANCEL |

CANCEL The settings are canceled and the

monitor returns to the PRINT
MODE SELECT screen.

* When printing is finished, the monitor returns to the
PRINT MODE SELECT screen.
I “Exiting direct printing” (P.198)

©

mn

CANCEL® [OK]

Data transfer screen

@To cancel printing

screen for selecting whether to continue or cancel

Pressing during print data transfer displays the
printing. To cancel printing, press && to select [ CONTINUE |
CANCEL, then press ®. —

| SELECT# [ GO #(0K] |
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Printing pictures

ALL PRINT

1

In the PRINT MODE SELECT screen, press
& to select ALL PRINT, then press ®).
» The PRINT PAPER screen is displayed.

Press & & to select the paper size, then
press §.
* When the PRINT PAPER screen is not displayed,

SIZE and BORDERLESS are set to [0; STANDARD.

— Go to Step 4.

Use & & to select framed or unframed,
then press ®.

OFF ([O]) The image is printed inside a blank
frame.

ON ([1]) The image is printed filling the entire
page.

* The PRINT INFO screen is displayed.

Press & & to select the item you want to
set, then press §).
+ Press & to select the item, then press &).
« If PRINT INFO cannot be set with your printer, go
to Step 6.
» Only one print can be made at a time.

DATE (&)
and time.
FILE NAME (¢&])
name.

PRINT MODE SELECT [xD]
N

ALL PRINT

EXIT#(«] SELECT#&] GO#[OK]

PRINT PAPER [xD]

(Cswommo )b~ )

CANCEL # (<] SELECT#E3) GO % [OK]

PRINT PAPER [xD]

-~
DA Ehsoseo

‘i

SELECT (5 GO (0K |

PRINT INFO [xD]

C =17 DT
(CoRTE Jpwmicor
(2102 L) DwaTrouT
C = bmo

SELECT#[] SET#[] GO*[OK]

If you select WITH, pictures are printed with the date

If you select WITH, pictures are printed with the file
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Printing pictures

5 Press ®.
* The PRINT screen is displayed.

6 Print the pictures.

PRINT [xD]
* Press & & to select OK or CANCEL, then
press ®.
OK Printing starts. | CANCEL

CANCEL The §ettings are canceled and the
monitor returns to the PRINT MODE

SELECT screen.

* When printing is finished, the monitor returns to the
PRINT MODE SELECT screen.
I “Exiting direct printing” (P.198)

mn

CANCEL® [OK]

Data transfer screen

©

@To cancel printing

screen for selecting whether to continue or cancel

Pressing during print data transfer displays the
printing. To cancel printing, press && to select [ CONTINUE |
CANCEL, then press ®. —

| SELECT# [ GO #(0K] |
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Printing pictures

ALL INDEX mode/PRINT ORDER mode

1

In the PRINT MODE SELECT screen, press
D to select ALL INDEX or PRINT
ORDER, then press ®.

» The PRINT PAPER screen is displayed.

Press & & to select the paper size, then

press §.

* When the PRINT PAPER screen is not displayed,
SIZE and BORDERLESS are set to [,
STANDARD. — Go to Step 4.

Use & & to select framed or unframed,

then press ®.

OFF ([O]) The image is printed inside a blank

frame.

ON ([]) The image is printed filling the entire

page.

* The PRINT screen is displayed.
+ BORDERLESS is notavailable in ALL INDEX mode.
Press & and go to Step 4.

Print the pictures.

* Press & & to select OK or CANCEL, then

press ®.

OK Printing starts.

CANCEL The settings are canceled and the
monitor returns to the PRINT MODE
SELECT screen.

* When printing is finished, the monitor returns to the
PRINT MODE SELECT screen.
I “Exiting direct printing” (P.198)

PRINT MODE SELECT [xD]

it

| ALL INDEX
EXIT#(«] SELECT#&] GO#[OK]

PRINT PAPER [xD]

(@ =TT SRS

CANCEL ® («JSELECT# &) GO % [OK]

PRINT PAPER [xD]

-~

CELT DG s
v

SELECT» €5 GO # [OK]

PRINT [xD]

| CANCEL

CANCEL® (<] SELECT# £} GO % [OK]

et

CANCEL® [OK]

Data transfer screen
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Printing pictures

@ To cancel printing

Pressing @) during print data transfer displays the
screen for selecting whether to continue or cancel
printing. To cancel printing, press & & to select [ CONTINUE |

CANCEL, then press ®.
[ser+3  GosoK |
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Printing pictures

Trim the picture

To set trimming by MORE in PRINT or MULTI PRINT mode, follow the
procedure below.

1 Use the arrow pad and zoom lever to select Control dial
the trimming position and size.

* Press @@@@ to select the trimming frame, and
turn the zoom lever toward W or T to decide the
trimming size.

Use the control dial to select the height and width
of the trimming frame.

3:2 trimming size can be selected when the size of
the selected picture is 3264 x 2448 or

3264 x 2176.

If trimming has already been set, the J= screen
appears. Press & to select RESET, then
press ®.

2 Press ®.

Zoom lever

Arrow pad

oK
Q” OK button

(i

3 Press @& to select OK, then press ®.

OK Saves the current trimming size.
RESET Sets a new trimming size.

— Repeat the procedure from Step 1.
CANCEL Cancels the current trimming setting.

* Press @ to complete trimming setting and return
to the PRINT INFO screen.

+ The size of the printed picture varies depending on the printer settings. If the
@ trimmed picture size is small, printing magnification increases accordingly,
resulting in a printed picture with lower resolution.
* For best results with close-up prints, you are recommended to use the TIFF,
SHQ or HQ mode.

Note
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Exiting direct printing

When you have finished printing, disconnect the camera from the printer.

1 Inthe PRINT MODE SELECT screen,
press @.
LI AN
 WLTL AT
[ ALL moex]

* A message is displayed.

TURN OFF THE POWER

2 Press the power switch to turn the camera Power switch
off.

3 Remove the USB cable from the
camera.

4 Remove the USB cable from the
printer.
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If an error code is displayed

If an error code appears on the camera’s monitor during direct print setting or
printing, see the following table.
For more details, refer to the printer’s instruction manual.

Monitor indication

Possible cause

Corrective action

(O

NO CONNECTION

The camera is not
connected to the printer
correctly.

Disconnect the camera and
connect it again correctly.

=+

There is no paper in the
printer.

Load some paper in the
printer.

NO PAPER
The printer has run out of |Replace the ink cartridge in
ink. the printer.
NO INK
8/\/ The paper is jammed. Remove the jammed paper.
JAMMED

SETTINGS CHANGED

The printer's paper
cassette has been
removed or the printer has
been manipulated while
making settings on the
camera.

Do not manipulate the
printer while making settings
on the camera.

PRINT ERROR

There is a problem with
the printer and/or camera.

Turn off the camera and
printer. Check the printer
and remedy any problems
before turning the power on
again.

TIPS

codes” (P.200).

+ If an error code other than those shown above is displayed, refer to “Error
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Miscellaneous

Error codes

) Mpnltpr Possible cause Corrective action
indication
The card is not inserted, Insert a card or insert a different
or it cannot be recognized. card.
If the problem persists, format the
NO CARD card. If the card cannot be
formatted, it cannot be used.
There is a problem with the card. | This card cannot be used. Inserta
new card.
CARD
ERROR
Writing to the card is prohibited. The recorded image has been
IB protected (read-only) on a PC.
WRITE- Download the image to a PC and
PROTECT cancel the read-only setting.
The card is full. Replace the card or erase
IB No more pictures, movies or unwanted pictures. Before
CARD FULL | information such as print erasing, download important
reservations can be recorded. images to a PC.
- There are no pictures on the card. | The card contains no pictures.
[ Record pictures.
NO PICTURE

(N

There is a problem with the
selected picture and it cannot be

Use image processing software to
view the picture on a PC. If that

PICTURE played back on this camera. cannot be done, the image file is
ERROR damaged.
The card cover is open. Close the card cover.
CARD COVER
OPEN

POWER OFF

SELECT 5] GO/

The card is not formatted.

Format the card.
All data on the card will be
deleted.

FILE SIZE
SELECTED TOO
LARGE

Files with a volume of 57 MB or
over (movies of over approx. 64
sec. (SHQ), 70 sec. (HQ) or 685
sec. (SQ)) cannot be copied.

Avoid selecting movies of the type
listed left for copying.
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Troubleshooting

@ Preparatory operations

Possible cause

‘ Ref. page

‘ Corrective action

The camera does not turn on or function buttons do not respond.
The power is off. Press the power switch to turn the camera on. P.25
The battery is Charge the battery. P17
exhausted.
The battery is Warm the battery by putting it in your pocket for a —
temporarily unable to | while.
function because of
the cold.
The camerais in the | Operate the camera (press the shutter button or P.26
sleep mode. the zoom lever).
The camera is The camera will not operate while it is connected to —
connected to a PC. aPC.
@ Shooting
Possible cause ‘ Corrective action ‘ Ref. page
No picture is taken when the shutter button is pressed.
The battery is Charge the battery. P17
exhausted.
The camera is in the | Set the mode dial to any position except [>]. P.50
playback mode.
The flash has not Remove your finger from the shutter button, and P.50, 60
finished charging. wait until i stops blinking. Press the shutter button
again.
The card is full. Erase unwanted pictures or insert a new card. P.143
Before erasing, download important images to a
PC.
The battery ran out of | Charge the battery. (Wait until the card access P17
power during lamp turns off when flashing.)
shooting or while the
images were being
written to the card.
(The battery check
indicator only blinks.)
The memory gauge is | Wait until there is room in the memory gauge. P.14
full.
There is a problem Refer to “Error codes”. P.200
with the card.
The viewfinder does not turn on.
The monitor is turned | Press to turn the viewfinder on. P.50
on.
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Troubleshooting

Possible cause ‘ Corrective action ‘ Ref. page
The monitor does not turn on.

The viewfinder is Press to turn the monitor on. P.50
turned on.

The viewfinder or monitor is hard to see.

The diopter is not Adjust the diopter so that the AF target mark is P.27

adjusted properly.

clearly visible.

There is
condensation inside
the camera.

Wait until the camera dries before turning it on
again.

* Condensation: When it is cold outside, the water vapor in the air is rapidly cooled and
turns to droplets of water.
Condensation occurs when the camera is suddenly taken from a cold

place into a warm room.
The brightness of the | Select 153} in the SETUP tab and adjust the P173
viewfinder or monitor | brightness.
is not adjusted
properly.
The monitor is Position the monitor in the down position or block —
exposed to direct the sunlight with your hand.
sunlight.
Vertical lines appear | Aiming the camera at a bright subject in sunlight —
in the viewfinder oron | may cause vertical lines to appear on the screen.
the monitor screen This is not a malfunction.
during shooting.
The date recorded with the image data is wrong.
The date/time is not | Set the date/time. The clock adjustment is not P.168
set. factory-preset.
The camera has been | If the camera is left for a few days with the battery | P.18, 168

left with the battery
removed.

removed, the date/time setting is canceled. Set the
date/time again.

The settings are returned to the factory default settings when the camera is

turned off.
ALL RESET is setto | Set ALL RESET in the & tab to OFF. P.145
ON.
The picture is out of focus.
The subject is too Position the camera more than 0.2 m/0.7 ft. from P.87, 88
close. the subject and take the picture. To take pictures

closer than 0.2 m/0.7 ft., use the super macro

mode.
Auto focus is not Use manual focus or focus lock to focus on the P.53, 79
possible. subject and then shoot.
The subject is dark. Turn the AF illuminator on. P.78

Thereis condensation”
on the lens.

Wait until the camera dries before turning it on
again.
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Troubleshooting

Possible cause ‘ Corrective action ‘ Ref. page
The monitor goes off.
The camerais in the | Operate the camera (press the shutter button or P.26
sleep mode. the zoom lever).
The power is turned | If ALL RESET in the 18 tab is set to OFF, the P.50, 145
off with the monitor camera settings before the power was turned off
off. remain unchanged.
Turn on the monitor, and turn off the power.
The flash does not fire.
The flash is closed. Press the flash pop-up button to make the flash P.59
pop up.
The flash is set to the | Select a flash mode other than ). P.59
flash off mode.
The subject is If you want the flash to fire on a brightly illuminated P.59
illuminated. subject, set the flash to .
Sequential shooting | The flash does not fire in the sequential shooting P.92
(HI, =, AF, | mode.
BKT) is set. Set [J in the &=y menu.
The camerais in the | The flash does not fire in the & mode. Set a P.55
movie mode. different shooting mode.
Super macro mode is | The flash does not fire in the super macro mode. P.88
set. Cancel the super macro mode.
Panorama mode is The flash does not fire in the panorama mode. P.95
set. Cancel the panorama mode.
The battery run time is brief.
You are using the Battery performance deteriorates in low —
camera in a cold temperatures. Keep the camera warm by putting it
environment. inside your coat or clothing.
The remaining battery | When battery consumption fluctuates P.14,17
power is notindicated | considerably, the camera may turn off without
correctly. displaying the battery warning indicator. Charge
the battery.

203 I




Troubleshooting

@Playback
Possible cause ‘ Corrective action ‘ Ref. page
The picture is out of focus.
A subject unsuited to | Use manual focus or focus lock to focus on the P.53,79
AF was taken subject and then shoot.
The camera moved Hold the camera correctly and press the shutter P.28
when the shutter button gently.
button was pressed.
The flash was closed | Press the flash pop-up button to make the flash P.59
orwas set to the flash | pop up and select a flash mode other than ().
off mode in a lighting | Camera movement occurs easily with slower
condition requiring shutter speeds. Use a tripod, or set the flash to
use of the flash. AUTO.
The lens was dirty. Clean the lens. Use a commercially available P.219
blower blush and then wipe with a lens cleaner to
remove dust. Mold may form on the lens surface if
the lens is left dirty.
The picture is too bright.
The flash was setto | Select a flash mode other than . P.59
the ¥ mode.
The center of the If the center of the subject is too dark, the P.108
subject is too dark. surrounding area emerges as too bright. Adjust the
exposure compensation toward minus (-).
The ISO is at a high | Set the ISO to AUTO or to a low sensitivity: 50 P.107
setting.
The aperture value is | Increase the aperture value or set the camera to P P.70
smallin A (M) mode. | mode.
The shutter speed Increase the shutter speed or set the camera to P P.71
setting is too slow in | mode.
S (M) mode.
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Troubleshooting

Possible cause ‘ Corrective action ‘ Ref. page
The picture is too dark.
The flash was blocked | Hold the camera correctly, keeping your fingers P.28
by your finger. away from the flash.
The subject was out | Shoot within the flash working range. P.59
of the working range
of the flash.
The flash was closed | Press the flash pop-up button to make the flash P.59
or was set to the ® pop up and select a flash mode other than ).
mode.
The subject was too | Set the flash mode to €, or use the spot metering P.59, 81
small and was backlit. | mode.
The sequential Higher shutter speeds are used when the P.92
shooting mode was sequential shooting mode is selected, which may
used. result in pictures that are darker than usual. Set (3]
in the sequential shooting menu.
The center of the If the center of the subject is too bright, the image P.108
subject is too bright. | as a whole emerges darker. Adjust the exposure
compensation toward plus (+).
The aperture value Decrease the aperture value or set the camera to P.70
setting is too highin | P mode.
A (M) mode.
The shutter speed Reduce the shutter speed or set the camera to P P.71
setting is too fast in mode.
S (M) mode.
The colors of pictures look unnatural.
Indoor lighting can Set the white balance according to the lighting. P.109
affect the picture’s
colors.
No white in the Include something white in the picture, or set the P.59
picture. flash mode to i
The white balance Adjust the white balance according to the light P.109
setting is wrong. source.
Filter was used. The image may be discolored according to the filter P.111
used. Use the one-touch white balance function.
Part of the picture is too dark
The lens was partly Hold the camera correctly, keeping your fingers P.28
blocked by your finger | and the strap away from the lens.
or the strap.
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Troubleshooting

Possible cause ‘ Corrective action ‘ Ref. page

Halation produces unnatural colors in the picture.

This may be caused |+ Use a UV filter. As this may upset the overall —

by excessively bright color balance, it should only be used in the

ultraviolet light on the conditions described on the left.

subject, such as * Process the picture using a graphics application

sunlight shining (Photoshop, Paint Shop Pro, etc.). For example,

through the leaves of after picking up unnatural colors with a syringe

trees, window frames tool, etc. you can select color areas, and try color

in bright light at night, conversion or saturation adjustment. For details,

reflection of metal in refer to the manual for the graphics application

direct sunlight, etc. you are using.

Pictures you have taken do not appear on the monitor.

The power is off. Set the mode dial to [>] before pressing the power P.121
switch to turn the camera on.

The camerais in the | Press the QUICK VIEW button or setthe mode dial | P.121, 122

shooting mode. to [=].

There are no pictures | NO PICTURE appears on the monitor. Record —

on the card. pictures.

There is a problem Refer to “Error codes”. P.200

with the card.

The camera is The monitor does not function when the AV cable P.134

connected toa TV. is connected to the camera.

Single-frame erase and all-frame erase cannot be performed.

The pictures are Display pictures with [0m] and press O button to P.142

protected. cancel protection.

No picture is displayed on the TV when connected to the camera.

The video output Set the video output signal according to the region P.174

signal is incorrect. where used.

The TV video signal | Set the TV to the video input mode. P.134

setting is incorrect.

The viewfinder or monitor is hard to see.

The brightness of the | Select 153} in the SETUP tab and adjust the P173

viewfinder or monitor | brightness.

is not adjusted

properly.

The monitor is Position the monitor in the down position or block —

exposed to direct the sunlight with your hand.

sunlight.

lllustrations and explanations are not displayed in English.

Alanguage otherthan | Select English for on-screen display. P.167

English has been

selected for on-

screen display.
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Troubleshooting

@ Connection to

a PC or Printer

Possible cause ‘ Corrective action ‘ Ref. page
The camera is not recognized by the PC.
The USB driver is not | Itis necessary to install the USB driver for Windows —
installed. 98/98SE. For installation instructions, see

“OPERATION MANUAL” (Digital camera — PC

connection) on the CD-ROM.
The camera has not | Press the power switch to turn the camera on. P.25
been turned on.
The printeris selected | Set the USB option in the SETUP tab to PC. P.175
as the connection
destination.
The camera cannot be connected to the printer.
PC is selected as the | Set the USB option in the SETUP tab to ;. P.175
connection
destination.
The camera or printer | Turn the camera or printer on. P.187
has not been turned
on.
The printer does not | Refer to the printer’s instruction manual or contact —
support PictBridge. the manufacturer.
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List of menus

The shooting mode menus and playback menus for still pictures and movies are
shown below.

OP. A, S, M, &7, ®], Aa, %, ) mode

. . Ref.
Top menu » Tab » Function » Sub-menu » Setting page
MODE MENU || CAMERA|[FLASH MODE FLASH MODE AUTO, ®©@, ¥, P.59

¥SLow, @
[53 |[-2.0t0 +2.0 | P.e4
=M FLASH IN+% =% SLAVE | P.66,
69
¥sLow SLOW1, <@ % SLOW, | P.63
sLow?2
AF/&/MF FOCUS MODE AF, &, MF, %, WMF | P.79,
87, 88
[AF MODE |iEsP.® | P74
[FULLTIMEAF _ |[OFF, ON | P75
[P-AF |[oFF. oN | P76
ESP/I3) ESP, (3, L) MULTI, | P.81
[©)
s O HIE, P.92
0y, AFC, BKT
O/ OFF, ®, & P.89,
90
[1Is0 |AuTO, 50t0400 | P.107
[DIGITAL ZOOM |[oFF. oN | P58
[NOISE REDUCTION "2 |[oFF. oN |P118
FUNCTION OFF, PANORAMA, | P.95,
ED, BLACK & WHITE, | 97, 98
SEPIA
[FRAME ASSIST |[oFF. oN | o9
@ |[oFF, oN | P100
MY MODE "3 MY MODE 1 to P.73
MY MODE 8
OFF, E4ON, ON, P.119
DIRECT
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List of menus
PICTURE|[WB AUTO Wez7, SET P.109,
112,
113
PRESET 1 PRESET 1, @8%, SET| P.110,
112,
113
PRESET 2 PRESET 2, @8%, SET| P.110,
112,
113
CUSTOM |[cusTOM 1o CUSTOM 4] P.111
=) GO, ADJUST, SET | P11,
112,
113
P RAW OFF, SHQ, HQ, SQ1, | P.103,
sQ2 105,
106
TIFF 3264 x 2448/ P.102,
3264 x 2176 (3:2)/ 105
2592 x 1944/
2288 x 1712/
2048 x 1536/
1600 x 1200/
1280 x 960/
1024 x 768/
640 x 480
SHQ 3264 x 2448/ P.102,
3264 x 2176 (3:2) 105
HQ 3264 x 2448/ P.102,
3264 x 2176 (3:2) 105
sQ1 2592 x 1944/ P.102,
2288 x 1712/ 105
2048 x 1536
sQ2 1600 x 1200/ P.102,
1280 x 960/ 105
1024 x 768/
640 x 480
‘SCENE MODES 2 HNORMAL, N & ‘ P.117
[SHARPNESS |-5to+5 | P114
[CONTRAST |-5to+5 | P115
[HUE |[-5to+5 | P16
[SATURATION |[-5to+5 | P117
CARD  |[CARD SETUP | FORMAT, CANCEL | P.166
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List of menus
78 |[ALLRESET™ |[oFF. oN | P.145
‘REC VIEW H OFF, AUTO, 3 SEC, ‘ P.147
5 SEC, 10 SEC
[BEEP |[oFF. 1,2 | P.148
[SHUTTER SOUND |[OFF. 1, 2 | P.149
‘DIAL NORMAL, CUSTOM 1 ‘ P.150
to CUSTOM 3
[EV STEP |[1/3EV, 1/2EV | P153
[CUSTOM BUTTON | P.154
[SHORT CUT | P57
‘MY MODE SETUP H CURRENT H MY MODE 1 to ‘ P.160,
MY MODE 8 161
‘RESET H MY MODE 1 to ‘ P.160,
MY MODE 8 162
‘CUSTOM H MY MODE 1 to ‘ P.160,
MY MODE 8 162
CONTROL PANEL |[oFF. oN | P.163
="K | Po2
[1s0)" | P107
[(DIGITAL ZOOM) 5 | P58

*1 Cannot be selected in %) mode.

*2 Cannot be selected in ] Aa & €Y mode.

*3 Can be selected only in &P mode.

*4 Cannot be selected in @? mode.

*5 The function registered in the shortcut menu is displayed.
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List of menus
@ X mode
Top menu » Tab » Function » Sub-menu » Setting E:;e
‘MODE MENU ‘ CAMERA ‘AF/&/MF H FOCUS MODE HAF, v Y 5.779,
[FULLTIME AF |[OFF, ON | P75
ESP/(3] ESP, (<], C<J MULTI, | P.81
| E |
O/k H OFF, O, & P.89,
2
‘FUNCTION ‘ OFF,BLACK&WHITE,‘ P.98
SEPIA
[FRAME ASSIST |[OFF, ON | P.99
PICTURE|[WB AUTO WBZ, SET P.109,
s
PRESET 1 PRESET 1, WB%, SET| P.110,
s
PRESET 2 PRESET 2, WB%, SET| P.110,
s
[CUSTOM |[CUSTOM 1to CUSTOM 4] P.111
) GO, ADJUST, SET | P11,
12,
13
[€ |[SHQ, HQ, sQ | P.105
[SCENE MODES |[NORMAL, &N, M. & | P17
[SHARPNESS |[-5to +5 | P.114
[CONTRAST |[-5to+5 | P15
[HUE |[-5to+5 | P16
[SATURATION |[-5to +5 | P17
[CARD  |[CARD SETUP |[FORMAT, CANCEL | P.166
18 |[ALLRESET |[OFF, ON | P.145
‘REC VIEW ‘ OFF, AUTO, 3 SEC, ‘ P.147
5 SEC, 10 SEC
[BEEP |[OFF, 1,2 | P.148
‘DIAL HNORMAL, CUSTOM 1 ‘ P.150
to CUSTOM 3
[EVSTEP |[1/3EV, 1/2EV | P.153
[CUSTOM BUTTON | P.154
[CONTROL PANEL |[OFF, ON | P.163
[ |[OFF, ON | P101
[iso |[AUTO, 50 to 100 | P.107
[DIGITAL ZOOM |[OFF, ON | P.58
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List of menus

@Playback mode (still pictures)

Top menu » Tab » Function » Sub-menu » Setting s:;é
MODE MENU |EDIT ~ |[RAWDATAEDIT | < |[TIFF, sHQ, Ha, 51, SQ2| P.140
[ |-5to+5 | P.140
‘ wB HAUTO, PRESET 1, P.140
PRESET 2, CUSTOM, O
[=7] |RED7toBLUE7 | P.140
[SCENE MODES  |[NORMAL, @, @. @ | P.140
[SHARPNESS |-5to+5 | P.140
[CONTRAST |-5to+5 | P.140
[HUE |-5to+5 | P.140
[SATURATION |-5to+5 | P.140
‘FUNCTION HOFF, BLACK&WHITE,‘ P.140
SEPIA
F= | P.140
‘E H640><480, ‘P.138
320 x 240, CANCEL
[ |[NEW FILE, CANCEL | P.139
[copY |[ALL, SELECT | P11
‘CARD HCARD SETUP HALL ERASE, FORMAT‘ 1P.61ét4,
78 |[ALLRESET |[oFF, oN | P.145
[BEEP |[oFF. 1,2 | P.148
[VOLUME otos | P.165
= 49,16 | 126
= | P127
[=] |[oFF, oN | P.136
(& |[oFF. oN | P137




List of menus
@Playback mode (movies)
Top menu » Tab » Function » Sub-menu » Setting 4 5:;9
‘MODE MENU H CARD HCARD SETUP HALL ERASE, ‘ P.144,
FORMAT 166
78 |[ALLRESET |[oFF. oN | P.145
[BEEP |[oFF. 1,2 | P.148
[VOLUME Jotos | P.165
(= 4.9, 16 | P-126
MOVIE PLAY H MOVIE PLAYBACK, ‘ P.128
INDEX, EDIT
[copY |[ALL, SELECT | P11
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List of menus

@ SET UP mode

Top menu » Tab » Function » Sub-menu » Setting Ref,
page
78 |[ALLRESET ||oFF, oN | P.145
REC VIEW OFF, AUTO, 3 SEC, | P.147
‘ HSSEC, 10 SEC ‘
[BEEP |[oFF. 1,2 | P.148
[SHUTTER SOUND |oFF, 1,2 | P.149
DIAL NORMAL, CUSTOM 1] P.150
‘ to CUSTOM 3 ‘
[EV STEP [[1/3EV, 1/2EV | P153
[CUSTOM BUTTON | P.154
[SHORT cuT | P57
‘MY MODE SETUP H RESET H MY MODE 1 to ‘ P.160,
MY MODE 8 162
‘CUSTOM H MY MODE 1 to ‘ P.160,
MY MODE 8 162
[CONTROL PANEL | oFF, oN | P.163
[VOLUME |otos | P.165
= [4.9,16 | P.126
SETUP |[@2 ENGLISH, FRANCAIS,| P.167
DEUTSCH, ESPANOL,
ITALIANO, PYCCKWW,
PORTUGUES, B #:E
[© | P.168
[m) |[OFF, LOW, HIGH | P.169
‘SLEEP Hso SEC, 1 MIN, 3 MIN ‘ P.169
5 MIN, 10 MIN
[FILE NAME | RESET, AUTO | 170
[BATTERY SAVE | oFF, oN | P71
[PIXEL MAPPING | sTART | P72
=] | P73
[mift [m. ft | P73
[VIDEO OuT |[INTSC, PAL | P74
[AF ILLUMINATOR ||oFF, oN | P78
[usB |[PC. PRINT | 175
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List of factory default settings

The menu functions are set to the following default settings at the time of

purchase.

Shooting mode

FNo. F2.4 NOISE REDUCTION | OFF ([®): fixed on ON)
Program shift RESET FUNCTION OFF

SHUTTER 1/1000 FRAME ASSIST OFF

Zoom 28mm (U] OFF

LCD/EVF LCD @ (movie) ON

CARD XD HISTOGRAM OFF

0.0 Histogram Center

FLASH AUTO target mark

(8. M: 3SLOW, @ ®)| [y moDE MY MODE 1

b 0.0 wB AUTO

FLASH IN+Ry WBY] None

SLAVE 1 CUSTOM WB Not Registered
¥sLow FSLOW1 € HQ (3264 x 2448,
AFINF AF & 320 x 240)

AF target mark Center JPEG OFF

AF MODE iESP TIFF 3264 x 2448
FULLTIME AF OFF SHQ 3264 x 2448

P-AF ON HQ 3264 x 2448
ESP/(®) ESP sQ1 2048 x 1536 NORMAL
Metering target Center SQ2 640 x 480 NORMAL
=y O SCENE MODES NORMAL

BKT +1.0, 3 pictures SHARPNESS +0

O/ OFF CONTRAST +0

1SO AUTO (A, S, M: 50) HUE +0

DIGITAL ZOOM OFF SATURATION +0
Playback mode

INFO OFF [=1] OFF

On OFF 0] OFF

& 0° COPY ALL

0 OFF
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List of factory default settings

SETUP
ALL RESET ON es ENGLISH
REC VIEW ON =) Y-M-D 2004/01/01 00:00
BEEP 1-LOW ») Low
SHUTTER SOUND | 1-LOW SLEEP 3MIN
DIAL NORMAL FILE NAME AUTO
EV STEP 1/3EV BATTERY SAVE OFF
CUSTOM BUTTON | ISO =] NORMAL
SHORT CUT A: Oy, B: I1SO mift m

C: DIGITAL ZOOM VIDEO OUT NTSC or PAL®

CONTROL PANEL OFF AF ILLUMINATOR | ON
VOLUME 3 uUsB PC
=2 9

* Setting differ according to the region where the camera is sold.
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List of items by shooting mode

In @? mode, available functions vary depending on the modes set in the MY
MODE SETUP menu.

Mode
P A S M 2 "] x

Function

Zoom

DIGITAL ZOOM
AF MODE
FULLTIME AF
P-AF

AF target mark

NNANENENENENEN

Manual focus
AUTO v — v —
©
% v — v —
$sLow1
@ %SLow v — v —
$sLowz
®

\
|
<
|

Flash
<
|

3%
FsLow
)

=

CJ MULTI v
(O]

Metering target
AE LOCK v
¥

2
SWMF
V)

AN ANENENENEN
|

|
<
|

<

\
|

|
<
|

NEARYAYRIA

T |=

=, O, AF
KT v
PANORAMA

[=2]

BLACK & WHITE
SEPIA

FRAME ASSIST
Histgram target mark

0

@
|
<
|

FUNCTION

NENENENEN ENENEN

@ (still picture)
& (movie) — v
<€:- v




List of items by shooting mode

Mode
P A S M V" s ) x
Function
1SO

E v
wB

WEY)
CUSTOM WB
SHARPNESS
CONTRAST
HUE
SATURATION
SCENE MODES v — | ~
NOISE REDUCTION v —

ALL RESET V2

REC VIEW

BEEP

SHUTTER SOUND
DIAL

EV STEP
CUSTOM BUTTON
SHORT CUT

MY MODE
CONTROL PANEL

<

|
<

NNANENENENENEN

NNENESENENENENENEN

v: Available — : Not available

*1 Cannot be selected in (&) mode
*2 Cannot be selected in @ mode
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Camera maintenance

@ After use

Turn off the camera, detach the lens hood, and then fit the lens cap on the lens.
If you do not intend to use the camera for a long period, remove the battery.

@_Cleaning the camera
1 Turn off the camera. (I P.25)
2 Remove the battery (I°P.18). (If you are using an AC adapter,

unplug the AC adapter from the camera first before removing the
plug from the AC outlet.)

3 Exterior:

— Wipe gently with a soft cloth. If the camera is very dirty, soak the cloth in mild
soapy water and wring well. Wipe the camera with the damp cloth and then
dry it with a dry cloth. If you have used the camera at the beach, use a cloth
soaked in clean water and well wrung.

Monitor and viewfinder:

— Wipe gently with a soft cloth.

Lens

— Blow dust off the lens with a commercially available blower, then wipe gently
with a lens cleaner.

Card
— Wipe gently with a soft, dry cloth.

@ Storage

» When storing the camera for extended periods, remove the battery and the
card, and keep in a cool, dry place that is ventilated well.

+ Periodically, replace the battery, and test camera functions.

D Do not use strong solvents such as benzene or alcohol, or chemically
: treated cloth.
Note

+ Cleaning should be done only after the battery has been removed or the AC
adapter has been disconnected.

Mold may form on the lens surface if the lens is left dirty.

Avoid leaving the camera in places where chemical products are handled
since this may result in corrosion.
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Camera maintenance

How to replace the battery (CR2025) of the remote control
device

1 Turn the screw on the bottom of the
remote control device counterclockwise
to loosen.

2 Turn the remote control device over, and
remove the cover. Remove the old battery
and insert a new battery (CR2025) with the
battery facing up as shown.

3 Replace the cover, turn the remote control
device over, and turn the screw on the
bottom clockwise to tighten.

@ » Do not apply excessive force to the remote control device.
Nete » Never heat the remote control device or dispose of it in fire.
» The working temperature range for the remote control device is —10°C to
40°C (14°F to 104°F).
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Specifications

Product type
Recording system
Still picture

Applicable
standards

Sound with still
pictures

Movie
Memory

Recording image
resolution

No. of storable pictures
When a 32 MB card is

used (without sound)

No. of effective pixels
Image pickup device
Lens

Photometric system

Aperture
Shutter speed
Shooting range

Viewfinder
Monitor

. Approx.

(DCF)), RAW Data

: Digital camera (for shooting and displaying)

Image Matching Il, PictBridge

. Wave format

Microdrive

. QuickTime Motion JPEG support
: xD-Picture Card (16-512MB), CompactFlash,

*340 MB Microdrive cannot be used.

1 3264 x 2448 pixels

3264 x 2176 pixels
2592 x 1944 pixels
2288 x 1712 pixels
2048 x 1536 pixels
1600 x 1200 pixels
1280 x 960 pixels
1024 x 768 pixels
640 x 480 pixels

2 frames

1 frames

8 frames
16 frames
40 frames
331 frames

Approx.
Approx.
Approx.
Approx.
Approx.

: 8,000,000 pixels
: 1/1.8" CCD solid-state image pickup, 8,310,000 pixels
: Olympus lens 7.1 mm to 35.6 mm, f2.4 to f3.5, 14

elements in 5 groups

(equivalent to 28 mm to 140 mm lens on 35 mm

camera)

. Digital ESP metering,

: f2.4108.0
1 16 to 1/4000 sec. (bulb mode: max. 8 min.)

: 0.8 m (2.6 ft.) to oo (normal)
0.2m to 0.8 m (0.7 ft to 2.6 ft.) (macro mode)

: 0.44" TFT color LCD display, 240,000 pixels
: 1.8" TFT color LCD display, 134,000 pixels

(RAW, TIFF, SHQ, HQ)

3:2, TIFF, SHQ, HQ)
TIFF, SQ1)

TIFF, SQ1)
TIFF, SQ1)
TIFF, SQ2)
TIFF, SQ2)
TIFF, SQ2)
TIFF, SQ2)

e e e e e e

(RAW : 3264 x 2448
(TIFF : 3264 x 2448
(SHQ : 3264 x 2448
(HQ  :3264 x 2448
(SQ1 :2048 x 1536
(sQ2

. Digital recording, TIFF (non-compression), JPEG (in
accordance with Design rule for Camera File system

. Exif 2.2, Digital Print Order Format (DPOF), PRINT

)
)
)
)

NORMAL)
1640 x 480 NORMAL)

spot metering system,
center-weighted metering system




Specifications
Autofocus : Dual autofocus
Contrast detection system, Phase-difference detection
system
Outer connector : DC-IN jack, USB connector (mini-B), A/V OUT jack
Automatic calendar : 2000 up to 2099
system
Operating environment
Temperature : 0°C to 40°C (32°F to 104°F) (operation)
—20°C to 60°C (—4°F to 140°F) (storage)
Humidity 1 30% to 90% (operation)/10% to 90% (storage)
Power supply : Only an Olympus BLM-1 lithium-ion battery
AC adapter specified by Olympus (optional)
Dimensions : 124 mm (W) x 84.5 mm (H) x 99 mm (D)
(4.9" x 3.3" x 3.9") (excluding protrusions)
Weight : Approx. 510 g (1.1 Ib.) (without battery and card)

SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT ANY NOTICE OR
OBLIGATION ON THE PART OF THE MANUFACTURER.

Lensfilter = = = = = = = = = = == === =@=@=@=&===2&=2&2&=&=@====&====-=-=x==

A lens filter can be fitted to the lens. For more information, please refer to our web
site.
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Glossary of terms

A (Aperture Priority) Mode
You set the aperture yourself and the camera automatically varies the shutter speed so
that the picture is taken with the best exposure.

AE (Automatic Exposure)

The camera’s built-in exposure meter automatically sets the exposure. The 3 AE modes
available on this camera are P mode, in which the camera selects both the aperture and
shutter speed, A mode, in which the user selects the aperture and the camera sets the
shutter speed, and S mode, in which the user selects the shutter speed and the camera
sets the aperture. In M mode, the user selects both the aperture and the shutter speed.

Aperture

The adjustable lens opening which controls the amount of light that enters the camera. The
larger the aperture, the shorter the depth of field and the fuzzier the background. The smaller
the aperture, the greater the depth of field and the sharper the background. Larger aperture
values indicate smaller apertures, and smaller aperture values indicate larger apertures.

Backlight
A light source to illuminate the monitor from behind the screen.

CCD (Charge-Coupled Device)
This converts light passing through the lens into electrical signals. On this camera, light is
picked up and converted into RGB signals to build a single image.

Contrast Detection System
This is used to measure the distance to the subject. The camera determines if the image is
focused by the level of contrast in the subject.

Conventional Photograph

This refers to recording images using silver halide (the method for recording images in
conventional, non-digital photography). This system is in contrast to still video and digital
photography.

DCF (Design rule for Camera File system)
A standard for image files by the Japan Electronics and Information Technology Industries
Association (JEITA).

Depth of field

The subject itself as well as some area to the front and rear of the subject are focused. The
entire depth of this focused area, from the front to the rear of the subject, is called “depth of
field”.

Digital ESP (Electro-Selective Pattern) Light Metering
This determines the exposure by metering and calculating the light levels in the center and
other areas of the image separately.

DPOF (Digital Print Order Format)

This is for saving desired print settings on digital cameras. By entering which images to
print and the number of copies of each, the user can easily have the desired images
printed by a printer or print lab that supports the DPOF format.

Dual Auto Focus

An auto focus system that uses two different focus detection systems in combination. This
camera uses the CCD’s contrast detection system in combination with the specified
sensor’s phase difference detection system, nullifying the shortcoming of each system.
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Glossary of terms

Eclipsing (Vignetting)

This refers to when an object obscures part of the field of view so that the whole subject is
not photographed. Vignetting also refers to when the image seen through the viewfinder
does not exactly match the image shot through the objective lens, so the photographed
image includes objects not seen through the viewfinder. In addition, vignetting can occur
when an incorrect lens hood is used, causing shadowing to appear in the corners of the
image.

EV (Exposure Value)

A system for measuring exposure. EVO is when the aperture is at F1 and the shutter speed
is 1 second. The EV then increases by 1 each time the aperture increases by one F stop or
the shutter speed increases by one increment. EV can also be indicated by brightness and
ISO settings.

Exposure

The amount of light used to capture an image. The exposure is determined by the time the
shutter is open (shutter speed) and the amount of light that passes through the lens
(aperture).

Flash Bracket
A mount used to attach an external flash to the camera. Shadows on the subject can be
changed by detaching the flash. The flash is used in combination with the flash cable.

1ISO

A method for indicating film speed by the International Organization for Standardization
(ISO) (e.g. “ISO100”). Higher ISO values indicate greater sensitivity to light, so images can
be exposed even in low-light conditions.

JPEG (Joint Photographic Experts Group)

A compression format for still images. Photographs (images) shot using this camera are
recorded onto the card in JPEG format when the record mode is set to SHQ, HQ, SQ1 or
SQ2. By downloading these images to a personal computer, users can edit them using
graphics application software or view the images using an Internet web browser.

M (Manual) Mode
The user sets both the aperture and shutter speed.

NTSC (National Television Systems Committee) / PAL (Phase Alternating
Line)

Television formats. NTSC is mainly used in Japan, North America and Korea. PAL is
mainly used in Europe and China.

P (Program) Mode
Also called Program AE mode. The camera automatically sets the best shutter speed and
aperture for the shot.

Phase-difference Detection System
This system measures the distance to the subject. The distance is calculated by the
difference in the image of the subject captured by a pair of sensors.

Pixels
A pixel is the smallest unit (dot) used to make up an image. Clear large-sized printed
images require millions of pixels.
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Glossary of terms

Resolution

The size of an image expressed by the number of pixels that make up the image. For
instance, a picture taken in 640 x 480 resolution is the same size as the screen when the
monitor setting is 640 x 480. However, if the monitor setting is 1024 x 768, the picture only
takes up part of the screen.

S (Shutter Priority) Mode
Also called Shutter Priority AE mode. The user selects the shutter speed and the camera
automatically varies the aperture so that the picture is taken with the best exposure.

Slave Flash

A wireless flash that is not connected to the camera by a synchronization cord. It flashes in
phase with the flash on the camera and can be used for lighting techniques, such as
changing the way shadows are cast on a subject.

Sleep Mode

A mode designed to save battery life. The camera automatically enters the sleep mode if
you do not operate it for a certain time. To get out of the sleep mode, use any button on the
camera (shutter button, arrow pad, etc.).

Synchro Terminals
Terminals on an external flash unit for connecting it to the camera.

TIFF (Tagged Image File Format)

A format used for saving highly detailed black and white or color image data. TIFF image
files can be handled by software programs for scanners and graphics applications. This
camera uses an uncompressed format.

TFT (Thin-Film Transistor) Color Monitor
A transistor color monitor constructed using thin-film technology.

TTL (Through-The-Lens) System
To help adjust exposure, a light receptor built into the camera directly measures the light
passing through the lens.

TTL-AUTO

For use with an external flash. Light emitted by the flash is reflected by the subject and
measured by the light receptor in the camera as it passes through the lens. This is used to
adjust the external flash intensity.
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1st curtain § SLOWA1 ......... 61
1st curtain with red-eye reduction
O@4SLOWT. . ............ 62
2nd curtaing SLOW2 . ........ 62
32 e 103
A
AN OUTjack ............. 9, 134
ACadapter.................. 19
AE. ... .. 223
AE lock (AED). .. .............. 85
AE memory (MEMO). . .. .......... 86
AEL button AEL . . .. .. 9,72,83,85
AF............. 74,75,76,77,78
AF illuminator . . ............ 9,78
AF ILLUMINATOR .. .......... 78
AFMODE................... 74
AFsensor................. 9,76
AF sequential shooting AFy. . . 92
AF targetmark . .. ......... 50, 77

AF/Macro/MF button AF/$/MF
................ 10, 79, 87, 88

ALLRESET ................ 145
All-frame erase §* . ......... 144
All-frame reservation & ...... 178
Aperture priority shooting A. . 47, 70
Aperturevalue . .............. 70
Arrowpad............. 9, 37, 121
Auto bracketing BKT.......... 93
Autofocus AF................ 34
Auto white balance. . ......... 109
Auto-flash. ............... ... 60
AVcable................... 134
B

Battery ......... ... ... ... 18
Batterycheck .. .............. 14

Battery compartment cover ..
Battery compartment lock. . .. 10, 18
BATTERY SAVE ............ 171
Beepsoundm) ............. 169
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BLACK&WHITE ............. 98
Bulbshots................... 72
Cc

Camera movement warning . . . . . 50
CAPTURE. . ................ 129
Card . .. ... 21
Card access lamp........... 9,50
Card buttonCFxD . ......... 9,23
Cardcover ................ 9,22
CARD SETUP. .. ............ 166
CCD ... 223
Center-weighted metering [ . . . 81
CF. . 21,23
Charger..................... 17
Close-up playback Q. ........ 124
Cloudyday ™ .............. 110
Color temperature. . .. ........ 110
CompactFlash............... 21
Compression. . .............. 102
Connector cover. .. .. .. 9, 134, 187
CONTRAST®.............. 115
Contrast Detection System. . . 76, 223
Control dial . . . .. 9, 31, 33, 121, 150
CONTROLPANEL........... 163
COPY ... i 141
Creatinganindex............ 131
Custom button . . .. .. ... 10, 154
CUSTOMBUTTON .......... 154
Custom white balance ........ 111
D

Date andtme @ ........... 168
DCF ... i 223
DC-INjack ................ 9,19
DIAL.......... ... 150
Digital ESP Metering. . .. ... 81, 223
DIGITALZOOM . ............. 58
Diopter adjustmentring. . . . .. 10, 27
DIRECT ................... 119
Directbuttons . .. ............. 31



Index
Directprinting............... 186 FULLTIMEAF. ............... 75
DPOF ................. 176,223 Fully ... 50
FUNCTION............ 95, 97, 98
E
Editngamovie. ............. 132 G
Erase button g ........... 9,143  Greenlamp.................. 50
Errorcodes. . ............... 200
EV.. ... 224 H
EVSTEP .................. 153 Halfway..................... 50
Evening sunlight =&. .. ....... 110 HIGH. ... ... ... ... .. .... 102
Exposure .................. 224 High speed sequential shooting
Exposure compensation. . . . . .. 108 HIS ... 92
Exposure compensation Histogram display [uli]. . . . . .. .. 119
button[.............. 10, 108  Histogram target mark ........ 120
Exposure differential. .. ... ..... 72 Hotshoe................. 10, 65
Exposure Steps . ............ 153 HQ ................... 104, 105
Externalflash ................ 67 HUERBS . . .. .. .......... 116
F |
Filename.................. 170 ESP . ... . 74
FILENAME . ............... 170 Index display [=8. .. .. .. .. 125, 126
FileNo..................... 170 Information display INFO . . .. .. 135
Fill-in flash i ................ 61 Information display button INFO
Flash. ....... .. ... ... .. 9,59 ... 10, 135
FLASH=®y .. ... ... ........... 66  ISO sensitivity. .. ........ 107, 224
Flashcharging ............... 60
Flash intensity control. . .. ... ... 64 J
Flash intensity control JPEG ............... .. 104, 224
buttonfByg ................. 34 JPEGDUPLICATE SETTING ... 106
Flashmode.................. 59
Flash mode button % .. .. ... 10,59 L
Flashoff ® ................. 61 Landscape shooting M. . ... ... 49
Flash pop-up button ¢ . .. . .. 10,59 Language @f£3)............. 167
Flashstand-by . .............. 50 Lens............ ... 9
Fluoescentlamp &3..........110 Lenscap................. 16, 25
Focus ................ 50, 53, 74 Lenscapstring............... 16
Focus Lock. . ................ 53 Lenshood................... 27
FOCUS MODE. .. ...... 79, 87,88  Lithiumionbattery ............ 18
FORMAT[H ................ 166
FRAME ASSIST display. . ... ... 99 M
FRAME ASSIST shooting E3. . . 97, 136  Macro mode shooting ¢ ... . ... 87



Index
Manualfocus MF . .. .. ........ 79 PC.... .. 175
Manual shootingM ... ... .. 48,72 Phase difference detection system
Measurement Unit L 76, 224
m/ft (meters/feet) .......... 173 PictBridge . . .. .............. 186
Memorygauge . .............. 14 Picture rotation 3. . .. ........ 123
Metering.................... 81 PIXEL MAPPING ............ 172
Metering button @) . . . .. 10,81,82 Pixels ..................... 224
Meteringmode . .. ............ 81 Playback mode. . . .. 13, 41, 44, 121
Metering targetmark .. ........ 82 PlaybackonaTV............ 134
Microdrive. .. ................ 21 Portrait shooting €y ........... 49
Microphone. . ......... 9,100, 137  Power battery holder. . ......... 19
Modedial ................ 10, 46 Poweron/off................. 25
MODEMENU................ 42 Power switch. . ............ 10, 25
Monitor. .. ..... 9, 11, 50, 121, 173 Preset white balance . ........ 110
Monitor brightness PRINT. ... ... ... ... .. .. 175
adjustment!1&2} . ... ... 173 Printbutton O, ........... 10, 178
Monitor button (2. . ........ 9,50 Printsetting. ................ 176
MOVIE PLAY .. ............. 128 Program shiftPs. ............. 46
MOVIE PLAYBACK . .. ....... 128 Program shooting P .. ......... 46
Movierecord & .. ......... 48,55 Protect .................... 142
Multi-metering C&JMULTI . ... .. 83  Protect buttonOm ........ 10, 142
My Mode @ ............. 48,73
MYMODE .................. 73 Q
MY MODE SETUP &Y. .. ..... 160 QUICKVIEW ............... 122
QUICK VIEW button. . ...... 9,122
N
Night Scene shooting[®] . ... ... 49 R
NOISE REDUCTION 3 . .. .. 118 RAW.............. 103, 105, 106
NTSC................. 174,224 RAWDATAEDIT............ 140
Number of storable still pictures ..104 RECVIEW ................. 147
REC.CANCEL ............... 51
o Record mode <€+ ............ 102
OK/Menu button & . ........ 9, 37 Record mode button <€- ... 10, 105
One-touch white balance 53,. .. 111 Recording sound &. . . 100, 101, 137
Operation sound BEEP . . . .. .. 148 Recording sound with
Optical zoom . ............... 57 movies®................. 101
Recording sound with still
P pictures & ................ 100
P-AF. ... 76  Red-eye reduction flash @ . ... 60
PAL. ........ .. ... .... 174, 224 Remaining recording time. . . 55, 104
PANORAMA. ................ 95 Remote control & ............. 90
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Index
Remote control receiver. . . ... 9,90 SQ ... 104, 105
Resizng[Pmd. .. .. oo voiee ot 138  Standard [,STANDARD .. .. .. 186
Resolution ............. 102,225 Strap........ i 16
Rotation button 3 .. ... ... 10,123  Strapeyelet............... 10, 16
Sunnyday3E. ... ... 110
S Super macro MF Y& ... ....... 88
SATURATIONRGE . ... 117 Super macro shooting ¢¥%. . . . ... 88
SCENE MODES............. 117
Self-timer & . ................ 89 T
Self-timer/Remote control Taking still pictures. . .......... 50
button /g .. ......... 9,89,90 TIFF .............. 104, 105, 225
Self-timer/Remote control Topmenu................... 37
lamp ......... ..., 9,89,90 Trimming H........ 139, 182, 197
SEPIA. . .. ... 98  Tripodsocket ................ 10
Sequential shooting &y. .. ... .. 92  Tungstenlight=0: ............110
SETUPmode ............... 45
Shade .- oo oo 110 U
SHARPNESS & ............ 114 USB ... ... i 175
Shoecover.................. 65 USBecable.................. 187
Shooting mode.. . . . .. 11, 40, 42, 46 USB connector .. .......... 9, 187
SHORTCUT ............... 157
ShortcutMenus .. ............ 40 V
SHQ.................. 104,105 VIDEOOUT ................ 174
Shutter button. . .. ....... 9,50,55  Viewfinder....... 9, 11, 27, 50, 173
Shutter priority shooting S ... 47,71 VOLUME................... 165
SHUTTER SOUND .......... 149
Shutter speed. ... ............ 71 W
Single-frame erase /ﬁ ________ 143 White balanceWB . .......... 109
Single-frame reservation L.... 180  White balance
Single-frame shooting (J . . . ... 92 adjustment WBY . .......... 112
SLAVE . ... 69 White balance button WB. . . 10, 109
Slaveflash .............. 69, 225
SLEEP . ...t 169 X
Sleepmode . ........... 169, 225 xD-Picture Card . .......... 21,23
Slideshow (&= . ............. 127
Slow synchronization r4
iSLOW _______________ 61,63 Zoom lever . ...... 10, 57, 124, 125
Speaker .......... ... ... 10
Sports shooting ¥ . .......... 49
Spot (AFmode) .............. 74
Spot metering (). .. .......... 81
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OLYMPUS

AMEDIA

DIGITAL g PERSONAL

CAMERA COMPUTER

DIGITAL CAMERA — PC CONNECTION

OPERATION MANUAL

How to use your PC to get the

most from images taken with
your digital camera.

® Thank you for purchasing an Olympus digital camera.

® This manual provides instructions on how to install the USB
driver. To ensure correct installation, refer only to these
installation procedures.




Introduction

This manual explains in detail how to connect your Olympus digital camera to
a computer. Read it carefully and keep it in a safe place for future reference.

About this manual

® The information contained in this manual may be subject to change without
notice. For the latest information on the product, please consult your local
Olympus representative.

® The information contained in this manual has been compiled by taking all
possible measures to ensure its accuracy. However, if you find any errors or
incomplete information, please contact your local Olympus representative.

® |t is prohibited by copyright laws to duplicate in part or in whole the information
contained in this manual, except for personal use. Reproduction without
permission of the copyright owner is prohibited.

® The PC screens shown in this manual may differ slightly from the actual displays
on some PC models.

Trademarks

® Microsoft and Windows are registered trademarks of Microsoft Corporation.

® Macintosh is a trademark of Apple Computer Inc.

® All other company and product names are registered trademarks and/or
trademarks of their respective owners.
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By connecting the camera to a computer with the provided USB cable,
images on a card can be transferred to the computer. Some OS’s (operating
systems) may need a special setup before connecting to the camera for the
first time. Follow the chart below.

For details, see the Olympus Corporate Site or phone customer
support.

| Identifying the OS (p.6) |
|

v v v
Windows 98/ . MacOS 9.0 - 9.2/0S X
98 SE (Second Edition) | | \Vindows Me/2000/XP | | c0'ns g6 see below.

v

Installing the USB
driver for Windows
98 (p.9)

v

Connecting the camera to the computer using the provided USB cable
(Windows p.11, Mac p.24)

v v

Confirming the computer recognizes
the camera (p.14)

v v

Downloading image files
(Windows p.17, Mac p.26)

v v v

Disconnecting the USB cable
(Windows p.20, Mac p.30)

Even if your computer has a USB connector, data transfer may not function

correctly if you are using one of the operating systems listed below or if you have

an add-on USB connector (extension card, etc.).

® Windows 95/NT 4.0

® Windows 98/98 SE upgrade from Windows 95

® Mac OS 8.6 or lower (except Mac OS 8.6 equipped with USB MASS Storage
Support 1.3.5 installed at the factory)

® Data transfer is not guaranteed on a home-built PC system or PCs with no

factory installed OS.




Flowchart

Caution

When connecting the camera to the computer, make sure that there is
sufficient remaining battery power. When connected (transmitting) to the
computer, the camera does not enter the sleep mode nor will the camera’s
power turn off automatically. Depending on the camera model, when the
battery power runs out or the internal temperature rises, the camera may
stop operating automatically. This could cause the computer to
malfunction, and any image data (file) being transmitted may be lost. Be
careful when downloading files for a long period of time. Use the AC
adapter (optional) when downloading files.

If you connect or disconnect the AC adapter when the camera is connected
to the computer and is running on battery power, it may result in the loss of
image data on the card or cause a malfunction in the computer. Before
connecting or disconnecting the AC adapter, disconnect the camera from
the computer and make sure that the camera is turned off.

To avoid computer malfunctions, do not turn off the camera when the
camera is connected to a computer.

If the camera is connected to the computer via a USB hub, operation may
not be stable if there are any compatibility problems between the computer
and the hub. In such cases, do not use the hub and connect the camera
directly to the computer.

You can view images using: graphics applications that support the JPEG
file format (Paint Shop Pro, Photoshop, etc.); Internet browsers (Netscape
Communicator, Microsoft Internet Explorer, etc.); CAMEDIA Master
software; or other software. For details on using commercial graphics
applications, refer to their instruction manuals.

QuickTime is needed for playing back movies. QuickTime is included on
the provided software CD.

If you want to process images, make sure to download them to your
computer first. Depending on the software, image files may be destroyed if
the images are processed (rotated, etc.) while they are on the card.



Identifying the OS

Identify the OS on your computer before connecting the camera. How to
identify the OS depends on the computer.

® Windows

1 Double-click the “My Computer”
icon on your desktop. .

—
ZTTT

When the “My computer” icon is not on
your desktop, click “Control Panel”
from the “Start” menu.

My Computer

2 Double-click the
“Control Panel” icon.

3 Double-click the
“System” icon.

The way the file icons inside the folder appear may vary depending on your
version of Windows. If you don’t see the icon you are looking for, click on
“view all Control Panel options” on the left of the window.



Identifying the OS
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A System Properties window will

iz Vianeger | Hercoers ot

appear. Note and record the =
“System:” information.
Confirm that your system is Windows R
98, 98 SE, Me, 2000 Professional or st
Windows XP, then press “OK” to close e
the window. Tty

o

If your OS is Windows 98/98 SE, proceed to “Installing the USB
driver for Windows 98” (I=5° p.9).

Users running Windows Me/2000/XP 15" p.11

Users running other OS =" p.31

® Mac OS (Macintosh)

Select “About This Computer” from the Apple menu on the menu bar.
A window appears with the name of the computer’s OS.
Confirm that the OS is OS 9.0-9.2 or OS X.

Ll File Edit View Specia
About This Computer
&L Apple System Profilgs
[ calculator
S chooser o
£ Control Panels » irtua y: 129 MB used on Mec 05 9.0E

; Largest Unused Block: 1036 B ™14 © Apple Computer, Inc, 1983-1999
[, Favorites »
Key Caps
R Network Browser
(@ Recent Applications b
(Gl RecentDocuments b
£ Recent Servers »
[ Remote Access Status
Scrapbook

42 Sherlock 2
< Stickies

Users running Mac OS 9/X " p.23
Users running other OS =" p.31



Windows

Using Windows 98/Me/2000/XP

Make sure that:

®Your computer is turned on and Windows is running.

®|f you are running any applications, quit them all.

®You are recommended to power the camera using the optional AC adapter.
If the battery power runs out while the computer is accessing the card in the
camera, the camera will turn off in the middle of the operation and this could
destroy image files (data). If you are using batteries, make sure that there
is sufficient remaining battery power.

4 I
Installing the USB driver for Windows 98 (When using Windows
98/98 SE) ....ceerurrererrnrreesseeesn e s n e n e 9
Connecting the camera to the computer ...........cccocvveiiiiinnnns 1

Confirming the computer recognizes the camera
Confirming the USB driver is installed .
Downloading images to your computer...

Disconnecting the camera from your computer




Installing the USB driver for Windows 98

(When using Windows 98/98 SE)

If your OS is Windows 98/98 SE, you must install the USB driver. Follow the
instructions below to install the USB driver in your computer. Once it is fully
installed, you do not need to repeat the procedure again.

If your OS is Windows Me/2000/XP, you do not need to install the USB
driver. Proceed to “Connecting the camera to the computer” (15" p.11).

I Insert the provided software CD
into your CD-ROM drive.

2 The Olympus Windows Installer
should automatically launch. Click
“USB Driver”.

If the USB driver is already installed in

your computer, this option will not

appear. (Reference Manual )

« This option will not appear if you are
using Windows Me/2000/XP.

L
ovmPUs e@ (= 5

CAMEDIA

GAMEDIA Master 4.1

[ cise

If the installer is not automatically launched, select “Run..” on the
“Start” menu and then execute “(drive letter):/ Information.exe”.

The drive letter of the CD-ROM varies depending on the computer.
To identify the drive letter, double-click “My Computer” on the desktop.



Installing the USB driver for Windows 98 (When using Windows 98/98 SE)
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3 Click “Continue”. The installation of
the USB driver will start.

Install USB Driver for WindowsS8

Press [Confinue] to install the: ISB diiver
for Dlympus digital cameras

4 Click “OK” to restart your computer
and the installation is complete.

Install USB Driver for WindowsS8

“four computer must be restarted to complste installation,

( ) Cancel

5 When the computer has restarted, installation is complete. If the
Olympus Windows Installer screen appears, click “Close” and
remove the CD-ROM from the CD-ROM drive.

10



Connecting the camera to the computer

Users running Windows 98/98SE need to install the USB drive before
connecting the camera to your computer for the first time. (I=5° p.9)

1 Some camera models have
a “USB” setting in the
menu. Make sure that “PC”
is selected before
connecting. This is not
required if your camera
does not have this setting.
For details on how to
operate the menu, refer to your camera's reference manual.

Arrow pad
Menu button

2 Insert the marked end of the provided USB cable into the USB
port on your computer as shown below.

Look for this mark.

% Terminal
4-

USB port

The location of the USB port varies depending on the computer. For details,
refer to your computer's manual.

3 After making sure that the camera is turned off, connect the end
of the USB cable to the USB connector on the camera.
The location of the USB connector or multi connector varies depending
on the camera model. Refer to the camera manual for details.

Computer

USB connector or
multi connector

‘11



Connecting the camera to the computer
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4 Turn the camera on.

o Camera with a lens barrier

The power turns on automatically,
with the exception of some models
which require you to press the
(monitor) button.

When the camera is turned on, the
lamp on the right of the viewfinder
lights up. (monitor) button

Lens barrier

® Camera witha = mode
Set the mode dial to = .
(If the camera has a power
switch as well as a mode
dial, turn the power switch to
ON.)

Mode dial

Power switch

5 Some camera models
display this screen (shown
right) on the monitor. When
this screen appears, use the
arrow pad to select “PC” and SELECTH ) GO [0K] -
press the OK button. OK button

Arrow pad

6 The computer recognizes the camera as a new device.
When you connect the camera to the computer for the first time, the
computer automatically recognizes the camera. Click “OK” when the
message saying that the installation is completed appears. The
computer recognizes the camera as a “Removable Disk”.

12



Connecting the camera to the computer

o Windows XP

Caution

You can download image files from the camera easily.

Select “Copy pictures to folder on my computer using Microsoft
Scanner and Camera Wizard”, then follow the on-screen instructions.
You may also select “take no action” to bypass the Microsoft Scanner
and Camera Wizard. You may then use a more advanced image
viewing/editing program such as Olympus CAMEDIA Master
software. For detailed instructions on downloading, refer to the
CAMEDIA Master software user’s guide.

When the camera is connected to the computer, none of the camera buttons
are functional.

13



Confirming the computer recognizes the camera

1 Double-click the “My Computer”
icon on the desktop.
For users running Windows XP, click
“My Computer” from the “Start” menu.

2 Make sure the “Removable Disk”
icon appears in the window.

There may already be other
“Removable Disk” icons for other
devices, such as a removable media
drive or USB SmartMedia Reader/
Writer. In this case, the digital camera
is recognized as another “Removable
Disk”.

If you cannot find the icon, the camera
and computer are not connected
properly. Turn the camera off,
disconnect the camera from the
computer and connect again, or proceed to “Confirming the USB driver
is installed” (I=¥5° p.15) to make sure that the USB driver is fully
installed.

EREEEEA

My
Computer (3 & (I &
b .

1ty o /

Femavable
Disk. [F:]



Confirming the USB driver is installed

If the computer does not recognize the camera as a Removable Disk, follow
the procedure below to check whether the USB driver has been fully installed.

1 Open “My Computer” ) Emm—
and double-click the I A Ll o

“Control Panel” icon.
For users running Computer @, B @
Windows XP, open
“Control Panel” from the
“Start” menu.

.2 =239

[t 7

2 Double-click the
“System” icon.

3 The System window will appear.
Click the “Device Manager” tab.

Spsonn
Mereon tindns 90

11
- Fegsedtc:
oivEG
oLveeUs
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Confirming the USB driver is installed

4 Confirm that “OLYMPUS Digital Sastom et =1
Camera” is in the “Universal Serial o o | e |
9  View devicesbybpe € View devices by comecton
Bus Controller” category. B b <
If you cannot find the “OLYMPUS b P
Digital Camera”, turn the camera off, j.%ﬁ:xékfaaw.

disconnect the camera from the
computer and start again.
Users running Windows 98/98 SE

start again from “Confirming the USB i »
driver is installed”, and Users running Pt | I | cirron | It |
Window Me/2000/XP start from o |
“Connecting the camera to the

computer”.

— the name of the camera you have connected listed under “Disk drives”
— “OLYMPUS Digital Camera” listed as one of the items in the “Universal
Serial Bus Controller” category

If the USB driver was successfully installed, you can find the following in the
Note “Nevi "
Device Manager”.

16



Downloading images to your computer

1 Double-click the “My Computer”
icon on the desktop.
For users running Windows XP, click
“Control Panel” from the “Start” menu.

LEEETT

rnpLber

2 Double-click the “Removable Disk”
icon.

s [ 1y oo

A new “Removable Disk” icon appears 5
when the camera is connected to the o
computer, as the digital camera is G &

CotePars Dl

recognized as a “Removable Disk”. s

If an error message appears when you double-click the icon, there may be a

problem with one of the following:

@ the camera’s power source (the AC adapter is not properly connected or
the battery power is low)
Make sure that the AC adapter is correctly connected or that the batteries
are not running low.

@ the card (there is no card in the camera or there is a problem with the
card)
Check that you can play back pictures stored on the card on the monitor
of your digital camera.

3 Double-click the
“Dcim” folder.

e f Yew Go Fawie lop

SE % B a|D

U | O Cw e | U

[ o i
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Downloading images to your computer

4 Double-click the “1000lymp” folder.

B

Image files (JPEG files) with files & om Bl & 212

« C Jages D woommore ]
n.ames such as “P1010001.jpg” are —3{ ¥ = 2 =
dISplayed. 010012 pg P01 3ipg PI000T4ipg PI0T00TS pg PIOIOT6 jpg.

- * The camera automatically assigns folder names and file names according
Note ]
to the following rules.

Folder name File name

(Example) (Example)
1000lymp Pi(_i]0001 .ipg
Serial number Month / Day / Serial number

« Serial numbers of image files run from 0001 to 9999.

« Serial numbers of folders run from 100 to 999.

* When file number 9999 is reached, a new folder is created and assigned
the next number.

« Months January through September are expressed by the numbers 1
through 9, October by the letter A, November by B and December by C.

5 Double-click the “My Documents”
icon on the desktop.

If you cannot find the icon on the
desktop, select “Explorer” on the Start
menu and double-click the “My
Documents” icon.

18



Downloading images to your computer

The “My Documents” window is
displayed. b ta tow o forie 50 ‘

12815 o Y

6 Drag & drop the image
you want to save in the
computer (in this case,
P1010012.jpg) to the
“My Documents”
window.

The image is saved in the
computer (in My
Documents folder).

* To select all files, choose Edit > Select all.

When the image file has been downloaded to the computer, you can view

images by double-clicking the image files downloaded to your computer. The
files will be opened in the default image viewer of the operating system. If you
want to view the image a different size or process it, you will need to open the
image with software that supports JPEG or TIFF images files, such as Paint
Shop Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while
the image is being copied. Never open the card cover on the camera, load or
remove the batteries, or connect or disconnect the AC adapter while the lamp
is blinking as the image files may be destroyed.

Caution

19



Disconnecting the camera from your computer

If your OS is Windows Me/2000, proceed to “Windows Me/2000/XP” (15~
p.21).

® Windows 98

I Make sure that the lamp on the
right of the viewfinder or the card
access lamp is not blinking.
Some camera models have either a
lamp on the right of the viewfinder or
a card access lamp, and the location
varies depending on the model.
Refer to your camera’s reference
manual.

2 Double-click the “My Computer”
icon and right-click the “Removable -
Disk” to display the menu.

3 Click “Eject” on the menu. =
Open

Explore
Find

Copy Disk....

Sharing...

Create Shortcut

Froperties



Disconnecting the camera from your computer

4

Make sure that the lamp on the right
of the viewfinder or the card access
lamp is not blinking.

The green lamp lights on some
models. If the lamp is no flashing, then
the cable can be removed.

Remove the USB cable from the
camera.

® Windows Me/2000/XP

Lamp

WA )
N

1

Make sure that the lamp on the right
of the viewfinder or the card access
lamp is not blinking.

Some camera models have either a
lamp on the right of the viewfinder or a
card access lamp, and the location
varies depending on the model. Refer
to your camera's reference manual.

‘21



Disconnecting the camera from your computer

2

Caution

22‘

Click the 5’ “Unplug or Eject
Hardware” icon on the task bar.

The message saying that the drive
has been stopped appears.

Click on the message.
The “Unplug or Eject Hardware”
window appears.

When a message appears, click
“OK”.

Remove the USB cable from the
camera.

c:fji@ 1:45 PM
ANS
\
[ Stop LISE Mass Storage Device - Drive(G:) !

[

@ The 1S5 Mess Storage Device!device can now be safely removed

A

'm

If the window returns the following message when you click “Unplug or Eject
Hardware”, first make sure that no image data is being downloaded from the

camera, and then remove the USB cable.

Problem Ejecting USB Mass Storage Device: x




Macintosh

Using Mac OS (9/X)

Make sure that:

®Your computer is turned on and Mac OS is running.

®|f you are running any applications, quit them all.

®You are recommended to power the camera using the optional AC adapter.
If the battery power runs out while the computer is accessing the card in the
camera, the camera will turn off in the middle of the operation and this could
destroy image files (data). If you are using batteries, make sure that there
is sufficient remaining battery power.

If you are running Mac OS X, the connection to the computer and
downloading the image data are verified. Restrictions such as the
following may occur due to the OS.

®The image file properties are not displayed correctly.

®Images in the camera cannot be opened without first downloading
them. etc.

For more details, visit the Olympus web site.

4 N
Connecting the camera to the computer ..........cccccoviieiiiieiinens 24
Downloading images to your computer...........ccceceireernninnnns 26
Disconnecting the camera from your computer ............c.c...... 30

. %
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Connecting the camera to the computer

Some camera models have
a “USB” setting in the
menu. Make sure that “PC”
is selected before
connecting. This is not
required if your camera
does not have this setting.
For details on how to
operate the menu, refer to your camera's reference manual.

Arrow pad
Menu button

Insert the marked end of the USB cable into the USB port on your
computer as shown below.

Look for this mark.

Terminal

USB port

The location of the USB port varies depending on the computer. For details,

refer to your computer's manual.

3

24‘

After making sure that the camera is turned off, connect the end
of the USB cable to the USB connector on the camera.

The location of the USB connector or multi connector varies depending
on the camera model. Refer to the camera manual for details.

Computer .
Rectangular terminal

Smaller terminal _

multi connector



Connecting the camera to the computer
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4 Turn the camera on.

o Camera with a lens barrier
The power turns on automatically,
with the exception of some models
which require you to press the
(monitor) button.
When the camera is turned on, the
green lamp on the right of the
viewfinder lights up.

Lens barrier

(monitor) button

® Camera witha = mode
Set the mode dial to = .
(If the camera has a power
switch as well as a mode dial,
turn the power switch to ON.)

Mode dial

Power switch

5 Some camera models
display this screen (shown
right) on the monitor. When
this screen appears, use the
arrow pad to select “PC” and
press the OK button.

Arrow pad

6 The computer recognizes the
camera as a new device.
The computer recognizes the camera untitled
automatically and an “Untitled” icon
appears on the desktop.
If you cannot find this icon, turn off the camera and connect again.

o Mac OS X
When the computer has recognized the camera, the Apple Image
Capture software automatically launches. =" p.29

When the camera is connected to the computer, none of the camera buttons
are functional.

Caution

25



Downloading images to your computer

® Mac OS 9

You can download images from the camera and save them in your computer
(in this case, in the Hard Disk).

1 Double-click the “Untitled” icon

displayed on the desktop when the Q
camera is connected to the untitled
computer.

If you cannot find this icon, or if an error message appears when you double-
4 click the icon, there may be a problem with one of the following:

® the camera’s power source (the AC adapter is not properly connected or
the battery power is low)

@ the card (there is no card in the camera or there is a problem with the
card)

Check that you can play back pictures on the monitor of your camera.

® the USB cable (the camera is not properly connected to the computer by
the USB cable).

@ Apple “File Exchange” extension is not enabled.

* Please refer to your Apple operating system manual for instructions on
how to enable this extension.

2 Double-click the
“Dcim” folder. 1 ftem, 26,4 1B avalade

3 Double-click the 5 oo %
“1000LYMP” folder. \ 1 e, 204 B ovoae

N

1000V
N—

1000LYMP
N
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Downloading images to your computer
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Image files (JPEG files) with files T 10000
names such as “P1010001.JPG” are © tams, 28,4 18 vl
displayed. |

forec fsorec
P10T0012.0PG P10T0013.0P6

3
P1010015.0PG

iree rs:
1010016 PIDIBOITRG
i >

ST

* The camera automatically assigns folder names and file names according

Note to the following rules.

Folder name File name

(Example) (Example)
1000LYMP Pig‘]0001 .Jpg
Serial number Month / Day / Serial number

« Serial numbers of image files run from 0001 to 9999.

« Serial numbers of folders run from 100 to 999.

* When file number 9999 is reached, a new folder is created and assigned
the next number.

« Months January through September are expressed by the numbers 1
through 9, October by the letter A, November by B and December by C.

4 Double-click the “Macintosh HD”
icon on the desktop. =

Macintash HD

27



Downloading images to your computer
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The “Hard Disk” window is displayed. |o

13 tems, 8.22 6B available

@
a

bopl Extras scobe Fonts olumpus

?

he
Lots Brasking hows:

a
d

2
H

8 &
@ @

3

d
&

nstallr Logs assistants

Kl

5 Drag & drop the image
you want to save in the
computer (in this case,
P1010012.JPG) to the
“Hard Disk” window.

The image is saved in

the computer (in the

Hard disk).

* To select all images,
click Edit > Select all.

When the image file has been copied to the computer, you can view images

J by double-clicking the image files in the “Hard Disk” folder. The files will be
opened in the default image viewer of the operating system. If you want to
view the image a different size or process it, you will need to open the image
with software that supports JPEG or TIFF images files, such as Paint Shop
Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while
the image is being copied. Never open the card cover on the camera, load or

Caution  'emove the batteries, or connect or disconnect the AC adapter while the lamp
is blinking as the image files may be destroyed.
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Downloading images to your computer

® Mac OS X

Malfunctions such as the following may occur due to the OS.

* If the camera is not connected correctly, a malfunction occurs in the
computer.

 Date and time information of image files is not accurately displayed.

« If the card cover of the camera is opened while connecting to the computer,
the “untitled” icon does not disappear from the desktop. etc.

When the computer has recognized the camera, the Apple Image Capture
software dialog appears.

1 From the “Download To” menu, oo caonzjconz
select a destination folder. |

2 To download all images, click
“Download All”.
To selectively download images,
click “Download Some” and
highlight the desired images.

The images are transferred from the camera to your computer.

( Downlosd Some.. ) ( Downlosd Al )

If you are operating Mac OS X and you want to download images using the
J same procedure as for Mac OS 9, select “File > Close” and exit the Apple
Image Capture software. At this time, the camera is indicated as “unlabeled”.

If you use the Apple Image Capture software, images downloaded to your
computer and transferred back to a card may not play back on the camera or

Caution  May have other problems.
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Disconnecting the camera from your computer

1 Make sure that the lamp on the
right of the viewfinder or the card
access lamp is not blinking.

Card access lamp

] ir’

Trash

2 Drag the “untitled” icon on the
desktop to “Trash”.

3 Make sure that the lamp on the right Lamp
of the viewfinder or the card access
lamp is not blinking.

LX)

The green lamp lights on some =
models. If the lamp is no flashing, then @g)@
the cable can be removed. O 0

4 Remove the USB cable from the
camera.

5 Remove the USB cable from your
computer.




Downloading image files using other 0OS

(For other OS users)

Users running other OS cannot connect the camera directly to a computer.
® Windows 95 ® Windows NT ® Mac OS before OS 9

For an OS listed above, you can download images directly to your computer

using an optional floppy disk adapter or PC card adapter.

For details, see the Olympus Corporate Site or phone customer support.

Does your computer have a USB interface?
Is there a port marked [+ on your computer?

)

Is your OS one of

the following?

Connect the camera directly
to your computer using the
provided USB cable.

*Windows 98

»Windows 2000
*Windows Me
*Windows XP
*Mac OS 9/X

10

Use the optional USB

reader/writer.”

*Certain card readers may not be
compatible with Mac OS X.

Check the Olympus website for

the most up-to-date compatibility

information.

(Does your computer have a built-in PC card slot?

)

Use the optional PC card adapter*.

@—}

*Not supported by Windows NT4.0 or
lower

(Consult your nearest Olympus representative.

)
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OLYMPUS’

http://www.olympus.com/

OLYMPUS CORPORATION
Shinjuku Monolith, 3-1 Nishi-Shinjuku 2-chome, Shinjuku-ku, Tokyo, Japan

OLYMPUS AMERICA INC.
Two Corporate Center Drive, Melville, NY 11747-3157, U.S.A. Tel. 631-844-5000

Technical Support (USA)
24/7 online automated help: http://www.olympusamerica.com/support
Phone customer support: Tel. 1-888-553-4448 (Toll-free)

Our phone customer support is available from 8 am to 10 pm

(Monday to Friday) ET

E-Mail: distec@olympus.com

Olympus software updates can be obtained at: http:/www.olympus.com/digital

Olympus Europa GmbH

Premises/Goods delivery: Wendenstrasse 14-18, 20097 Hamburg, Germany
Tel: +49 40-23 77 3-0 / Fax: +49 40-23 07 61
Letters: Postfach 10 49 08, 20034 Hamburg, Germany

European Technical Customer Support:
Please visit our homepage http://www.olympus-europa.com
or call our TOLL FREE NUMBER* : 00800 - 67 10 83 00
for Austria, Belgium, Denmark, Finland, France, Germany, ltaly, Luxemburg, Netherlands,
Norway, Portugal, Spain, Sweden, Switzerland, United Kingdom
* Please note some (mobile) phone services/provider do not permit access or request an
additional prefix to +800 numbers.

For all not listed European Countries and in case that you can’t get connected

to the above mentioned number please make use of the following

CHARGED NUMBERS: +49 180 5 - 67 10 83 or +49 40 - 237 73 899

Our Technical Customer Support is available from 9 am to 6 pm MET (Monday to Friday)

© 2004 OLYMPUS CORPORATION
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